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This manual, which can be kept behind the left-hand door of the copier, 
contains a description of the Océ 9600 and the copy jobs that can be done with 
it. The introduction (chapter 1) contains general instructions for using the 
printer. We recommend that you read at least this chapter. 

Safety information

This manual contains the following safety information:
■ Appendix B lists ‘Instructions for safe use’. You are advised to read this 

information before you start to actually use the copier. Technical safety 
information such as safety data sheets can also be found in appendix B.

■ Where applicable, cautions and warnings are used throughout this manual to 
draw your attention to safety precautions to be taken.



Table of Contents 3

Table of contents

Chapter 1
Introduction
About this manual 10
The Océ 9600 12
Océ 9600 key concepts 13
Océ 9600 users 16
Océ 9600 components 17

Océ 9600 printer 17
Océ 9600 scanner 18
Océ 9600 manual feeder 18
Océ 9600 controller 19
Océ 9600 optional features 21

Chapter 2
Using the Océ 9600 Printer
Printer operating panel 26

Display 27
Counter 28
Buttons 29

Printer panel actions 30
Starting up and shutting down the Océ 9600 31
Media type and size on the printer 32
Special media indication 34
Interrupt a print job 34
Select a language 35
Off-line folding settings 36
Positioning the reinforcement knives (optional) 37

Chapter 3
Using the Océ 9600 Copier
Scanner operating panel 40

Display 41
Buttons 41
Section, Function and Arrow buttons 42
Sections on the operating panel 42
Settings on the Océ 9600 Copier operating panel 44



4 Océ 9600 Copier/Printer User Manual

Perform basic copy jobs 46
Starting up and shutting down the scanner 47
Make copies 48
Selecting the required media 49
Selecting the input mode 50
Specifying the zoom factor 51
Select the exposure 52
Delivering originals after scanning 52
Defining settings for the next original 53
Using the manual feeder for copying 54
Defining delivery of copies 55
Stopping a copy job 55

Chapter 4
Performing special copy jobs
Non-standard size originals 58

The scan width 59
The copy size 60
Scanning originals with filing strip 61

Improving the image quality 65
Brightness 65

Editing functions 67
Auto shift 67
Shift the image 69
Mirror-image copies 71

Chapter 5
Managing print and copy jobs
Introduction 74

Structure 74
Icons 77

The connection to a controller 78
Managing print jobs 79

Chapter 6
Scan to file
Introduction 82
Make a scan-to-file 83
Settings for scan-to-file 85

File mode 86



Table of Contents 5

Destination 86
File type 86
Tiff subformat 87
Resolution 88
Zoom 88
Optimization 88
Mirror 89

Scan Manager 90
Tree view 91
Table view 91

Actions from the Scan Manager 93
Destinations 93
Scanned files 96
Manage the temporary store 98

How to retrieve scanned files? 99
Get files via FTP 99

Océ View Station 101
Menu options 102
Function buttons 103
View error 104

Chapter 7
System status
Introduction 106

Structure 106
Icons 110

User operations 111

Chapter 8
Remote Logic
Introduction 114
Installation procedure 115

Chapter 9
The Océ 9600 applications
Introduction 120
User modes 121

Log in 122
Logout 122
To change the password 122



6 Océ 9600 Copier/Printer User Manual

Automatic login 123
Ease of use 124

Language 124
Help 124
Command line parameters 125

Work on a remote system 127

Chapter 10
Key operator settings
Introduction 130
Starting up and shutting down the controller 131
Settings Editor 132

General structure 133
Menu bar 134
Row of buttons 134
Settings area 134
General control buttons 135
Status bar 136
How to access the Settings Editor 137
How to perform actions from the Settings Editor 137

Key operator settings 139
Job-related settings for copying 140

Job-related settings for copying (single) 141
Original (group) 143
Copy (group) 149
File (group) 154
Zoom calibration 157

Job-related settings for printing 158
Sheet (group) 160
Finishing (group) 165
Image (group) 168
Layout (group) 172

Printer-related settings 174
System related settings 176

Single options 177
Localization (group) 177
Job priorities (group) 179
Media (group) 180
Timers (group) 181
Disk clean up (group) 183

Scanner related settings 185
Single options 186
Zoom steps (group) 187



7

Timers (group) 188

Chapter 11
System administrator settings
Introduction 192
System Administrator settings 193
Printer related settings 195

Printer Descriptive Language settings (groups) 197
Pen settings 206
System related settings 208

Controller identification settings (group) 209
Set memory reservation settings 211
Connectivity settings 211

Chapter 12
Loading supplies
Introduction 218
Media 219

Rolls 220
Cut sheet material 225

Toner 227
Maintenance of the glass platen and the reference roller 230
Reinforcement unit maintenance 232

A new tape roll 232
The waste box 240
Maintenance of the reinforcement knives 241

Chapter 13
Problem solving
Introduction 244
Original jams in scanner 245
Jams in printer 247

Cut sheet feed section 248
Roll feed section 248
Manual feeder 249
Fuser section 250
Folder 252
Reinforcement unit 260

Other problems 266



8 Océ 9600 Copier/Printer User Manual

Chapter 14
Folder
Océ 9600 folder 268

Folder 268
Off line folding 272
Reinforcement unit 273
Belt unit 275

Appendix A
Overview and tables
Overview of the Océ 9600 system 278
Printer operating panel 279
Scanner operating panel 280
Product specifications Océ 9600 281
List of available material types and sizes 288

Reinforcement strips 289

Appendix B
Safety information
Recommended weight limits 292
Instructions for safe use 294
Safety data sheets 295

Safety data sheet Océ 9600 printer and folder 295
Safety data sheet Océ 9600 scanner 295
Safety data sheet Océ 9600 printer 296

EPA Energy Star® 297

Appendix C
Miscellaneous
How to read this manual 300
User survey 301
Addresses of local Océ organizations 303



9

Océ 9600 Copier/Printer

User Manual

Chapter 1
Introduction

This chapter contains a general introduction to the
Océ 9600, including a general description of the main 
features, delivery options and software applications 
provided with the system.
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About this manual

This manual contains the following chapters

Chapter 1: Introduction  contains a general introduction to the Océ 9600 
system, including a general description of the main features, delivery options 
and software applications provided with the system.

Chapter 2: Using the Océ 9600 printer  contains a brief description of the 
actions that can be performed on the printer operating panel of the Océ 9600.

Chapter 3 Using the Océ 9600 copier  contains a brief description of the 
actions that can be performed on the scanner operating panel of the Océ 9600 
plus the basic copy functions that are available from the system.

Chapter 4: Performing special copy jobs  provides a detailed description of 
special copy functions to be performed on the Océ 9600.

Chapter 5: Managing print and copy jobs  describes how to view the Océ 9600 
print queue and how to abort the active print, how to delete and pause print jobs 
in the queue and how to restart jobs that have been put on hold.

Chapter 6: Scan to file  describes how to scan originals to a file.

Chapter 7: System status  describes how to view the system status of the Océ 
9600.

Chapter 8: Remote Logic  describes how to install the remote versions of the 
Queue Manager, System Control Panel and Settings Editor on a user PC.

Chapter 9: The Océ 9600 applications  describes the general functionality of 
the Océ 9600 applications.

Chapter 10: Key operator settings  describes how to make key operator 
settings with the Settings Editor.

Chapter 11: System administrator settings  describes how to make system 
administrator settings with the Settings Editor.

Chapter 12: Loading supplies  describes regular maintenance tasks, such as 
refilling paper and toner or refilling the reinforcement unit.
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Chapter 13: How to solve problems  describes the problems that may occur 
while using the Océ 9600.

Chapter 14: Folder  contains a description of the optional folder delivered with 
the Océ 9600.

Appendix A: Overview and tables  contains the product specifications for the 
Océ 9600, a list of available material types and sizes.

Appendix B: Safety information  contains the recommended weight limits, 
instructions for safe use, the available safety data sheets and the applicable 
ENERGY STAR® specifications.

Appendix C: Overview of printer/copier parts  To help you quickly find the 
parts of the copier and the functions on the operating panel, an illustration of 
the Océ 9600 is presented in appendix A or B.

Appendix D: Miscellaneous  contains the notation conventions, a reader’s 
comment sheet and the addresses of local Océ organizations.

Index  indicates where you can find the most commonly used terms in the 
manual.
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The Océ 9600

The Océ 9600 is a wide-format, black-and-white, electrophotographic, mid- to 
high-volume copier/printer/scanner. The machine is available in a number of 
printer configurations, ranging from two rolls in a single drawer (the minimum 
configuration) to a maximum of six rolls (with one cassette tray) and three 
cassette trays (with four rolls). 
The Océ 9600 is a versatile, highly productive system which offers you a broad 
range of functions. See ‘Product specifications Océ 9600’ on page 281 for 
more information.

[1] Océ 9600
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Océ 9600 key concepts

Printer configuration  The Océ 9600 is available in a number of printer 
configurations, ranging from two rolls in a single drawer (the minimum 
configuration) to a maximum of six rolls with one cassette tray and four rolls 
with three cassette trays. Also, a number of optional features are available, 
including a folder, a horizontal delivery tray, a roll loader and a paper switch 
for supporting customer finishing units.

Copy functionality  With the Océ 9600 scanner, a large number of copy 
activities can be performed. A wide variety of original and copy related 
settings are supported. Users can specify particular layout, media, finishing, 
feeding and quality enhancement options from the scanner operating panel. 
See ‘Product specifications Océ 9600’ on page 281 for more information.

Scan to file  The Océ 9600 offers full hybrid performance with its optional 
scan-to-file function. Documents are scanned and then digitally stored. Ten 
customizable destinations are supported.

Network connectivity  The Océ 9600 supports a number of popular network 
protocols. This means that it can be used in multiple networking environments 
such as TCP/IP, NetBEUI, and Novell Pserver (IPX/SPX).

Set processing  The Océ 9600 supports set processing. This means that when 
you send a file to the printer, it is processed once and can be printed many times 
(as required). The Océ 9600 is equipped with a set memory for storing up to 
250 A0s, which allows for the creation of identical sets that are sorted either 
by page or by set.

Print/copy job  A print/copy job is a job sent to the Océ 9600 Printer from a 
user application (print job) or from the scanner (copy job). A print/copy job 
may consist of several sets, which in turn may consist of several pages. Sorting 
of a print/copy job may take place based on sets or on pages.

Spool memory  The Océ 9600 contains a spool memory which provides a 
queuing system for files you want to print. The spool memory allows multiple 
users to send print jobs to the Océ 9600 simultaneously. The print jobs are then 
placed in the print queue where they wait to be printed. The first job put into 
the queue is the first to be printed.
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Job recovery  The Océ 9600 is equipped with a job recovery function that 
safeguards users against data loss in case of a printer failure. After a restart, the 
data submitted to the printer before the crash will be automatically processed 
and printed. This means that jobs do not have to be resubmitted after a printer 
malfunction, thus saving valuable time for the users.

Green button principle  The Océ 9600 is a very user-friendly system. The 
scanner, in particular, is very easy to operate. Basic copy jobs can be performed 
by simply pressing the green start button on the scanner operating panel. If you 
want to perform more complex copy jobs, you have to change the default copy 
settings with the help of the other settings on the scanner operating panel.

User interaction  The user can communicate with the Océ 9600 from different 
locations, both locally (printer and scanner operating panels, controller 
applications) and remotely (drivers on user workstations, Remote Control 
Format (RCF) files or Océ Job Tickets (OJT) and remote applications):
■ Operating panels

The Océ 9600 consists of two operating panels for making a wide variety of 
settings for printing and copying. See ‘Printer operating panel’ on page 26 
and ‘Scanner operating panel’ on page 40 for more information.

■ Controller applications
The Océ 9600 controller applications are used for making default key 
operator and system administrator settings (Settings Editor). For viewing the 
status of the jobs in the print queue, use the Queue Manager. The ‘System 
Control Panel’ shows the status of the entire system. With ‘Scan Manager,’ 
you can define all relevant settings for scan to file. See ‘Océ 9600 controller’ 
on page 19 for more information.

■ Printer drivers
With the Océ 9600, a number of printer drivers can be used, including Plot 
Director, Windows driver, AutoCAD ADI/HDI and PostScript. With these 
drivers, PC users can access the Océ 9600 remotely, from their applications 
to print their files. More information about installing, configuring and using 
drivers can be found in the documentation provided with the drivers. All Océ 
drivers (except Postscript) can be freely downloaded from the Internet at 
www.oce.com.
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■ A Remote Control Format (RCF) file or Océ Job Ticket (OJT) can be used to 
instruct the Océ 9600 on how to handle a remote print job. The specific 
settings can be made by a user on a control panel, or by means of the user 
interface (UI) on a workstation or PC. The RCF file/job ticket specifies the 
sets of inputs, the sets of outputs and the processing that is needed to form 
the outputs. See the ‘Remote Control Format Reference Manual’ and the 
‘Océ Job Ticket Reference Manual’ for more information about Remote 
Control Format (RCF) files or Océ Job Tickets (OJT).
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Océ 9600 users

On the Océ 9600, the following user types can be identified:

System administrator  The Océ 9600 system administrator is responsible for 
installing and configuring the Océ 9600 in his or her environment. He defines 
the printer language settings, pen settings and Automatic Language Sensing 
(ALS) settings. The system administrator can also provide assistance to normal 
users who need to install the printer drivers on their workstations. See 
chapter 7, ‘System status’ on page 105 for more information. Configuration 
information can be found in the Océ 9600 Connectivity Manual provided with 
the Océ 9600.

Key operator  The Océ 9600 key operator is responsible for daily maintenance 
of the Océ 9600. The key operator replenishes toner when necessary, loads 
media as needed and defines the default printer settings for recurring print jobs. 
Also, the key operator defines all time settings, such as panel time out and 
sleep mode time out. See chapter 10, ‘Key operator settings’ on page 129 for 
more information. 

Repro operator  The Océ 9600 repro operator is responsible for the daily 
operations on the Océ 9600. The repro operator performs all job-related 
activities on the system and is allowed to change the default settings for 
job-related activities in the Settings Editor. 

Anonymous user  Typically, an anonymous user on the Océ 9600 can be either 
a PC user who has remote access to the system through one or more drivers 
(Plot Director, Windows driver, AutoCAD ADI/HDI or PostScript), the remote 
applications (Queue Manager, System Control Panel and Settings Editor), or a 
user performing a copy job at the scanner.
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Océ 9600 components

The Océ 9600 is available as a digital network printer, copier and scan-to-file 
system. It consists of the following components:

■ Printer (see ‘Océ 9600 printer’ on page 17)
■ Scanner (see ‘Océ 9600 scanner’ on page 18)
■ Controller (see ‘Océ 9600 controller’ on page 19)
■ Optional features (see ‘Océ 9600 optional features’ on page 21)

These components, in combination with your network, Plot Director and one 
or more drivers (Windows driver, AutoCAD HDI or PostScript), allow you to 
use the Océ 9600 as your default enterprise printing and copying solution.

See the Océ 9600 Connectivity Manual for more details about making 
networking settings on the Océ 9600 printer. More information about 
installing, configuring and using drivers can be found in the documentation 
provided with the drivers.

Note: All Océ drivers and file submitters can be freely downloaded from the 
Internet at www.oce.com.

Océ 9600 printer
As a user, you can perform a number of activities at the Océ 9600 printer. You 
can start up and shut down the printer, set the media type and size, set a special 
media indication, stop a print job or select your preferred language from the 
printer operating panel (see chapter 2, ‘Using the Océ 9600 Printer’ on page 25 
for more details). With the manual feeder, you can manually feed sheets of 
printing material if you want to print a job on a media type and/or size that is 
not available on one of the paper rolls or in one of the cassette trays (see ‘Océ 
9600 manual feeder’ on page 18 for more information). 
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Océ 9600 scanner
The Océ 9600 scanner supports a wide range of copy activities. It provides a 
large number of functions for defining original and copy-related settings. 
Users can specify particular layout, media, finishing, feeding and quality 
enhancement options from the scanner operating panel. In combination with 
the Océ 9600 printer, it constitutes a powerful productivity tool.

The Océ 9600 scanner is also used to carry out ‘scan to file’ operations.

Océ 9600 manual feeder

The Océ 9600 offers you the ability to manually feed sheets of printing 
material. This can be convenient if you want to print a job on a media type 
and/or size that is not available on one of the paper rolls or in one of the cassette 
trays. The manual feed is a special slot just above the paper drawers on the 
engine. You can insert cut sheet material in this slot, one sheet at a time.

Note: Only use material as specified in ‘List of available material types and 
sizes’ on page 288.

[2] Océ 9600 manual feeder

Attention: When you feed a sheet of printing material in the manual feeder 
while a normal print job is being executed, a media jam may occur.
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▼▼▼▼ Use the manual feeder

1 Select the manual feed option from the printer driver and select the media to 
print on before you send the job to the printer.
Note: More information about Océ 9600 Plot Director and other printer 
drivers can be found in the online help provided with those drivers.

2 Wait until the following message appears on the printer display:
(for example): Waiting for manual feed job xxx. Feed A3 portrait, plain paper.

3 Go to the printer and specify the required media on the operating panel. See 
‘Set media type for manual feeder’ on page 33 for more information.

4 Take your sheet of print material to the manual feed.
Note: Avoid using sheets that have already been printed on one side. 
Otherwise, the Océ 9600 might become damaged.

5 Use both hands to align the print material with the format indication on the 
manual feed.

6 Move the material forward into the manual feed slot until the printer pulls in 
the first part of the sheet.
A few seconds later, the complete sheet will be pulled into the printer.

7 If the print job requires more sheets, the printer will ask you to feed in the next 
sheet.

8 Collect your output.

Note: The sheet must be inserted face-up.

Océ 9600 controller

The Océ 9600 is equipped with a workstation which helps you to make 
optimum use of your system. This workstation runs a number of applications 
which allow you to control your print jobs, make your default printer settings 
and monitor the printer status. These applications include:

■ Queue Manager (QM)
■ System Control Panel (SCP)
■ Settings Editor (SE)
■ Scan Manager (SM)
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Queue Manager  The Océ 9600 Queue Manager (QM) application provides 
you with a graphical representation of the print queue. It allows you to view 
the print queue and the status of the print jobs, as well as to manage the jobs in 
the queue. With the Océ 9600 Queue Manager you can:
■ View the print queue
■ Abort the job currently being printed
■ Delete job(s) in the queue
■ Pause job(s) in the queue
■ Restart previously paused job(s) in the queue

See chapter 5, ‘Managing print and copy jobs’ on page 73 for more 
information about the Océ 9600 Queue Manager.

System Control Panel  The Océ 9600 System Control Panel (SCP) application 
provides you with status information about the printer. This includes:
■ Machine status of the Océ 9600 printer and scanner
■ Set memory monitor to view the available storage space on the controller.
■ Overview of the loaded media types and sizes.

See chapter 6, ‘Scan to file’ on page 81 for more information about the Océ 
9600 System Control Panel.

Key Operator settings / System Administrator settings  The Océ 9600 
Settings Editor allows an operator to configure and set up job, printer, system 
and scanner specific settings. These settings include:
■ Format options
■ Editing options
■ Media-related options
■ Finishing options
■ General job, printer and system options

See chapter 10, ‘Key operator settings’ on page 129 for more information 
about the Océ 9600 Settings Editor application.

The system administrator settings in the Océ 9600 Settings Editor application 
allow the system administrator to configure and set up all aspects related to the 
infrastructure of the system. These settings include:
■ Host information
■ Network settings
■ Pen settings
■ Printer language settings
■ General administrator settings



Introduction 21

See chapter 9, ‘The Océ 9600 applications’ on page 119 for more information 
about the Océ 9600 Settings Editor application.

Scan Manager  The Scan Manager is an application available only locally on 
the controller. With the Scan Manager you can: 
■ configure the destinations for ‘scan to file’. 
■ increase your productivity with automatic file naming. 

See chapter , ‘Scan Manager’ on page 90 for more information about the Océ 
9600 Scan Manager application.

Océ 9600 optional features

By default, the Océ 9600 is equipped with an Integrated Receiving Tray (IRT) 
as the output delivery device. The IRT is the rack on top of the machine (see 
figure 1 on page 12). A number of optional features are also available with the 
Océ 9600. These include:

Rolls and cassette trays  The Océ 9600 is available in many configurations, 
ranging from two rolls in a single drawer, to four rolls in two drawers plus three 
cassette trays. A maximum of six rolls (in combination with one sheet feeder) 
and three sheet feeders (in combination with four rolls) can be configured. 

Note: Contact your Océ representative if you want to know more about the 
available configurations.

Each of the rolls and cassette trays on the Océ 9600 may be loaded with print 
material of a different size or type. The size and type of the available media are 
indicated on the operating panel.
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Original delivery tray  The original delivery (see figure 3) tray can be used to 
stack a number of originals behind the scanner after they have been scanned.

[3] Original delivery tray

Roll loadr  In order to help customers to achieve optimum productivity with 
their Océ 9600 and at the same time comply with the international safety 
regulations as far as maximum roll weights are concerned, Océ provides an 
optional roll loader for use with the Océ 9600. See ‘Recommended weight 
limits’ on page 292 for more information about the maximum recommended 
roll weights.

[4] Roll loader

Paper switch  To allow customers to use their own output delivery devices, or 
CFUs (Customer Finishing Units), with the Océ 9600, Océ has developed the 
paper switch. This switch is used to direct output to the delivery device of your 
choice.
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Copy Delivery Tray  The Copy Delivery Tray can be used to neatly stack a 
number of prints of various sizes. This tray can be extended for longer prints. 
Unfolded copies can be delivered to the Copy Delivery Tray. The Copy 
Delivery Tray can be used in combination with the Integrated Receiving Tray 
(IRT).

[5] Copy Delivery Tray

Folder  If the Océ 9600 is equipped with a folder, the folded copies are fed into 
the standard delivery of the folder, by default. The folder can be combined with 
the integrated receiving tray (IRT).

[6] Folder
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Reinforcement unit  The optional reinforcement unit adds a firm plastic rim 
with punched holes to the copy (see figure 7).

[7] Copy with reinforcement unit
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Chapter 2
Using the Océ 9600 Printer

This chapter contains a brief description of the operating 
panel of the Océ 9600 Printer and the actions that can be 
performed on it.
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Printer operating panel

The printer operating panel, located on the right-hand side of the printer 
console, is easy to use (see figure 8). The panel consists of a number of buttons 
and a graphical display. At the top of the panel there is an indicator (a light) 
which starts flashing when operator intervention is required.

[8] Printer operating panel

Stop button

On line 
button

Up/Down
buttons

Selection
buttons



Using the Océ 9600 Printer 27

Display
The graphical (LCD) display offers feedback about the current printer status. 
It provides you with the following information: 

■ Status information (e.g. ‘Preparing for run’ or ‘Ready to print’).
During normal operation, the following message types may appear: 
Status/action message: indicates the actual status of the printer plus the 
action to be taken, e.g. ‘Roll empty. Feed A2, plain paper’.
Warning message: during a warning message, the printer will continue to 
operate, but it is possible that the print quality will not be optimal, e.g. ‘Fill 
B5 toner’.
A graphical overview of available rolls and cassette trays, including the 
material type and size used by each roll or cassette tray.

■ A symbol indicating the paper orientation (for cassette trays only).
■ An indication that a particular roll or cassette tray is empty (if applicable).

An empty roll is represented by a dotted roll symbol.
An empty cassette tray is displayed as an empty paper tray.

■ In the event of an error, a graphical representation of any error location (cover 
or panel), together with instructions on how to solve the problem is 
displayed.
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Counter
On theOcé 9600 Printer operating panel, a counter will be displayed that gives 
the user feedback about the progress of the job that is currently being printed. 
The counter, located at the bottom of the upper window on the operating panel, 
displays the number of sets and/or pages printed. Counting starts at 1. The 
following options are available:

■ When no sets are made, only the current page and the total number of pages 
are displayed (e.g. ‘Page 3 of 5’). At the beginning of a job, when the system 
does not yet know the total number of pages, only the current page may be 
displayed (e.g. ‘Page 5’).

■ With set input: set counter. In this case, the counter shows the current, total 
number of sets and the current page (e.g. ‘Set 3 of 5, Page 10’). At the 
beginning of a job, when the system does not yet know the total number of 
sets, only the current set and page may be displayed (e.g. ‘Set 2, Page 5’).

■ With set input: multiple sheet counter. In this case the counter shows the 
current page, the total number of pages and the current copy, e.g. ‘Page 2 of 
12, Copy 5’). At the beginning of a job, when the system does yet not know 
the total number of pages, only the current page and copy may be displayed 
(e.g. ‘Page 2, Copy 5’).
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Buttons 
With the buttons on the operating panel, you can make a number of settings for 
the Océ 9600 Printer, such as the media type and size or the preferred language.

The following buttons are available: 

Button types

Function
Selection
buttons

The selection buttons are located immediately below the 
graphical display. The left button can be used to activate one 
of the main menu choices (Language, Folding or 
Media) on the left part of the display. 

Note: A shadow highlighting effect is used to indicate the ac-
tive menu option.

The right selection button can be used to activate the options 
on the right part of the graphical display.

Note: To identify the active selection, the dotted line around 
this selection is changed into an uninterrupted line and the 
small selection triangles next to the specified option are no 
longer dimmed.
These selection triangles indicate that you can select an op-
tion from a predefined list with the help of the Up/Down but-
tons.

Up/Down
buttons

These two triangular buttons to the right of the graphical dis-
play are used to display the next or previous option from the 
selected menu choice and to select the desired option.

On line button By pressing the on line button you can put the printer on line 
or off line. If the green light above the on line button is on, the 
printer is on line; if this light is off, the printer is off line.

Stop button The red stop button is used to stop the present print job. After 
this button is pressed, a dialog will display and ask for confir-
mation.

Note: The printing process does not stop instantaneously be-
cause a number of prints may already have been submitted to 
the printer after processing. The prints cannot be stopped.

Key button The green key button has no function.
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Printer panel actions

On the Océ 9600 printer operating panel you can perform a limited number of 
actions. These include: 

■ Starting up and shutting down the printer
■ Setting media type
■ Setting media type for manual feeder
■ Setting media size
■ Setting a special media indication
■ Stopping a print job
■ Selecting the preferred language
■ Making off-line folding settings
■ Cleaning the reinforcement knives
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Starting up and shutting down the Océ 9600 
After starting up the Océ 9600 Printer, it is ready for operation. 

▼▼▼▼ Start up the system

1 Set the on/off switch at the rear of the printer to position ‘1’ (see figure 9). If 
the mains is connected correctly, the green switch will light up.

[9] Printer on/off switch

2 Turn on the scanner.
3 Turn on the controller and the monitor. 

Note: The Océ 9600 controller will be started up automatically.

▼▼▼▼ Turn off the system

1 Select the ‘Shut down’ option from the System Control Panel.
2 Turn off the controller and the monitor.
3 Set the on/off switch at the rear of the printer to position ‘0’ (see figure 9).

Note: Turning off the printer during a print job may cause loss of 
information or a paper jam.

Note: After turning it off,  wait at least 5 seconds before you restart the system.

On/off switch
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Media type and size on the printer
One of the features of the Océ 9600 printer is the automatic media change 
function. This function allows the printer to switch to another roll of the same 
format and copy material when the roll or cassette tray becomes empty during 
printing.

Note: Because the Océ 9600 Printer cannot detect the loaded copy material 
type and format itself, you have to specify type and size after you (re)load 
media, as described in ‘Media’ on page 219.

See ‘List of available material types and sizes’ on page 288 for an overview of 
all materials that can be used on the Océ 9600 Printer.

▼▼▼▼ Set media type

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window.

[10] Operating panel in off line mode

The focus is shifted to the Media option (indicated by the shadow effect).
2 Use the Up/Down buttons to select the roll or cassette tray for which you have 

just loaded new media.



Using the Océ 9600 Printer 33

3 Press the right selection button to activate the Mat. (Material) option.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified material are no 
longer dimmed.

4 Use the Up/Down buttons to select the material you just loaded.
5 Press the on line button to put the printer on line again. The printer now knows 

which material is used for the specified roll or cassette tray.

▼▼▼▼ Set media type for manual feeder

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window.

2 Press the left selection button to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the Up/Down buttons to select the Manual option.
4 Press the right selection button to activate the Mat. (Material) option.

The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified material are no 
longer dimmed.

5 Use the up/down buttons to select the material you just loaded.
6 Press the on line button to put the printer on line again. The printer now knows 

which material is used by the manual feeder.

▼▼▼▼ Set media size

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window (see figure 10 on 
page 32).

2 Press the left selection button to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the up/down buttons to select the roll or cassette tray for which you have 
just loaded new media.

4 Press the right selection button to activate the Size option.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified size are no longer 
dimmed.

5 Use the up/down buttons to select the size of the media you just loaded.
6 Press the on line button to put the printer on line again. The printer now knows 

which media size is used for the specified roll or cassette tray.
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Special media indication
On the Océ 9600 Printer, you can attach a Special indication (exclamation 
mark: !) to a roll or cassette tray which uses special media (for instance colored 
paper). This indication is used to identify the roll or cassette tray to the printer. 
For this roll or cassette tray, the automatic media change option is disabled.

▼▼▼▼ Set a special media indication

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window (see figure 10 on 
page 32).

2 Press the left selection button to shift the focus to the Media option.
A shadow effect is used to indicate that the focus is set to this option.

3 Use the up/down buttons to select the roll or cassette tray for which you have 
just loaded special media.

4 Press the right selection button to activate the ‘Type’ option.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified type are no longer 
dimmed.

5 Use the up/down buttons to select the Special option for the specified roll or 
cassette tray.

6 Press the on line button to put the printer on line again. The printer now knows 
that the specified roll or cassette tray contains special material.

Interrupt a print job

The red ‘Stop’ button on the Océ 9600 Printer operating panel interrupts the 
active print process. You can cancel or continue the current print job.

▼▼▼▼ Cancel a print job

1 Press the ‘Stop’ button. 
A dialog is displayed informing you that you can press ‘on line’ to continue or 
stop to cancel the job.

2 Press the ‘Stop’ button again to cancel the current job.
Note: In general, the printer cannot be stopped immediately because the 
started prints have to be finished. Printing will be stopped at the end of the 
page.

▼▼▼▼ Continue a print job

1 Press the ‘Stop’ button. 
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A dialog is displayed informing you that you can press ‘on line’ to continue or 
stop to cancel the job.

2 Press the ‘On line’ button to continue the current print job.

Select a language
On the operating panel of the Océ 9600 Printer you can specify which language 
you want to use for displaying printer information, such as status and error 
messages.

By default, you can choose between two languages, which have been defined 
for your system by the key operator (see chapter 10, ‘Key operator settings’ on 
page 129). 

Note: If the key operator has specified only one language, it will not be possible 
for you to choose. In that case, the language option will not appear on the 
operating panel.

▼▼▼▼ Select a language

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window.

2 Press the left selection button to shift the focus to the Language option.
A shadow effect is used to indicate that the focus is set to this option.

3 Activate the Language option by pressing the right selection button.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified language are no 
longer dimmed.

4 Use the up/down buttons to switch between the predefined languages.
5 The language specific elements on the display are immediately customized to 

reflect your language choice. Only the indicator for the language itself is in the 
alternate language. This way you always know what your alternate language is.

6 Put the printer on line again by pressing the on line button. The printer now 
uses the selected language.
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Off-line folding settings
On the  Océ 9600 Printer operating panel, you can specify the settings you 
want to use for off-line folding. These settings include defining the length and 
width of the folded package, enabling and defining the binding edge, selecting 
the input method and legend position and cleaning the reinforcement knife.

▼▼▼▼ Make off-line folding settings

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window.

2 Activate the Folding option by pressing the left selection button.
The dotted line around the current selection is changed into an uninterrupted 
line and the small selection triangles next to the specified option are no longer 
dimmed.

3 Use the up/down buttons to toggle through the available options.
4 Activate the Input option and press the right selection button to activate the 

Legend option.
5 If necessary, change the value in the Legend field with the up/down buttons.
6 Press the right selection button again to activate the Method option. 
7 If necessary, change the value in the Width field with the up/down buttons.
8 Press the left selection button again and use the up/down buttons to select 

another option. This can be Package (with sub-options Length and Width), 
Binding (with suboptions Size and Binding), or Special (with sub-option 
Knife).

9 Make any desired settings.
10 Put the printer on line again by pressing the on line button. The printer now 

uses the specified off-line folding settings.
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Positioning the reinforcement knives (optional)
Because the knives of the optional reinforcement unit of the folder get sticky 
from the glue on the reinforcement tape, they have to be cleaned regularly. You 
are recommended to clean the knives each time you have inserted a new tape 
roll (see ‘A new tape roll’ on page 232) or when an error in the reinforcement 
unit has occurred.

Before you can clean the reinforcement knives, you have to place them in such 
a position that all the parts that need to be cleaned are accessible. You can do 
this from the printer operating panel.

▼▼▼▼ Prepare the reinforcement knives for cleaning

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window.

2 Press the left selection button to shift the focus to the Folding menu.
A shadow effect is used to indicate that the focus is set to this menu.

3 Select the Special option from the Folding menu.
4 Press the ‘start’ right selection button to activate the Knife option.

The following information is now displayed in the panel display:

[11] Cleaning the reinforcement knife

Note: When a job is running, the ‘Job interrupted’ message appears. The 
machine stops running after it has correctly finished the prints that were 
already in the engine. Then the reinforcement knives are placed in the 
correct position. 

5 You can now continue to clean the reinforcement knives (see ‘Maintenance of 
the reinforcement knives’ on page 241).
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Chapter 3
Using the Océ 9600 Copier

This chapter contains a brief description of the interface of 
the Océ 9600 Copier and the actions that can be performed 
on its operating panel.
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Scanner operating panel

The Océ 9600 is a very user-friendly system. The scanner, in particular, is very 
easy to operate. Basic copy jobs can be performed by simply pressing the green 
start button on the scanner’s operating panel. If you want to perform more 
complex copy jobs, you have to change the default copy settings with the help 
of the other settings on the scanner operating panel.

The operating panel is located above the original feed. The Océ 9600 Copier 
operating panel is illustrated below. As you can see in this diagram, the panel 
consists of a display in the center, surrounded by a number of function, section 
and arrow buttons. To the left of the display, you can find the Stop and Interrupt 
buttons. Below the display, you can find the Start, Numeric and Correction 
buttons as well as the Counter window.

This section consists of two parts. The first part explains the basic use of the 
buttons. The second part deals with special use of the display. It describes how 
to use the soft buttons above and along the sides of the display to define your 
copy settings.

.

[12] Scanner operating panel

Stop
button

Interrupt
button

Correction buttonStart button

Section buttons Arrow buttons

Function
buttons

Numeric buttons
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Display
The display is used to make settings for copying. The display provides 
feedback about the system status. 

The scanner display informs you about:
■ the number of copies you have selected, the media selection, input mode, 

zoom settings and exposure. 
■ the actual system status, for example ‘Ready to copy’. In the event of an error 

in the scanner, the exact error location is graphically shown on the scanner 
display, together with instructions on how to solve the problem.

Buttons 

With the buttons on the operating panel you can make a number of settings for 
the Océ 9600 Copier.

The following buttons are available: 

Button type

Function
Start buttons The green button marked with  is used to start the 

feeding of the original, or to re-start the copy process.
Numeric buttons The buttons with numbers on the lower part of the oper-

ating panel are used to enter numbers. 
Correction button The orange button marked with C, located at the bottom 

right of the operating panel. If you press the correction 
button once, the copy counter is set to the default (prob-
ably ‘1’). If you press this button twice, all settings are 
reset to their default values.

Stop button Pressing the red button to the left of the display stops the 
copy process for the current original. You can stop the 
original transport immediately when an original jam oc-
curs.

Interrupt button Currently not in use.
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Section, Function and Arrow buttons
Apart from the buttons mentioned above, the operating panel of theOcé 9600 
Copier contains a number of other buttons. These include:
■ Section buttons
■ Function buttons
■ Arrow buttons.

The section buttons are the four buttons located above the display. These 
buttons provide access to the ‘Custom’, ‘Original’ and ‘Copy’ sections on the 
display. 

Each section contains several functions (cards). These can be accessed with the 
help of the function button on the far left, which is also called the card selection 
button.

The other function buttons allow you to select functions or subfunctions within 
a card. 

Finally, the arrow buttons can be used, like the numeric buttons, to define 
numeric settings. The arrow buttons are also used for selecting subfunctions 

Sections on the operating panel

The operating panel of the Océ 9600 Copier consists of the following three 
sections:
■ Custom
■ Original
■ Copy.

Custom section  Upon startup of the Océ 9600 Copier, a number of default 
settings are available from the ‘Custom’ section. These settings, which can 
also be found in one of the other two sections, are the most commonly used 
options on the Océ 9600 Copier. The key operator can change the contents of 
the ‘Custom’ section from the Settings editor on the controller (see ‘Specify 
the custom card’ on page 138).
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By default, the ‘Custom’ section includes the ‘Media’, ‘Input mode’ and 
‘Zoom’ settings plus one or two others. This could be, depending on your 
configuration and language settings, the ‘Folding’ (if you have a folder), 
‘Language’ (if you work with more than one language) or ‘Exposure’ settings. 
See figure 12 on page 40 for an example of the ‘Custom’ section.

Original section  The ‘Original’ section contains all settings for the original, 
divided over a number of cards. The following cards are available (top to 
bottom):
■ Scanner
■ Image
■ Sheet
■ Feeding

Each card contains a number of specific options, as shown below.

[13] Original section of the Océ 9600 Copier

Copy section  The ‘Copy’ section contains all settings for the copy, divided 
over a number of cards. The following cards are available (top to bottom):
■ Image
■ Layout
■ Finishing
■ Sheet
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Each card contains a number of specific options, as shown in figure 14 on 
page 44.

[14] Copy section of the Océ 9600 Copier

Settings on the Océ 9600 Copier operating panel

On startup of the Océ 9600 Copier, the ‘Custom’ section is displayed. This 
contains a number of default values that have been defined by the key operator. 
If you want to make other settings, which are not available from the ‘Custom’ 
section, you take the following steps:

▼▼▼▼ Make settings on the Océ 9600 Copier operating panel

1 Press one of the Section buttons to activate the desired menu.
Note:  The active menu is moved slightly downward to visually separate it 
from the other menus. Apart from that, a shadow highlighting effect is used 
for extra highlighting.

2 Press the Card selection button to select the appropriate card. You can switch 
cards (from bottom to top) by pressing the button again.
Note: The active card is likewise visually separated from the other cards 
and given a shadow highlighting effect for extra highlighting.

3 Select the desired function values in one of the following ways:
■ Simple (non-numeric) selection: press the Function button to activate the 

desired (non-numeric) value. The selected value is preceded by a ‘●’ symbol. 
The ‘Background compensation’ setting demonstrated in figure 13 on 
page 43 is an example of this.

■ Long list selection: if you want to select a value from a list of options that 
cannot be fully displayed on the panel, activate the selection triangles next to 
the specified option (the dotted line around this selection is changed into an 
solid line and the selection triangles are no longer dimmed, indicating that 
there are additional options available. Select one of the non-displayed values 
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with the Arrow buttons.) The ‘Original type’ setting demonstrated in figure 
13 on page 43 is an example of this.

■ Numeric selection: activate the selection triangles and select the desired 
value with the Arrow buttons or with the numeric buttons. The ‘Brightness’ 
setting demonstrated in figure 13 on page 43 is an example of this.

Also a combination of simple selection and numeric selection is possible, as 
shown in the ‘Cut length’ setting demonstrated in figure 14 on page 44.

Note: The Up arrow and Down arrow buttons can be used to increase or 
decrease the active value by 1; the Left arrow and Right arrow buttons 
increase or decrease the active value by 10. An exception to this rule is the 
selection of zoom values. The Left arrow button can be used to browse 
through the predefined reduction steps and the Right arrow button to 
browse through the predefined enlargement steps.
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Perform basic copy jobs

On the Océ 9600 Copier you can perform a number of basic tasks. These 
include:
■ Starting up and shutting down the scanner
■ Making copies
■ Selecting the required media
■ Selecting the input mode
■ Specifying the zoom factor
■ Select the brightness
■ Delivering originals after scanning
■ Defining settings for the next original
■ Defining delivery of copies
■ Stopping a copy job
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Starting up and shutting down the scanner
TheOcé 9600 Copier can be started up and shut down with the on/off switch, 
which is located on the scanner underneath the original feed table (see 
figure 15). 

The on/off switch has two settings:
■ on: the scanner is switched on
■ off: the scanner is switched off.

[15] On/off switch

▼▼▼▼ Start up

1 Push the switch to the ‘on’ position.
The system is immediately available for work. The message ‘Ready to copy’ 
appears.
Note: Make certain the printer and controller are started as well.

▼▼▼▼ Shut down

1 Push the switch to the ‘off’ position.
Note: The scanner can be turned off while the printer is still working.
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Make copies
1 Place your original face-down, aligned to the right along the original guide. 

Keep the legend at your right-hand side.
Note: When feeding the original, keep it in place until it is transported 
(about 1 cm) into the machine.

[16] Inserting the original

Note: Inserting the original
2 Specify the number of copies using the numeric buttons. 
3 Specify the desired copy material on the operating panel. 

 If you select ‘Automatic’ the Océ 9600 Copier will try to use a roll format that 
matches the specified size. 
Note: After inserting the original, the roll or cassette tray that is used is 
indicated by the ‘❍’ symbol.
Use the ‘Media’ function to select copy material and format.

4 Specify how a job will be sorted: ‘Single sheet’, ‘Multiple sheets’ (output: 1-1, 
2-2, 3-3) or ‘Set’(output: 1-2-3, 1-2-3). 
The currently selected input mode is indicated by the ‘●’ symbol.

5 Specify a reduction or enlargement factor on the operating panel by using the 
‘Zoom’ function. 
If you select ‘Automatic’, the Océ 9600 Copier will use a zoom factor that is 
needed to obtain a copy without loss of information. After inserting the 
original, the zoom factor that is used is indicated by the ‘❍’ symbol. 

6 Specify the desired brightness on the operating panel. 
You can use the ‘Brightness’ setting to correct for a lighter or darker original.

7 Specify folding options on the operating panel. 
If the optional folder is installed, you can use the ‘Folding’ settings to get a 
neatly folded copy. 
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8 Press the green start button  to start the copy job.
Your original will be fed into the scanner. The printer starts.

9 Collect your output.
Your copy will be delivered on the selected output unit of the print engine.

Selecting the required media

The ‘Media’ setting can be used to select copy material and format. The 
display will show you what rolls or cassette trays are currently loaded. The 
currently selected roll or cassette tray is indicated by the ‘●’ symbol. 

If you select ‘Automatic’, the Océ 9600 Copier will try to use a roll or cassette 
tray format that matches the original size. After inserting the original, the roll 
or cassette tray that is used is indicated by the ‘❍’ symbol.

Note: The ‘❍’ symbol remains in place until a new original is inserted. Then it 
may move to indicate another roll or cassette tray, depending on the original 
format.

▼▼▼▼ Selecting the required media

1 Select the ‘Sheet’ card in the ‘Copy’ section.
2 Select the desired media with the ‘Media’ function button.

[17] Selecting the required media

Note: You can also select the desired media from the ‘Custom’ section, if this 
setting has been defined for this (see figure 12 on page 40).
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Selecting the input mode
You can use the ‘Input mode’ setting to specify how a job will be sorted: the 
‘Single sheet’ option treats each sheet as a separate job. ‘Multiple sheets’ 
produces the specified number of copies for each sheet in a job and then 
continues with the next sheet. Graphically that would look something like this:

Note: An important characteristic of ‘Multiple sheets’ is that, if this setting is 
selected, the active job is kept together and treated as a whole. In this case, the 
job cannot be interrupted by a high-priority copy job, and there will be no risk 
of getting mixed output.

‘Set’ produces one copy for each sheet in a set and then continues with the next 
copy of the entire set, as follows:

The current input mode can be closed by pressing the Stop button.

The currently selected input mode is indicated by the ‘●’ symbol.

▼▼▼▼ Selecting the input mode

1 Select the ‘Feeding’ card in the ‘Original’ section.
2 Select the desired media with the ‘Input mode’ function button.

[18] Selecting the input mode

Note: You can also select the input mode from the ‘Custom’ section (if this 
setting has been defined for this).

1 1 1 2 2 2 3 3 3 4 4 4 5 5 5

1 2 3 1 2 3 1 2 3 1 2 3 1 2 3
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Specifying the zoom factor
You can use the ‘Zoom’ setting to select a zoom factor. If you select 
‘Automatic’ with the ‘●’ symbol, the Océ 9600 Copier will use a zoom factor 
that is needed to obtain a copy without loss of information. This will be done 
according to the selected media roll or cassette tray. After inserting the 
original, the zoom factor that is used is indicated by the ‘❍’ symbol. 

If you select the numeric zoom factor with the ‘●’ symbol, you can define a 
zoom factor yourself between 25% and 400%. After selecting the numeric 
zoom factor, the four little triangles will appear to the right. Now you can 
define a new zoom factor in two different ways:
■ By using the Arrow buttons on the right of the display (see figure 12 on 

page 40). If you press one of the vertical buttons, the zoom factor will 
increase or decrease with steps of 0.1%. If you press one of the horizontal 
buttons, the zoom factor will increase or decrease with the steps predefined 
in the Settings Editor by the key operator.

■ By using the numeric buttons at the bottom of the operating panel. You can 
specify the exact zoom factor in increments of 0.1%.
For example, if you want to specify a zoom factor of 25.4%, you type 254. If 
you want to specify a zoom factor of 254%, you type 2540.

▼▼▼▼ Selecting the zoom factor

1 Select the ‘Image’ card in the ‘Copy’ section.
2 Select the desired media with the ‘Zoom’ function button.

[19] Selecting the zoom factor

Note: You can also select the zoom factor from the ‘Custom’ section (if this 
setting has been defined for this).
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Select the exposure
You can use the ‘Exposure’ setting to correct for a lighter or darker original.

▼▼▼▼ Selecting the exposure setting

1 Select the ‘Image’ card in the ‘Original’ section.
2 Select the desired exposure level by using the Arrow buttons to the right of the 

display (see figure 12 on page 40).

[20] Selecting the exposure level

Note: You can also select the exposure level from the ‘Custom’ section (if this 
setting has been defined for this).

Delivering originals after scanning

You can choose for delivery of the original at the front (rewind) or the rear side 
of the scanner.

Attention: The ‘Rewind’ function is disabled if the optional copy delivery 
tray is installed.

Note: If you are copying thick or very thin originals, originals that are 
damaged or originals in a carrier sheet, it is recommended to use the output at 
the rear side of the scanner to ensure correct delivery (‘Rewind’ function off).
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▼▼▼▼ Select original delivery

1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Press the ‘Rewind original’ function button to make your selection:

■ ‘On’: Originals are delivered at the front side of the scanner. You have to 
collect each original by hand.

■ ‘Off’: Originals are delivered at the rear side of the scanner.

[21] Using the Rewind original function to select original delivery at the front or the rear

Defining settings for the next original

You can define the settings for each original you want to copy. When 
‘Automatic feed’ is enabled, you should bear in mind that the original is 
automatically pulled into the scanner. If you want to be absolutely sure about 
the settings that belong to an original, insert an original when the settings are 
correct.

Note: To increase your versatility at the scanner input side, you can ask your 
key operator to turn off Automatic feed. When using the scanner with 
automatic feed off, you must press the start button for each new original to be 
scanned. This allows you the possibility of changing the settings for the next 
original, even if you already put the original in place on the scanner feed table.

▼▼▼▼ Define settings for the next copy job

1 Select all settings required for the next original.
2 Insert the next original.

If ‘Automatic feed’ is off, press the start button. 
If ‘Automatic feed’ is on, the original is fed automatically.
Note: You can enable or disable this function from the ‘Scanner’ card in the 
‘Original’ section. See figure 21 on page 53.
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Using the manual feeder for copying
If you want to copy a job on a media type and/or size that is not available on 
one of the paper rolls or cassette trays, it is more convenient to manually feed 
sheets instead of switching paper rolls or cassette trays. The sheet feed is a 
special slot just above the roll drawers on the engine. You can insert pre-cut 
copy material in this slot, one sheet at a time. 

Note: Only use media as specified in ‘’ on page 287. 

▼▼▼▼ Copying on pre-cut sheets

1 Open the ‘Sheet’ card in the ‘Copy’ section.
2 Press the ‘Manual feed’ button. The display will look as follows:

[22] Using the manual feed option

3 Select any other required settings.
4 Enter the number of copies using the numeric buttons.
5 Feed in the original.
6 Press the start button.
7 Take your sheet of copy material to the side of the printer engine that contains 

the sheet feed. 
8 Use both hands to align the copy material in accordance with the format 

indication and the sticker on the manual feed table.
9 Move the copy material forward onto the tip of the roller. This should cause an 

ample paper bulge over the full width of the page.
10 Hold the paper with both hands until the engine pulls in the first part of the 

sheet.
The bulge will be reduced or disappear. A few seconds later, the complete sheet 
will be pulled into the printer.
Note: If the copy job requires more sheets, the display will ask you to feed 
in the next sheet.

11 Repeat steps 7 to 11 to complete the job.
12 Collect your output.
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Note: The image will be printed on the side of the sheet which is facing up.

Defining delivery of copies

Normally, your copies are delivered on the integrated receiving tray on top of 
the Océ 9600 Printer. However, you can specify settings for the delivery of 
your copies on the optional copy delivery tray or on a folder. If you want to use 
your copy delivery tray, take the following steps.

▼▼▼▼ Deliver copies on the copy delivery tray

1 Open the ‘Finishing’ card in the ‘Copy’ section.
2 Use the ‘Copy delivery’ function button to select the ‘Copy deliv. tray’ option.

[23] Delivering copies on the copy delivery tray

Stopping a copy job

Pressing the Stop button interrupts the original transport. 

▼▼▼▼ Stop a job

1 Press the Stop button.
The original transport is now stopped and you are prompted the open the 
scanner cover in order to remove the original.

2 Open the cover, remove the original and close the cover again
You are now ready to start the next copy job.
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Chapter 4
Performing special copy jobs

In this chapter, special copy functions are described in 
greater detail.
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Non-standard size originals

The scanner of the Océ 9600 system automatically detects the width of the 
inserted original. For Example: with European sizes, it detects whether the 
width is A0, A1, A2, A3, A4, 500 mm, or 700 mm. The Océ 9600 system uses 
a memory table that contains all standard width - standard length combinations 
to predict the length of the original. The scanner also measures the real length 
of each original while it is transferred through the scanner.

Note: If you are copying thick, thin or damaged  originals or originals in a 
carrier sheet, we recommend that you use the output at the rear side of the 
scanner to ensure correct delivery (see ‘Delivering originals after scanning’ 
on page 52).
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The scan width
To prevent information loss when copying a non-standard original, you can 
select the ‘non-standard’ scan width. The scanned width will then be larger 
than the original width. It is also possible to define the scanned width and 
length yourself. 

▼▼▼▼ Defining the scan width

1 Open the ‘Sheet’ card in the ‘Original’ section.
2 Press ‘Scan width’ to select the required setting:

■ Standard. This option must be used to copy a standard-sized original.
■ Non-standard. This option can be used to copy a non-standard original. The 

scanned width will be larger than the original width (to the next larger, 
standard size), to prevent information loss.

■ Numeric. You can define the scan width yourself, using the higher/lower 
buttons or the numeric buttons.

[24] Selecting ‘Non-standard’ scan size
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The copy size
The copy width depends on the selected roll or cassette tray or the custom 
defined scan width, whereas the copy length depends on the selected cut 
option.

▼▼▼▼ Copying non-standard size originals

1 Press the ‘Media’ button in the ‘Sheet’ card of the ‘Copy’ section to select 
‘Automatic’, or to select the roll or cassette tray with the correct width.

[25] Selecting roll or cassette tray in the ‘Custom’ section

Note: The media can also be selected directly from the ‘Custom’ section.

Note: When ‘Automatic’ is selected, the roll or cassette tray that is used is 
indicated by the ‘❍’ symbol.

2 Press the ‘Cut length’ function button to select the required cut option:
■ Standard, which cuts copies at a standard length.
■ Synchro, which cuts copies at the end of the image. The system cuts at the 

measured length of the original times the zoom factor.
■ Custom (numeric), which cuts copies on a specified length. You can define 

the copy length yourself, using the arrow buttons or the numeric buttons.
3 Make other settings as required.
4 Feed the original.

Refer to table ‘Standard folding settings’ on page 269 for more information 
about folding copies of non-standard sized originals.

................
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Scanning originals with filing strip
You can adjust the original guide of the scanner to remove a filing strip along 
the left-hand side (right-hand side in the feed direction, face-down). This side 
can be reduced by up to 60 mm (2.36 inches) (see figure 26).

[26] Example of adjusting the left-hand side of an original

▼▼▼▼ Copying with removed filing strip along the left-hand side

1 Press the catch underneath the original guide, and move it to the right.

[27] Adjusting the original guide to add or remove a filing strip along the left-hand side

2 Make all required settings.
3 Insert the original face-down, aligned to the right, with the original guide on 

the original feed table.

Face-up:
Left-hand side
- 40 mm (1.57 inches)

Face-down:
right-hand side 
in feed direction
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You can also remove the filing strip along the right-hand side (left-hand side in 
the feed direction, face-down) by selecting a specific roll or cassette tray. If the 
paper width of the original is greater than the paper width of the selected roll 
or cassette tray, the remaining paper part on the right-hand side will not be 
scanned (see figure 28).

[28] Example of removing the right-hand side of an original 

▼▼▼▼ Scan with removed filing strip along the right-hand side

1 Select the required media in the ‘Custom’ section on the operating panel.
2 Select the 100% value for the ‘Zoom’ function.
3 Make other settings as required.
4 Feed the original.

Face-up:
Right-hand side
- 40 mm (1.57 inches)

Face-down:
left-hand side in feed 
direction
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It is also possible to adjust the length of both the leading and trailing edge to 
eliminate or add a filing strip. Leading and trailing edges can be extended up 
to 400 mm (15.7 inches) or shortened up to 100 mm (3.9 inches) (see 
figure 29).

[29] Example of adjusting the leading/trailing edge of an original

▼▼▼▼ Copy with removed filing strips along the leading and trailing edge

1 Open the ‘Sheet’ card in the ‘Original’ section.
2 Press the ‘Remove strip’ function button.

[30] Removing strip

3 Adjust the values for the trailing edge using the numeric or arrow buttons.
4 Press the ‘Remove strip’ function button again.
5 Adjust the values for the leading edge using the numeric or arrow buttons.
6 Make other settings as required.
7 Feed the original.

Leading edge: 
-1.57 in

Trailing edge: 
1.57 in

Trailing edge: 
-1.57 in

Leading edge: 
1.57 in
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▼▼▼▼ Copy with added filing strips along the leading and trailing edge

1 Open the ‘Layout’ card in the ‘Copy’ section.
2 Press the ‘Add strip’ function button.

[31] Adding strip

3 Adjust the values for the trailing edge using the numeric or arrow buttons.
4 Press the ‘Add strip’ function button again.
5 Adjust the values for the leading edge using the numeric or arrow buttons.
6 Make other settings as required.
7 Feed the original.
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Improving the image quality

You can improve the image quality by modifying the exposure setting, or 
making use of special functions. You will learn how to turn on and off 
automatic background compensation, how to use the lighter and darker buttons 
to achieve the best possible copy quality, or how to adjust the brightness based 
on the type of image you want to copy.

Brightness

The automatic background compensation will provide a good quality copy 
from a large variety of originals. The automatic background compensation  
setting, which is activated (by default), ensures the production of 
background-free copies of most line drawings. 

[32] Brightness settings

▼▼▼▼ Set the automatic background compensation

1 Open the ‘Image’ card in the ‘Original’ section.
2 Press the ‘Background compensation’ function button if this function is 

disabled.

When copying extremely light or dark originals, or originals with unequal 
background intensity, the result may not meet your requirements (e.g. too 
much background). In such cases, you can manually adjust the brightness  (see 
figure 32).
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▼▼▼▼ Manually adjust the exposure setting

1 Press the ‘Exposure’ function button and use the arrow buttons to set the 
exposure as desired.
Note: The Up and Down arrow buttons can be used to gradually increase 
or decrease the exposure setting; the Left or Right arrow buttons can be 
used to go to the highest or lowest available exposure level at once. If you 
want to go from any negative value to the highest possible positive value or 
vice versa, you have to press the corresponding Left or Right button twice. 

2 Specify other settings as required.
3 Feed in the original.

The Océ 9600 Copier allows you to adjust the exposure setting according to 
the type of image on the original. There are five original types available. Select 
a suitable mode according to the original (see figure 32 on page 65).

▼▼▼▼ Adjust the brightness according the type of image

1 Press the ‘Original type’ function button to select the appropriate image type:
■ By default ‘Lines/text’ is selected with ‘Background compensation’ enabled. 

This is the most suitable setting for originals that contain characters and line 
art.

■ Press the ‘Original type’ function button to select ‘Photo’ when the original 
consists of a combination of characters, line art and picture images.

Note: If you select ‘Photo’ or ‘Grays&lines’ , the ‘Background 
compensation’ will be disabled automatically by default.
■ Press the ‘Original type’ function button to select ‘Grays&lines’ when the 

original contains many gray scales and lines.
■ Press the ‘Original type’ function button to select ‘Blue print’ when you want 

to copy an original with an image in ‘negative’ (image in white on dark 
background). The copy will be ‘positive’ (image in black on white 
background).

■ Press the  ‘Original type’ function button to select ‘Dark orig’ when the 
original has an extremely dark background (i.e. low contrast).

2 Specify other settings as required.
3 Feed in the original.
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Editing functions

The Océ 9600 Copier is equipped with a number of editing functions. These 
functions can be set before scanning the original. 

Note: You can select only one edit function at a time.

Auto shift

By selecting the automatic shift function you can move your image to one side 
of the page.

Auto shift supports these shift options:

[33] Auto shift options with standard cut option active

Top Left Top Middle Top Right

Middle Left Middle Middle Right

Bottom Left Bottom Middle Bottom Right
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Note: You must turn on standard cut length to get copies like the one in the 
illustration 33 above. If synchro cut length has been turned on, the result will 
be as follows:

[34] Auto shift options with synchro cut option active

In ‘Shift the image’ on page 69 you can read how to define the exact place of 
your image on the page. 

▼▼▼▼ Select default settings for auto shifting

1 Open the ‘Layout’ card in the ‘Copy’ section.

[35] Automatic shift with the ‘Align’ function

2 Press the ‘Align’ function button and select a horizontal alignment value (Left, 
Middle or Right) with the arrow buttons.

3 Press the ‘Align’ function button again and select a vertical alignment value 
(Top, Middle, or Bottom) with the arrow buttons.
Note: If you select ‘Center’, make sure the original width is specified as 
follows (see ‘The scan width’ on page 59):
■ ‘Standard’ if a standard sized original is used
■ The exact original width (numeric) if a non standard sized original is used.

4 Feed your original.

Top Left Top Middle Top Right

Middle Left Middle Middle Right

Bottom Left Bottom Middle Bottom Right
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Shift the image
In some cases the margin may be too narrow to accommodate filing strips 
without loss of information. To avoid this, you can shift the image in horizontal 
and/or vertical direction, as shown below.

[36] Example of shifting the image
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▼▼▼▼ Shift the image

1 Open the ‘Layout’ card in the ‘Copy’ section.

[37] Image shift

2 Press the ‘Shift’ function button and select a horizontal shift value by pressing 
the numeric or arrow buttons until the required distance is set to shift the image 
to the left or to the right.
Note: When you shift the image horizontally, you can only shift to the left or to 
the right.

3 Press the ‘Shift’ function button again and select a vertical shift value by 
pressing the numeric or arrow buttons until the required distance is set to shift 
the image upwards or downwards.
Note: When you shift the image vertically, you can only shift up or down.

4 Specify other settings as required.
5 Feed in the original.

Note: You can use horizontal and vertical shift simultaneously.
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Mirror-image copies
With the Océ 9600 Copier you can make a mirror-image copy of an original, 
as shown in the next figure:

[38] Example of a mirror-image copy

▼▼▼▼ Make mirror-image copy

1 Open the ‘Image’ card in the ‘Copy’ section.

[39] Mirror-image 

2 Press the ‘Mirror’ function button to enable the ‘Mirror’ function.
3 Specify other settings as required and feed in the original.

Roll 2

type
Process



72 Océ 9600 Copier/Printer User Manual



73

Océ 9600 Copier/Printer

User Manual

Chapter 5
Managing print and copy jobs

This chapter describes how to view the Océ 9600 
print/copy queue and how to abort the active print, how to 
delete and put on hold print and copy jobs in the queue and 
how to restart jobs that are put on hold.
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Introduction

The Océ 9600 Queue Manager application provides you with a graphical 
representation of the print queue. It allows you to view the print queue and the 
status of the print jobs as well as to manage the jobs in the queue. With the Océ 
9600 Queue Manager you can:
■ Abort the job currently being printed
■ Delete job(s) in the queue
■ Put job(s) in the queue on hold
■ Restart job(s) that were previously put on hold in the queue 

Structure

The Océ 9600 Queue Manager window is divided into the following parts (see 
figure 40 on page 75):

■ The standard menu bar.
The menu bar for the Queue Manager contains the following menus:

■ File options: Login, Logout, Connect to, Exit
■ Edit options: defining first and second language and setting default printer 

(only remote). The 'Auto login' option allows you to start the Queue Manager 
application automatically in the specified user mode.

■ View options: selecting first and second language
■ Help options: About Queue Manager, Contents of Queue Manager, 
■ The active print job window.

This window displays the job currently being printed on the Océ 9600.
■ The print queue window.

This window has a tabular format and shows the jobs waiting to be printed. 
The jobs are displayed in the order in which they are expected to be printed.

Note: Copy jobs are automatically moved up in the queue, because they take 
preference over print jobs.
■ Status bar

The Queue Manager has a status bar displaying the following information:
■ System status (connected, not connected)
■  Server (system that contains the controller)
■ User mode
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The following information is displayed for each job:

■ The current status of the job in the form of an icon. See ‘Icons’ on page 77.
■ The name of the print job.
■ The type of job (print job / copy job)
■ The name of the user who has submitted the print job.
■ The number of sets and pages.
■ Any remarks (e.g. 'Manual Feed').

You can resize the columns in the main queue window by dragging the table 
header separators. It is also possible to change the order of the columns by 
dragging a specific column to a new position.

[40] Queue Manager window

Modes  The Océ 9600 Queue Manager has four modes: 
■ Anonymous user mode
■ Repro operator mode
■ Key operator mode
■ System administrator mode

These different modes are designed to limit  access to specific functions to 
authorized users only. 

The anonymous user mode only offers view access to the queue. In this mode, 
the available buttons are disabled, except for the Abort button on the local Océ 
9600 system.

menu bar

active print
job window

header
separator

print queue
window

status
bar
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The repro operator, the key operator and the system administrator modes allow 
you to perform a number of activities on the jobs in the queue, with the help of 
the Abort, Delete, Resume and Hold buttons.

Note: In the Queue Manager and the System Control Panel, the repro operator, 
the key operator and the system administrator have the same user rights. In the 
Settings Editor, however, the user modes offer different rights.

Access  The access to the key operator, repro operator and system 
administrator modes is password protected to allow only authorized personnel 
to use particular functions. You can enter these modes by selecting the Login 
option from the File menu and by specifying the correct password when 
prompted for it (see ‘Log in’ on page 122). 

You can exit the Queue Manager altogether by selecting the Exit option from 
the File menu.

Note: The Exit option is only available when you are working remotely (see 
chapter 8, ‘Remote Logic’ on page 113). In local mode you cannot stop the 
Queue Manager.

Job priority  The priority of print jobs in the Queue Manager is determined by 
the order in which they are submitted to the Océ 9600. However, there is a 
setting in the Settings Editor which allows you to give copy jobs priority over 
print jobs. See ‘Copy priorities’ on page 179 for more information.
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Icons
The Océ 9600 Queue Manager uses a number of icons to display information 
about a job in the queue. The following icons are used:

The job is in the spool and is currently being transferred to the print 
queue.

The job is currently being processed for printing in the print queue.

The job is ready for printing in the print queue.

The job is being received and printed at the same time. 

The job is being processed and printed at the same time. 

The job is being printed.

Note: Jobs that are being printed (this is indicated by a printer 
symbol next to the job in the queue) cannot be put on hold anymore. 
If you select such a job, the Hold button is disabled.

Indicates, both in the active print job and in the print queue 
window, that the job needs special operator attention (e.g. manual 
feed).

The job is marked for deletion and will be automatically deleted 
after a few seconds.

The job is put on hold.
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The connection to a controller

The Océ 9600 applications are not only available locally or on the controller, 
but are also delivered as remote or client versions (except for Scan Manager). 
This means that users can access one or more Océ 9600 systems from their own 
computer. 

Anonymous users can view the status of both their jobs (Queue Manager) and 
the entire system (System Control Panel). This way they can, for instance, 
determine which queue is shortest and send their jobs there to avoid lengthy 
delays.

From a management point of view, the availability of remote versions of the 
applications is quite useful as well. The remote applications allow key 
operators and system administrators to manage multiple Océ 9600 systems 
from a  single location. They can centrally monitor the system status and 
identify potential problems without having to work at the controller itself.

When the Océ 9600 Queue Manager has been installed on a remote client, the 
Connect to option is available in the File menu.

▼▼▼▼ Connect to a controller

1 Click on the Connect to option in the File menu.
A dialogue box will appear containing all the available Océ 9600 systems.

2 Select one of the available Océ 9600 systems and click on OK.
Note: If the system you want to connect to is not available in the list, you can 
click on the Edit... button. A  dialogue box will appear which allows you to 
manually add a Océ 9600 system. For this you need a valid IP address.
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Managing print jobs

The Océ 9600 Queue Manager allows you to perform the following operations:
■ View the print queue
■ Abort the job currently being printed
■ Delete job(s) in the queue
■ Put job(s) in the queue on hold
■ Restart job(s) that were previously put on hold in the queue 

▼▼▼▼ View the print queue

The Océ 9600 Queue Manager displays all jobs sent to the print queue in a list 
sorted according to the order in which they are expected to be printed. This 
ordering can be changed by deleting jobs, putting jobs on hold or restarting 
jobs currently on hold. This list will be automatically updated. 

Note: Queue operations can only be performed when you are properly 
authorized. Before you can use the Queue Manager in a different mode, you 
first have to enter a password to get the required access (see ‘User modes’ 
on page 121).

▼▼▼▼ Abort the job currently being printed

1 Click on the Abort button to the right of the active print job window. The active 
job will now be aborted. 
Note: To abort the job which is currently being printed on the controller, no 
password is required. To abort the current job from a remote client, you 
need repro operator, key operator or system administrator rights.

Note: Consider carefully before you use the Abort button. An abort 
operation cannot be undone.
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▼▼▼▼ Delete print jobs

1 Select the desired job(s) by clicking on them.
Note: You can select a consecutive list of jobs to be deleted by clicking on 
the first job, holding down the Shift key and clicking on the last job. You can 
select a non-consecutive list of jobs to be deleted by clicking on each 
desired job while holding down the Ctrl key.
Note: To delete a job from a remote client, you need repro operator, key 
operator or system administrator rights.

2 Click on the Delete button. 
A cross icon is displayed in front of the job and a confirmation window will 
now be displayed.
Note: Consider carefully before you use the Delete button. A delete 
operation cannot be undone.

▼▼▼▼ Put print jobs on hold

1 Select the desired job(s) by clicking on them.
Note: You can select a consecutive list of jobs to be put on hold by clicking 
on the first job, holding down the Shift key and clicking on the last job. You 
can select a non-consecutive list of jobs to be put on hold by clicking on 
each desired job while holding down the Ctrl key.

2 Click on the Hold button. 
An icon for a job that is put on hold (see ‘Icons’ on page 77) is displayed in 
front of the job when the job is put on hold.
Note: A  job that is put on hold will retain its position in the print queue. 
Once it reaches the top of the queue, the job that is put on hold will stay 
there until it is restarted or deleted. While a job is on hold, other jobs will 
be printed, even when they were behind the job on hold in the queue. The 
active job and the jobs in printing state cannot be put on hold by the Queue 
Manager.

▼▼▼▼ Restart jobs that are put on hold

1 Select the desired job(s) by clicking on them.
Note: You can select a consecutive list of jobs to be restarted by clicking on 
the first job, holding down the Shift key and clicking on the last job. You can 
select a non-consecutive list of jobs to be restarted by clicking on each 
desired job while holding down the Ctrl key.

2 Click on the Resume button. 
The selected job(s) will now be restarted.
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Chapter 6
Scan to file

This chapter describes the Océ 9600 scan-to-file function.
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Introduction

Scan-to-file is an option which enables you to scan a document to a file for later 
(re)use. You enable scan-to-file via a password (see ‘Scan-to-file password 
(single)’ on page 177).

You use scan-to-file in order to:
■ print documents at a later time
■ archive documents
■ email documents
■ reuse the information documents contain in another application

A scan-to-file is made at the Océ 9600 scanner. On the scanner operating panel 
you can, among other things, choose at which resolution you want to scan and 
where you want to store your file. 

The result of the scan-to-file can be stored on the controller (temporary store) 
or directed forward towards a network destination via Window’s Network 
Neighborhood. 

Océ View Station, linked to the Scan Manager application, enables you to 
automatically or manually view the scanned documents afterwards.
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Make a scan-to-file

Scanning an original to file is an easy operation. If the settings (see chapter , 
‘Settings for scan-to-file’ on page 85) are correct, the only thing you have to 
do is press the start button  on the scanner.

▼▼▼▼ Scan-to-file

1 Place your original face-down, aligned to the right along the original guide.
2 Select the appropriate original type.
3 Select the ‘Destination’ card in the ‘File’ section.

[41] ‘Destination’ card in the file section

4 Select ‘File mode’ On.
The status message is displayed: Ready to scan to file.

5 Select a Destination (see ‘Destinations’ on page 93).
6 Press the start button .

The original is scanned. 
A status message is displayed (see figure 42 on page 84):
“Scanning job “Scan job number X””
“File scan22.tif”
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[42] Feedback during scan-to-file

7 On the controller, Océ View Station starts automatically, showing the result of 
the scan (see figure 43).

[43] Océ View Station
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Settings for scan-to-file

The settings regarding scan-to-file on the scanner operating panel are divided 
into two cards: Destination and Image.

Destination card:
■ File mode
■ Destination
■ File type
■ Tiff subformat

[44] Scanner operating panel: Destination card

Image card:
■ Resolution
■ Zoom
■ Optimization
■ Mirror

[45] Scanner operating panel: Image card
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File mode
File mode can be ‘Off’, ‘On’ or ‘On with check plot’. ‘Off’ means normal copy 
mode. ‘On’ results in scan-to-file. Choose ‘On with check plot’ to scan to file 
with a check plot. A check plot is a print of the scanned original, ensuring 
consistency with a later re-print.

Note: The Océ 9600 system does not allow you to change the ‘File mode’ 
setting during a set from ‘On’ to ‘Off ’ or vice versa. However, changing from 
‘On’ to ‘On with checkplot’ and vice versa is allowed.

Note: In scan-to-file mode, the automatic behavior is optimized for scanning. 
Turning check plot on or off does not influence this automatic behavior

Destination

You can store your scan either in the temporary store on the controller or on a 
network destination. You can define up to ten destinations in the Scan Manager 
application. On the scanner operating panel you can choose one of these 
destinations.

▼▼▼▼ Select a destination

1 Press the function button to select destination 1 through 4.
2 To select destinations four through ten, you have to begin by selecting 

destination four. Press the arrow buttons to select destinations 4 through 10.

Note: You can choose any name for the destinations. However, for your 
convenience, you are able to define understandable nicknames in the Scan 
Manager application (see ‘Create a destination’ on page 93).

File type

To define the internal organization of the scanned files, choose between TIFF 
(Tagged Image File Format) and CALS-I (Continuous Acquisition and 
Life-Cycle support).

TIFF  describes image data that typically comes from scanners, frame grabbers, 
and paint- and photo-retouching programs. The purpose of TIFF is to describe 
and store raster image data. A primary goal of TIFF is to provide a rich 
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environment within which applications can exchange image data. This 
richness is required to take advantage of the varying capabilities of scanners 
and other imaging devices. For example, TIFF supports image compression 
with no loss. Though TIFF is a rich format, it can easily be used for simple 
scanners and applications as well because the number of required fields is 
small.

CALS  is an industry strategy for transition of paper-intensive processes to 
highly automated, integrated processes for defense system acquisition, design, 
manufacturing, and life cycle support. 

Tiff subformat
Within the ‘Tiff subformat’ option, you can define the ‘Organization’ and 
‘Compression’ of the file.

Organization   can be (select with the arrow buttons):
■ Stripped 
■ Tiled
■ Raw

Note: Only choose ‘Stripped’ or ‘Tiled’ when you are sure you can use these 
organizations afterwards. Choose ‘Raw’ in any other case.

Compression   can be (select with the arrow buttons):
■ Group 4
■ Group 3-1D
■ None

Note: Only choose ‘Group 4’ or ‘Group 3-1D’ when you are sure you can use 
these compressions afterwards. Choose ‘None’ in any other case.

Note: If you are scanning grayscales or dark originals, use Group 3-1D 
compression. In these cases, group 4 can increase the file size.

Note: ‘Group 4’ or ‘Group 3-1D’ are compression methods which are 
optimized for text and vector drawings. If you choose these compressions when 
scanning a photo with many grayscales, these compressions can result in a 
negative compression: the file size increases instead of decreasing. Use these 
compressions sparingly.
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Resolution
The Océ 9600 scan-to-file option allows you to scan at the following three 
resolutions:

■ 200 dots per inch (dpi)
■ 300 dpi
■ 400 dpi

The higher the resolution, the better the image quality. Higher resolution also 
leads to larger file sizes. The default value is 200 dpi.

Zoom

The ‘Zoom’ option allows you to scale while scanning to a file. When you set 
‘File mode’ to ‘On’, the automatic ‘Zoom’ setting will result in ‘1:1’. You can 
change this default setting into one of the following three settings:

Custom  This option let’s you specify a custom zoom value. You can enter a 
range from 25% to 400%. This value also shows the zoom value when the 
‘Automatic’ option is chosen.

1:1  With this option selected, scan-to-file will result in an image that is exactly 
the same size as the original. ‘Zoom’ displays 100%.

Automatic  Selecting ‘Automatic’ always results in a 1:1 scan to file. 

Optimization

There are two ways to optimize a scan to file.

Scan quality  optimizes for the best image quality. The scan resembles the 
original as much as possible.

File size  optimizes for better compression. Generally resulting in a smaller file 
size and an image quality comparable to copy quality.
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Mirror
You can use the ‘Mirror’ option to scan a horizontally mirrored image of an 
original. Mirroring is performed in the vertical axis.
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Scan Manager

The Scan Manager is an application available only locally on the controller. 
With the Scan Manager you can configure the destinations for scan-to-file. To 
increase your productivity, you can define automatic file naming. This way, 
you can do batch scans without operating the controller.

During scan-to-file, Scan Manager displays the filename and the status of the 
file generation process. When the scan is completed, a view of the scanned 
image is automatically displayed on the controller.

Figure 46 on page 90 shows the Scan Manager application. It has the looks and 
functions of a Microsoft Windows ‘Explorer’. The left part displays a tree view 
containing folders which contain destinations. The right part displays a table 
view containing the content of the folder currently selected. In 46 on page 90 
folder ‘Next Dest(8)’ is selected.

[46] Overview of the Océ 9600 Scan Manager application
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Note: Not all options are available to all users. You must log into a particular 
user mode to perform specific tasks with Océ 9600 Scan Manager (see ‘User 
modes’ on page 121).

Tree view
The tree view displays:
■ the system name
■ the collapsible destination tree
■ the collapsible temporary store tree.

If you scan to a particular destination, that destination is displayed in bold as 
well as the corresponding icon changes. The destination to which you last 
scanned, is displayed in bold.

If you select a destination in order to view it’s content in the right table viewer, 
this destination will appear as having been selected. Figure 46 on page 90 
shows that the destination ‘Temp10’ is selected.

If for any reason a scan to file cannot be sent to the appropriate remote 
destination, the file will be stored in the ‘Unsent’ folder.

Table view

The table view (on the right side of figure 46 on page 90) displays the 
filenames of the files in the opened destination or temporary folder. 

Each file has the following information:
■ Name
■ Size
■ Type
■ Modified
■ Resolution
■ Image size.

If the currently viewed destination is the one you are scanning to, then the 
scanned file will appear at the end of the table. If you currently view another 
destination than the one you are scanning to, the scanned to destination is 
displayed in bold.
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It is possible that there are more files in the table than fit on the screen. The 
most recently scanned files appear at the end of the table. Under these 
circumstances, it is possible that your most recent scanned file is not visible in 
the on-screen table. In this case, you can update the table view.

▼▼▼▼ Update the table view

1 From the ‘View’ menu select ‘Refresh’ or click the ‘Refresh’ button on the 
toolbar (see figure 47). If the opened destination is also the one which is 
currently scanned to, the view is automatically updated.

[47] ‘Refresh’ button on the toolbar
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Actions from the Scan Manager

The Océ 9600 Scan Manager enables you to choose settings regarding 
scan-to-file. You can edit and view the destination properties. You can also 
view the properties of scanned files.

Destinations

A destination is a place to which you scan your file. You can create, delete and 
lock destinations. You can also define automatic file naming to ensure your 
files get the desired names.

A destination can also be a file server or an end user PC. It is better to select 
remote destinations instead of the local ones. The local destinations are 
temporary and cannot contain many of scan files.

▼▼▼▼ Create a destination

1 Select ‘Destinations’ in the tree view.
2 Open the ‘File’ menu and select ‘New’ or click on the ‘New’ button on the 

toolbar (see figure 48).

[48] ‘New’ button on the toolbar
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The following dialog box appears (see figure 49):

[49] ‘Destination properties’ window

3 Enter a logical name for the destination in the ‘Name’ text box.
This logical name also appears on the scanner panel (see figure 41 on page 83).

4 Choose a destination type from the ‘Type’ drop-down list box.
You can choose between File Transfer Protocol (FTP), Server Messages Block 
(SMB) or local storing in the temporary store on the controller.

5 Enter the name of the system you want to scan your files to in the ‘System’ text 
box.

6 Enter a path of the target folder in the ‘Path’ text box. You can also click the 
‘Browse’ button to select the path.
Note: This is only possible if you choose ‘On the controller’ as ‘Type’ (see 
step 4).

7 Enter, if required, a user name for the network destination in the ‘User name’ 
textbox.

8 Enter, if required, the appropriate password for the network destination in the 
‘Password’ textbox.

9 Click Ok to accept the destination properties.

Note: You can create a maximum number of 10 destinations.

A key operator can determine whether a destination can be modified by an 
anonymous user. This done by locking and unlocking a destination.

▼▼▼▼ Lock a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.
3 Check the ‘Locked’ check box.
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4 Click Ok to accept the destination settings.
The destination properties are now locked.
Note: This option is only available if you are logged on as a Key operator (see 
chapter , ‘User modes’ on page 121).

▼▼▼▼ Unlock a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.
3 Uncheck the ‘Locked’ check box.
4 Click Ok to accept the destination settings.

The destination properties are now unlocked.
Note: This option is only available if you are logged on as a Key operator (see 
chapter , ‘User modes’ on page 121).

▼▼▼▼ Delete a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the 

toolbar (see figure 50).

[50] ‘Delete’ button on the toolbar

The selected destination is deleted.
Note: This option is only available if you are logged on as a Key operator or 
as a Repro operator.

Note: You are not able to delete the last destination.

▼▼▼▼ Define file name

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’.

The ‘Destination properties’ screen appears as in figure 49 on page 94.
3 Enter a name in the ‘Base name’ textbox.

Note: The ‘Base name’ may contain ‘###’ for automatic file naming. The 
‘###’ will be replaced by an ascending number. You may place an equal 
amount of dots in the ‘Base name’.

4 Check or uncheck the ‘Add appropriate file extension’ check box to add or 
respectively leave out an appropriate file extension. The file extension can be 
set in the Settings Editor (see ‘File extension TIFF’ on page 155 or ‘File 
extension CALS’ on page 155).

5 Click Ok to accept the settings.
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▼▼▼▼ Set / Change destination properties

1 Select a destination.
2 Open the ‘File’ menu and select ‘Properties’ or click the ‘Properties’ button on 

the toolbar (see figure 51).

[51] ‘Properties’ button on the toolbar

The ‘Destination properties’ screen appears as in figure 49 on page 94.
3 Change the destination properties as described in ‘Create a destination’ on 

page 93.

Scanned files

The right-hand pane of the Océ 9600 Scan Manager contains the scanned files 
and additional information about the files. You can view, print and delete these 
files. You can also view the file properties.

▼▼▼▼ View a scanned file

1 Select a file in the right-hand pane.
2 Open the ‘File’ menu and select ‘View’ or click the ‘View’ button on the 

toolbar (see figure 52).

[52] ‘View’ button on the toolbar

Océ View Station (see ‘Océ View Station’ on page 101) starts up and displays 
the file.
Note: When you scan to file, the Océ View Station controller starts 
automatically, showing the result of the scan.

▼▼▼▼ Print a scanned file

1 Select a file in the right-hand pane.
2 Open the ‘File’ menu and select ‘Print’ or click the ‘Print’ button on the toolbar 

(see figure 53).

[53] ‘Print’ button on the toolbar

The selected file will be printed with the default settings as defined in the 
Settings Editor (see ‘Job-related settings for printing’ on page 158).
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▼▼▼▼ Delete a scanned file

1 Select a file in the right-hand pane.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the 

toolbar (see figure 54).

[54] ‘Delete’ button on the toolbar.

The selected file will be deleted.
Note: This option is only available if you are logged on as a Key operator 
or as a Repro operator.

▼▼▼▼ View properties of a scanned file

1 Select a file in the right-hand pane.
2 Open the ‘File’ menu and select ‘Properties’ or click the ‘Properties’ button on 

the toolbar (see figure 55).

[55] ‘Properties’ button on the toolbar.

The following window appears (see ‘‘Scanfile properties’ window’ on 
page 97):

[56] ‘Scanfile properties’ window

3 Click OK to close the ‘Scanfile properties’ window.
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▼▼▼▼ Automatically view a file after scanning

You can choose to view a file automatically after scanning:
1 Open the ‘System’ menu and select ‘Auto view’.

Whenever you scan to file, Océ View Station will start automatically and show 
the scanned file.

Manage the temporary store

When you regularly scan originals to a file, many files are created in the 
temporary store. You can clean up the temporary store manually or 
automatically.

To manually delete   the files in the temporary store, select the ‘Purge’ 
command from the ‘System’ menu.

To automatically delete   the scanned files from the temporary store, you must 
choose some settings in the Océ 9600 Settings Editor (see chapter 10, ‘Key 
operator settings’ on page 129).
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How to retrieve scanned files?

When you scan to file, your files will be stored in the destination you set. This 
can be on the local controller or on a remote system. You can retrieve your files 
from the local host via File Transfer Protocol (FTP) (see figure 57). Also, if 
during scanning to a remote destination something goes wrong, you can 
retrieve your files from the local host.

[57] How to retrieve scanned files?

Get files via FTP

1 Launch an FTP client.
2 Enter the ‘ftp’ command.

A DOS box now appears with the FTP prompt.
3 Enter the ‘Open’ command followed by either the registered name of the Next 

Generation Controller (NGC) or the IP address (for example: 194.2.66.146) to 
connect to the NGC and press Enter: ‘open 194.2.66.146’.
Note: Instead of performing steps 2 and 3, you could type “ftp host_name” 
in the FTP client.
The connection with the NGC is now established and a window appears asking 
you for a user name.

4 Enter the user name ‘anonymous’, and enter ‘anonymous’as your password 
also. 
A connection is now set up for the ‘anonymous’default user.

Remote client 
Windows 95 / 98

Remote client 
Windows NT 4.0

Local host (Controller)
Windows NT 4.0

Get files via FTP

Get files via FTP
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Note: Because there is no registered user, you can simply press Enter to 
initiate the connection.

5 Set the transmission mode to binary by entering ‘binary’.
6 Go to the ‘tempstore’ directory using the following command: ‘cd tempstore\’.
7 Go to the ‘scan’ directory if you want to retrieve a file from a destination on 

the local host, 
or
go to the ‘unsent’ directory if you want to retrieve a file from ‘unsent’ folder 
on the local host.

8 Get the data file (for example: bugatti.tif) via the ‘get’ command: 
‘get bugatti.tif’.

9 Quit FTP by entering the ‘bye’ command.
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Océ View Station

With Océ View Station you can view your scanned files. This can be done 
automatically (see ‘Automatically view a file after scanning’ on page 98) after 
scanning or via the Scan Manager (see ‘Print a scanned file’ on page 96).

Océ View Station has the following menus (see figure 58):
■ File
■ View
■ Preference
■ Help

[58] Océ View Station
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Menu options

File menu

Command What does it do?
Close Closes the active document
Properties Provides technical information and allows you to change certain 

properties of the document.

View menu

Command What does it do?
Fit Scales the image to fill the window.
1:1 Displays the image at a 1:1 scale factor.
Magnify Zooms into the page.
Reduce Zooms out of the page.
Refresh Redraws all windows displaying the active document.
Invert Reverses the black and white parts of the image.
Mirror Mirrors the image.
Rotate 90 CCW Rotates the image 90 degrees counter-clockwise.
Rotate 90 CW Rotates the image 90 degrees clockwise.
Rotate 180 Rotates the image 180 degrees.
Sample When active, displays only a sample of bi-level raster pixels.
Negate Reverses the raster image pixels on display and changes which 

are dominant for scaling. 
Scale to gray When active, displays the active bi-level raster image as though 

it were a grayscale image. 
Monochrome An image or screen with only background and foreground col-

ors. Same as black-and-white or bi-level.

Preference menu

Command What does it do?
View ribbon View Ribbon displays and removes the ribbon that contains but-

tons. By default, the View Ribbon appears below the menu bar. 
It serves as a fast means of selecting some File, View, and Pref-
erence menu commands.

Status bar Status Bar displays and removes the Status Bar at the bottom of 
the Océ View Station window. The Status Bar displays the 
pointer co-ordinates and a status line.
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Note: You can retrieve help about View Station via Océ Scan Manager.

Function buttons

Below the menus there are function buttons in a ribbon. This ribbon can be 
turned on and off (see ‘View ribbon’ on page 102). 

[59] Function buttons in Océ View Station

Figure 59 displays the buttons:
1 Invert: Reverses the black and white parts of the image.
2 Fit: Scales the image to fill the window.
3 1:1: Displays the image at a 1:1 scale factor.
4 Magnify: Zooms into the page.
5 Reduce: Zooms out of the page.
6 Mirror: Mirrors the image.
7 Rotate 90 CCW: Rotates the image 90 degrees counter-clockwise.
8 Rotate 90 CW: Rotates the image 90 degrees clockwise.
9 Rotate 180: Rotates the image 180 degrees.

10 Measurement, when active, allows you to measure lines and areas on the 
image.

Reference Reference displays or removes a small, usually floating win-
dow. This window displays the entire current page in miniature. 
The crossed box inside the Reference window indicates which 
part of the page is displayed in the document window.
By moving or resizing the crossed box, you change which area 
of the page is displayed.

Detail Displays or removes the Detail window.
Measurement When active, allows you to measure lines and areas on the im-

age.

Help menu

Command What does it do?
About Shows information about Océ View Station.

Preference menu

2 3 4 5 6 8 9 10 11 121 7
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11 Reference. This small floating window displays the entire current page in 
miniature for reference.

12 Displays or removes the Detail window.

View error
When the memory is almost full, sometimes the viewer does not show the 
scanned file. Instead it shows a red border with a red cross (see figure 60).

[60] Error view in Océ View Station
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Chapter 7
System status

This chapter describes how to view the status of the Océ 
9600 system.
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Introduction

The Océ 9600 System Control Panel (SCP) application provides you with 
status information about the system. This includes:
■ Machine status of the Océ 9600 Printer
■ Overview of the loaded media types and sizes
■ Machine status of the Océ 9600 Copier
■ Memory usage.

Structure

The Océ 9600 System Control Panel window is divided into the following parts 
(see figure 61 on page 107):

The standard menu bar  which contains the following menus:
■ File - Login, Logout, Connect to and Exit.
■ Edit

If you select this option, a window is displayed in which you can view your 
default server and the display languages (first and second) for the System 
Control Panel application. The Auto login option allows you to start the 
application automatically in the specified user mode.

■ View
The View menu allows you to switch between the display languages as 
defined in the Edit options window and to enable or disable System Control 
Panel sub windows.

■ System
The System menu allows you to dump your configuration settings, make a 
demo plot, clear the system and shut down the system.

Help options: Contents of System Control Panel, About System Control Panel.

The Printer status window  This window displays the current status of the Océ 
9600 Printer. Any error messages displayed on the printer control panel also 
appear in the printer status window of the System Control Panel.

The Media window  This window provides graphical information about the 
status of the printer rolls and cassette trays (available, empty or disabled) and 
about the available media (size and type).
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The Scanner status window  This window displays the current status of the 
Océ 9600 scanner. Any error messages displayed on the scanner control panel 
will also appear in the scanner status window of the System Control Panel.

The set memory meter  This bar indicates how much set memory is still 
available to you. The information is displayed in the form of a meter which is 
divided into three zones:
■ Green: safe, you have enough space left to print large jobs/many small jobs
■ Orange: pay attention, you might reach the set memory limit soon
■ Red: the set memory is (nearly) full; you should remove files or wait until 

files are printed and automatically removed or flushed from memory.
Note: At the right of the set memory meter a percentage is displayed, 
indicating the amount of set memory currently being used.
The System Control Panel main window is displayed below:

[61] System Control Panel window

Access to
ial
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Page

Interrupt
job
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Printer status window  The printer status window is used to display the printer 
status messages, such as: Power off, Off line, Error, Ready to print, Door open, 
etc.

When operator intervention is required (for instance when an error has 
occurred) a blinking icon will be displayed to visually attract the operator’s 
attention.

Media window  For each media source (roll or cassette tray) the following 
information is displayed:
■ Media feed type roll or cassette tray
■ Media feed number
■ Media size
■ Media type
■ Media sort: special or normal
■ Media orientation (cassette tray type only)
■ Media feed empty
■ Media feed available
■ Media weight

Note: If the Media type is polyester, the thickness is expressed in mil (0.001"), 
otherwise the weight is expressed in g/m2 or in pounds. 

When a roll or tray is disabled, the roll or tray icon is dimmed and the media 
information is replaced by the text “-disabled-” (see ‘Icons’ on page 110).

Note: Special media are excluded from the automatic behavior of the Océ 
9600.

Note: You can hide the media by de-selecting it in the View menu option.

Scanner status window  The scanner status window is used to display the 
scanner status, such as: Power off, Error, Ready to scan, etc.

When operator intervention is required (for instance when an error has 
occurred) a blinking icon is displayed, until the source of the alert has been 
removed.

Note: You can hide the scanner status window by de-selecting it in the View 
menu option.

Set memory status  The System Control Panel will display the percentage of 
memory in use.
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The display will be in the form of a status bar divided into three zones to show 
the current state of the set memory: 
■ Green, normal zone
■ Yellow, warning almost full zone
■ Red, error set memory full zone.

Note: You can hide the memory status window by de-selecting it in the View 
menu option.
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Icons
The Océ 9600 System Control Panel uses a number of icons to display 
information about the media available on the printer. The following icons are 
used:

The material is available and the roll is ready for printing.

The roll is enabled but empty.

The material is available in portrait orientation and the cassette 
tray is ready for printing.

The material is available in landscape orientation and the cassette 
tray is ready for printing.

The cassette tray is empty and material should be loaded in 
portrait orientation.

The cassette tray is empty and material should be loaded in 
landscape orientation.



System status 111

User operations

The Océ 9600 System Control Panel allows you to perform the following 
operations:
■ Making a demo plot
■ Printing your system configuration
■ Changing the display language
■ Clearing the system
■ Shutting down the system
■ Setting up a remote session (only on a remote system)
■ Quitting a remote session (only on a remote system).

▼▼▼▼ Making a demo plot

1 Select the Demo plot option in the System menu.
A demo plot is made on the printer.

▼▼▼▼ Printing your system configuration

1 Select the Print settings option in the System menu.
A list is printed of the current settings on the Océ 9600.

▼▼▼▼ Changing the display language

1 Select the View menu option.
Here you can select one of two available display languages.

▼▼▼▼ Clearing the system

1 Select the ‘Clear system’ option in the System menu to delete all jobs. 
You can use this option in case of a corrupt job which cannot be deleted with 
the help of the Queue Manager. 
Note: This option is only available in repro operator, key operator and 
system administrator mode. In anonymous user mode, it is not possible to 
clear the system.

▼▼▼▼ Shutting down the system

1 Select the Shut down option in the System menu to shut down the system.
This option is only available in repro operator, key operator and system 
administrator mode. 
Note: On a local system, this option is available to any user, including an 
anonymous user.
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▼▼▼▼ Setting up a remote session (only on a remote system)

1 Click on the Connect to option in the File menu.
A dialog box will appear containing all the available 9600 systems.

2 Select one of the available 9600 systems and click on OK.
Note: If the system you want to connect to is not available in the list, you 
can click on the Edit... button. A  dialog box will appear which allows you 
to manually add a 9600 system. For this, you will need a valid IP address.

▼▼▼▼ Quitting a remote session (only on a remote system)

1 Select the Exit option in the File menu when the System Control Panel has 
been installed on a remote client.
The remote SCP session is now terminated.
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Chapter 8
Remote Logic

This chapter describes how to install the remote versions of 
the Queue Manager, System Control Panel and Settings 
Editor on a user PC.
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Introduction

The controller applications of the Océ 9600 (Queue Manager, System Control 
Panel and Settings Editor) are also delivered as remote versions.

This means that users can access one or more Océ 9600 systems from their own 
computer. Anonymous users can view the status of both their jobs (Queue 
Manager) and the entire system (System Control Panel). This way they can, for 
instance, determine which queue is shortest and send their jobs there to avoid 
lengthy delays.

From a management point of view, the availability of remote versions of the 
applications is quite useful as well. They allow key operators and system 
administrators to manage multiple Océ 9600 systems from a  single location. 
They can centrally monitor the system status and identify potential problems 
without having to work at the controller itself.

The remote versions are almost identical to the local applications, which are 
installed on the controller. The only difference is that an anonymous user can 
only use the ‘Abort’ button of the Queue Manager and the ‘Shut down’ option 
on the System Control Panel when he is working locally. The key operator, 
system administrator and repro operator can access these functions remotely, 
from their own PC.
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Installation procedure

Before installing Remote Logic you must take note of the following minimum 
system requirements for the remote system. It has to be a Pentium 233 with 32 
Mb RAM, running Windows 95, 98 or NT (service pack 3) or a HP-UX 10.20. 
Contact your local Océ organization for other compatible systems.

Remote Logic (Queue Manager, System Control Panel and Settings Editor) are 
located on the Océ 9600 User Documentation / Applications CD-ROM 
provided with the system. The installation procedure for Remote Logic is quite 
simple and self-explanatory. When you select the ‘Install remote applications’ 
option on this CD-ROM, a wizard is started which guides you through the 
installation process. Once the installation process is completed, you can start 
working with the applications without having to reboot your system.

Note: Remote Logic works only when TCP/IP is enabled on your system. Refer 
to your system administrator for assistance with the installation procedure for 
TCP/IP.

▼▼▼▼ Install Remote Logic 

1 Insert the Océ 9600 User Documentation / Applications CD-ROM into the 
CD-ROM drive of your PC.

2 Select the ‘Install remote applications’ option. 
The installation wizard is started and you are asked to choose a setup language.

[62] Choosing a setup language
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3 Specify the desired language and click ‘OK’. 
The Setup is now started and a Welcome window is displayed.

[63] ‘Welcome’ window

4 Exit all Windows programs (as recommended) and click the ‘Next’ button to 
continue. The ‘Software License Agreement’ window is displayed

[64] ’Software License Agreement’ window 

5 Click the ‘Yes’ button to accept the specified terms or click the ‘No’ button to 
refuse.
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Note: If you click the ‘No’ button, the ‘Exit Setup’ window is displayed, 
prompting you to click on the ‘Resume’ button to return to the ‘Software 
License Agreement’ window or to click the ‘Exit’ button to terminate the 
installation procedure.
The ‘User Information’ window is now displayed

[65] ’User Information’ window

Enter your name and your company name in the appropriate fields and click 
the ‘Next’ button. The ‘Select components’ window appears.

[66] ’Select components’ window
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6 Accept the proposed destination folder or use the ‘Browse’ button to select a 
folder of your own choice.

7 Select the desired components and click the ‘Next’ button. 
Note: By default, all components are selected.

8 When you click the ‘Next’ button, the ‘Select Program Folder’ window 
appears.

[67] ’Select Program Folder’ window

9 Enter the desired program folder name and click on the ‘Next’ button. 

The programs are now installed. Each application is installed separately and as 
part of a combined version called ‘Applications’.

When the installation is complete, you can start the applications by selecting 
them from the specified folder in the ‘Start’ menu. 

To work with the applications you first have to connect to an available Océ 
9600 machine. How to connect is described in ‘The connection to a controller’ 
on page 78.

Note: If you plan to work with more than one of the available remote 
applications, you are advised to use the ‘Applications’ version, because this 
uses less system resources than the individual applications.
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Chapter 9
The Océ 9600 applications

This chapter describes the general functionality of the Océ 
9600 applications.
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Introduction

The Océ 9600 applications enable you to perform certain tasks such as:
■ View system status (Océ System Control Panel).
■ Manage print jobs (Océ Queue Manager).
■ Change settings (Océ Settings Editor).
■ Manage scanning (Océ Scan Manager).

The Océ 9600 applications have four different user modes. These user modes 
are designed to limit access of specific functions to authorized users only. 
Access one of the four user modes by logging in.

To facilitate working with the Océ 9600 applications, the display languages 
can be configured. Should you find yourself not able to proceed to the next 
step, you can always access the help system to retrieve an answer to you 
questions.

The Océ 9600 applications are available on the local host and as a remote 
version except for Scan Manager which is only available on the local host. 

The Océ 9600 applications operate independently of each other. You have to 
log in and select a language for each application separately.
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User modes

In order to block access from some users, you have to log in to a particular user 
mode. The breakdown of user modes finds its origin in different target groups 
with specific tasks and needs.

There are four different user modes:
■ Anonymous user mode
■ Repro operator mode
■ Key operator mode
■ System administrator mode

The anonymous user mode only offers monitoring capabilities. You are not 
allowed to change anything.

The repro operator, the key operator and the system administrator modes allow 
you to perform a number of particular user actions.

Note: In the Queue Manager and the System Control Panel, the repro operator, 
the key operator and the system administrator have the same user rights. In the 
Settings Editor, however, the user modes offer different rights.

In repro operator mode, the operator is allowed to view settings only in the key 
operator and system administrator modules. 

In key operator mode, the operator is allowed to view and change settings in 
the key operator module. The key operator is also allowed to view system 
administration settings, but is not able to change them.

In system administrator mode, the operator is allowed to view and change 
settings in the system administrator module. The system administrator is also 
allowed to view key operator settings, but is not able to change them. 

When you are not logged in (in anonymous user mode), the right-hand part of 
the window where the settings are displayed, is shaded in.

Note: The status bar at the bottom displays the active user mode.



122 Océ 9600 Copier/Printer User Manual

Log in
The access to the key operator, repro operator and system administrator modes 
is password protected to allow only authorized personnel to use particular 
functions.

You can enter these modes by selecting the ‘Login’ option from the ‘File’ 
menu and by specifying the correct password when prompted for it. 

Note: You will have to perform the Login action in all four Océ 9600 programs 
separately.

Logout

You can leave the key operator, repro operator and system administrator modes 
by selecting the ‘Logout’ option from the ‘File’ menu. When you select 
‘Logout’ you will return to anonymous user mode.

Note: You will have to perform the Logout action in all four Océ 9600 
programs separately.

To change the password

To avoid taking any security risks on the Océ 9600, you may want to change 
your password on a regular basis. You can change the password for each user 
mode (except anonymous user mode, for which no password is required) by 
taking the following steps:

▼▼▼▼ Change the password:

1 Open the ‘File’ menu, select ‘Log in’ and click the ‘Password’ button. 
2 Select the appropriate username in the ‘Username’ drop-down list box.
3 Enter the old password in the ‘Password’ text box.
4 Enter the new password in the ‘New password’ text box.
5 Confirm the new password by entering it in the ‘Confirm new password’ text 

box and click ‘OK’ to set the new password.

Note: You will have to perform the Change password action in all four Océ 
9600 programs separately.
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Automatic login
If you do not want to specify your password every time you log on to the 
system, you can select the automatic login function. This option allows you to 
start the Océ 9600 applications automatically in the specified user mode.

▼▼▼▼ Enable automatic login:

1 Open the ‘Edit’ menu and select ‘Options’.
The Options window appears.

2 Select the ‘Auto login’ check box.
3 Select the required user mode and enter your password for that user mode.
4 Click ‘OK’.

Automatic login is now enabled.
Note: You will have to perform the Enable automatic login action in all four 
Océ 9600 programs separately.
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Ease of use

The Océ 9600 applications are easy to use. You can change the display 
language and there is an extensive help system should you have any questions.

Language

You can choose between two display languages defined for your system by 
selecting one of the two specified languages in the ‘View’ menu. 

Note: The check mark in front of the language indicates that this is the active 
display language.

The languages can be set in the ‘Options’ dialog box. This can only be done 
from the remote applications:

▼▼▼▼ Set the languages

1 Open the ‘Edit’ menu and select ‘Options’.
The Options window appears.

2 Choose the desired first and second language from the two drop-down list 
boxes.

3 Click ‘OK’ to close the Options window.

Note: On a remote client, you must set the languages in all three Océ 9600 
applications separately. On the NGC, the languages of the four applications 
are set at once.

If you want to change the language in the scanner and printing operating panels 
you must do this by using the settings in the Settings Editor (see ‘First 
language’ on page 178 and ‘Second language’ on page 178).

Help

▼▼▼▼ Display help information

1 Open the ‘Help’ menu and select ‘Contents’. 
Now you can retrieve extensive help for all functions of the Océ 9600 
applications.
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Command line parameters
In order to start the remote applications faster, there are 6 command line 
parameters available.

configfile=config_file  Specifies a configuration file you want to use. The 
configuration file can have any name

server=server  Specifies the server (local host) you want to connect to.

language1=lang   Specifies the first language in combination with the 
parameter ‘country1=country’.

country1=country  Specifies the first language in combination with the 
parameter ‘language1=language’.

language2=lang  Specifies the second language in combination with the 
parameter ‘country2=country’.

country2=country  Specifies the second language in combination with the 
parameter ‘language2=language’.

Note: You must always use a matching combination of ‘lang’ and ‘country’ 
(see table 68 on page 126).
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The parameters can be applied to the following applications:
■ QM.exe (Queue Manager)
■ SCP.exe (System Control Panel)
■ SE.exe (Settings Editor)
■ Clients.exe (Queue Manager, System Control Panel and Settings Editor)

Note: These applications are usually located in ‘C:\Program Files\Remote 
Logic\Bin’.

The easiest way to do this is by creating a short-cut for an application and then 
add the command line properties.

Example command line parameter  Below is an example of how to start the 
Océ 9600 applications with the configuration file ‘Myconfig.cfg’, connected to 
the ‘My9600’ server. The first language is set to US English and the second to 
French:
‘C\Program Files\Remote Logic\Bin\Clients.exe -configFile=Myconfig.cft 
server=My9600 language1=en country1=US language2=fr country2=FR’.

Language

Lang Country
Danish da DK
Czech cs CZ
Spanish es ES
Finish fi FI
Hungarian hu HU
Italian it IT
US English en US
UK English en GB
Dutch nl NL
German de DE
French fr FR
Portuguese pt PT
Norwegian no NO
Swedish se SE
Polish pl PL

[68] Matching Language and Country parameters
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Work on a remote system

You can start up the Océ 9600 applications (Settings editor, Queue manager, 
System control panel) except for Scan manager, on a remote client after you 
installed the software (see chapter 8, ‘Remote Logic’ on page 113). In order to 
use the functions, you first have to add an Océ 9600 controller and then connect 
to an available Océ 9600 controller.

▼▼▼▼ Add an Océ 9600 controller 

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear with a drop-down list box containing the already 
added Océ 9600 systems. 

2 Click ‘Edit...’. The ‘Edit systems’ dialog box appears.
3 Enter the IP address of the Océ 9600 system you want to connect to, in the 

‘Systems’ text box.
4 Click ‘Add’. The Océ 9600 is added to the list. You can add more systems.

Note: You can remove an Océ 9600 system. Select one from the list and click 
‘Remove’.

5 Click OK twice to return to the application.

Note: Before you can add an Océ 9600 system, the system has to be installed 
and configured by a system consultant or a technician.

▼▼▼▼ Connect to an Océ 9600 controller 

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear containing a drop-down list box with the available 
Océ 9600 systems. 

2 Select one of the available Océ 9600 systems and click on ‘OK’. When you 
connect to another system, all settings have to be retrieved. This may take some 
time.

Note: You will have to perform the Add and Connect actions in the remotely 
used Océ 9600 programs separately.
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Chapter 10
Key operator settings

This chapter describes how to choose key operator settings 
in the Settings Editor of the Océ 9600.



130 Océ 9600 Copier/Printer User Manual

Introduction

This chapter is intended for key operators only and contains all details 
necessary for printer/copier user activities required to keep the Océ 9600 tuned 
to company requirements.

The key operator is responsible for maintaining correct system default settings. 
These include default settings and groups of default printer settings for 
recurring print and copy jobs.

Also, the key operator can define all timer settings, such as panel time out and 
sleep mode time out.

This chapter will inform you about accessing the Settings Editor and defining 
key operator settings.

Note: Only one key operator or system administrator can be logged on to the 
Settings Editor at the same time.
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Starting up and shutting down the 
controller

Take the following steps to start up the controller:

▼▼▼▼ Start up the Océ 9600 controller

1 Turn on the controller and the screen. 
After the initial controller system test, the Queue Manager, System Control 
Panel, Settings Editor and Scan Manager applications are automatically started 
and the Océ 9600 is ready for operation.
Note: The Queue Manager and the System Control Panel applications are 
visible on the screen; however, the Settings Editor is minimized in order to save 
screen space.

Take the following steps to shut down the controller:

▼▼▼▼ Shut down the Océ 9600 controller

1 Go to the System Control Panel application.
2 Select the ‘Shutdown’ option from the ‘System’ menu.
3 Confirm shutdown by clicking on the ‘Yes’ button in the ‘Shut down’ window.

The system automatically performs the shutdown procedure for the controller. 
Finally, the Windows NT ‘Shutdown Computer’ window appears, which 
informs you that you can turn off your computer. 
Note: You can now restart the controller by pressing the ‘Restart’ button.

4 Turn off your computer and display.

Note: The Océ 9600 has a sleep mode (see page 182). The sleep mode turns off 
most of the power supply after a certain time of inactivity. 
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Settings Editor

The Settings Editor is one of the controller applications for the Océ 9600, 
which allows users and operators to view and, if authorized, to modify system 
settings.

With the Settings Editor, two groups of settings can be configured:
■ Key operator settings (KO settings)

The key operator group allows authorized users to configure default settings 
for copy and print jobs, default off-line fold settings and scan-to-file options. 
Printer, system and scanner defaults can also be set or modified within the 
key operator settings.

■ System Administrator settings (SA settings) 
The system administrator group allows authorized users to configure default 
printer language (PDL) settings and printer pen settings. It also allows the 
system administrator to configure system and connectivity settings.

These groups of settings can be selected from the ‘View’ menu of the Settings 
Editor.

Setting dependencies   The Settings Editor is used to display and edit a 
specified group of settings. Some settings are dependent upon other settings. If 
you want to change settings which have dependencies upon other settings, you 
will be prompted with a message. When a setting is changed, the system 
automatically updates the dependent settings. 
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Also, when you change certain settings, such as measurement unit or paper 
series, all related settings are instantaneously converted to the new setting 
(with a bullet for the settings that are changed).

[69] Settings Editor

General structure

The Settings Editor is structured as follows: 
■ Menu bar
■ Row of buttons
■ Settings area
■ General control buttons
■ Status bar
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Menu bar
The menu bar of the Settings Editor contains the following menus:   

File   If you select the ‘File’ menu, you can log in as a particular type of user, 
log out of the previously selected user mode, open an existing setting file, save 
the current settings to a file, connect to a different controller (only for remote 
users) or exit the Settings Editor.

Edit  If you select ‘Options’ from the ‘Edit’ menu, a window is displayed in 
which you can view your default system and the display languages (first and 
second) for the Settings Editor application. The ‘Auto login’ option allows you 
to start the Settings Editor application automatically in the specified user 
mode.

View  The ‘View’ menu allows you to switch between the display languages as 
defined in the Edit options window and between KO settings and SA settings.  

Help  The ‘Help’ menu contains the following options:  ‘Contents of Settings 
Editor’ and ‘About Settings Editor’.

[70] Menu bar

Row of buttons

There are four different buttons available at the top of the Settings Editor. 
These are ‘Jobs’, ‘Printer’, ‘System’ and ‘Scanner’. Each button provides 
access to a specific group of settings. By clicking on each of these buttons, you 
can get access to the settings related to the selected group.

A shadow highlight is used to indicate which button is activated.

[71] Row of buttons

Settings area

The settings area consists of two parts: a setting tree and an update area.
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Tree structure   Most settings are displayed using a tree structure. By clicking 
on the settings, folders can be opened to show all the entries or closed to hide 
all the entries below these folders.

The settings for system components that are not available are not displayed. 
Therefore, if you do not have a folder, no folder settings are available. This 
means that different configurations result in different tree structures.

Note: When a tree item has been changed, this item will be marked with a 
bullet.

Update area  The user can move through the tree and select a setting. If he 
selects a setting for which he is authorized, he can edit the setting in the update 
area.

If the user is not authorized for a particular setting, the update area is grayed 
and no changes can be made.

Note that a few settings, such as basic card and pen settings, are not edited from 
the tree structure, but are accessed directly from the settings area.

The update area contains some additional information about the selected 
setting. This includes a brief definition of the setting, as well as the minimum, 
maximum and default values (if appropriate).  

[72] Settings area

General control buttons

The Settings Editor contains two general control buttons: ‘Apply’ and ‘Undo’.
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Apply  When you click on the ‘Apply’ button, the changes you have made 
become effective. Initially, this button is disabled. It is enabled after the first 
setting is changed and disabled again after the apply action is performed or 
after an undo action. 

Undo   This button restores the settings to the state it was in the last time the 
settings were applied (and not back to the factory default). The ‘Undo’ button 
is disabled at first. This button is enabled the moment the first setting is 
changed. It is disabled after an Apply action is performed or after an undo 
action. 

[73] Control buttons

Status bar

The Settings Editor has a status bar displaying the following information (left 
to right):

■ System status (icon for connected or disconnected)
The following icons are used:  

The Settings Editor is connected to a system.  

The Settings Editor is disconnected from a system.

■ System name (‘localhost’ if you are working at the controller)
■ User mode (Repro operator, Key operator, System administrator or 

anonymous)
■ View mode (KO settings or SA settings).
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How to access the Settings Editor
In order to perform special key operator functions, you must log on to the 
Settings Editor as a key operator.

Because these functions are restricted to a dedicated key operator, a password 
is required to access them. The service engineer will provide this password to 
you upon installation.

Note: Only one key operator or system administrator at a time is authorized to 
make modifications. However, multiple users may view the settings. When a 
second user tries to log in as Key Operator or as System Administrator, an 
error message is displayed.

How to perform actions from the Settings Editor

You can perform a number of activities from the Settings editor. These 
activities include:

■ Save settings to file
■ Load settings from a file
■ Specify the custom card.

Save and load settings  All key operator and system administrator settings can 
be saved in a file or loaded from a file. This way, you can have different settings 
for different customers, departments or other situations.

Note: These settings can only be saved in Key operator or System 
administrator mode. 

▼▼▼▼ Save settings to file

1 Open the ‘File’ menu and select ‘Save as’.
You now have two possibilities:
■ If the client is a local client, a dialog is displayed and the user can supply a 

file name. The file is saved in a predefined directory on the system. 
■ If the client is a remote client, a dialog box is displayed and the user can 

supply a directory and a file name.
Note: All settings in the current view mode are saved; not only the ones that 
are currently visible.  

A few special files are available here:
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■ Default.kos/Default.sas 
These files contain the factory default settings for the key operator and 
system administrator, respectively, and cannot be changed.

■ Backup.kos/Backup.sas 
These files contain a previous version of the settings for the key operator and 
system administrator, respectively (before the last application of settings).

■ Current.kos/Current.sas 
These files contain the version of the settings for the key operator and system 
administrator after the last application of settings.

When an new settings are applied, the contents of the current settings are 
copied to the backup file. There are two versions of this file, one for KO 
settings and one for SA settings. These files are always stored on the system.

▼▼▼▼ Load a settings file

1 Open the ‘File’ menu and select ‘Open’.
A dialog box is displayed from where you can choose the correct file.

2 Click on the ‘Apply’ button. 
The loaded settings are transferred to the system.
Note: This is only possible if the user is logged in as a key operator or system 
administrator.

▼▼▼▼ Specify the custom card 

The custom card on the scanner panel contains high priority settings. Because 
there is only room for five default settings on the basic card and there are more 
functions that might qualify, the custom card is programmable. 

This option allows you to add or delete current settings on the custom card. In 
the left window, all available setting groups are displayed. In the right window, 
all the current settings are displayed. You can use the two arrow buttons 
between the two windows to add settings to or remove settings from the custom 
card.

1 Click on the ‘Scanner’ button. 
2 Select the ‘Custom card’ tab. 
3 Press the upper arrow button to add settings to the custom card. The maximum 

number of settings that can be added to the custom card is five.
4 To change the order of the settings on the card, click on one of the buttons on 

the right of the ‘Custom card’ window.
5 Click on the ‘Apply’ button to save any changes you have made.
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Key operator settings

In order to perform special key operator functions, you must log on to the 
Settings Editor as a key operator.

Because these functions are restricted to a dedicated key operator, a password 
is required to access them. The service engineer will provide this password to 
you upon installation.

Note: When you are finished, make certain you log out of the Key operator 
mode of the Settings Editor to prevent unauthorized use of the Océ 9600.

▼▼▼▼ Make key operator settings in the Settings Editor

1 Maximize the Settings Editor on the screen.
2 Log in as key operator.
3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings, such as the defaults for the Custom card, are made 
directly from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting

7 Log out of the Key operator mode when you have finished updating the 
settings.
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Job-related settings for copying

The ‘Copy & File’ tab of the job-related settings contains a folder with default 
settings, which can be overruled by settings that are sent along with the copy 
job (via a job ticket or from the scanner panel), plus a folder with settings for 
horizontal and vertical zoom calibration.

The ‘Defaults’ folder contains the following (groups of) options:
■ Output mode (single option)
■ Checkplot (single option)
■ Number of prints/sets (single option)
■ Zoom method (single option)
■ Custom zoom (single option)
■ Mirror (single option)
■ Original (group)
■ Copy (group)
■ File (group)

[74] ’Defaults’ Folder for ‘Copy & File’
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Job-related settings for copying (single)

Output mode

Description The option ‘Output mode’ allows you to define the destina-
tion of the output: Copy: the output will be printed on paper. 
File; the output is saved as a print file and can be printed on 
paper at a later time.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Output mode - <value> - Ap-
ply

Checkplot

Description Use ‘Checkplot’, to define that a paper copy will be made of 
each scanned original.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Checkplot - <value> - Apply

Number of prints/sets

Description Use ‘Number of prints/sets’, to define the default number of 
copies for each job in the printer memory.
The default value is 1. The maximum number of copies is 
999.

Min/max values 1 - 999

Menu path Jobs - Copy & File - Defaults - Number of prints/sets - <val-
ue> - Apply

Zoom method

Description The Océ 9600 has a custom, automatic and 1-to-1 scaling 
option.
‘Custom’ allows you to define the zoom ratio.
If you select ‘Automatic’, a zoom ratio will be calculated, 
based on the original size and the copy media size.
1-to-1 means there is no zoom ratio.

Menu path Jobs - Copy & File - Defaults - Zoom method - <value> - Ap-
ply
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Custom zoom

Description The custom zoom value defines the zoom ratio when you se-
lect ‘Custom’ for Zoom method

Menu path Jobs - Copy & File - Defaults - Custom zoom - <value> - Ap-
ply

Custom zoom

Description The custom zoom value defines the zoom ratio when you se-
lect ‘Custom’ for Zoom method

Menu path Jobs - Copy & File - Defaults - Custom zoom - <value> - Ap-
ply

Mirror

Description You can use the ‘Mirror’ option to print a horizontally mir-
rored image of an original. 
Mirroring is performed in the vertical axis.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Mirror - <value> - Apply
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Original (group)
The Original group contains the following options (see figure 75 on page 143):
■ Input mode
■ Legend location
■ Remove leading strip
■ Remove trailing strip
■ Scan width method
■ Custom scan width
■ Scan length method
■ Custom scan length
■ Original type
■ Background compensation
■ Exposure

[75] ’Original’ Folder for Copy & File
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Input mode

Description The ‘Input mode’ allows you to define the type of input:
Single sheet: No sorting will be used. Each page is put in a 
separate job.
Multiple sheets: Sort by page job where, until the set is 
closed, all originals will belong to the same job (e.g. 11111 
- 22222 - 33333).
Set: Sort by set job (e.g. 123 - 123 - 123 - 123 - 123)

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Feeding -Input 
mode - <value> - Apply

Legend location

Description You can use the ‘Legend location’ option to determine if us-
ers will feed in the original with the legend on the leading 
edge or on the trailing edge.
This information is used to fold the copy in such a way that 
the legend is always on top of the folded package.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Feeding - Legend 
location - <value> - Apply

Remove leading strip

Description Use the ‘remove leading or trailing strip’ settings to set the 
removal of a blank strip at the top or bottom of the image as 
default. The print length will decrease accordingly.
‘Remove leading strip’ will remove a blank strip at the top of 
the image.
‘Remove trailing strip’ will remove a blank strip at the bot-
tom of the image.
You can remove up to 400 mm or 16 inches in increments of 
1 mm.
By default, no leading or trailing strip is defined.
Remove leading or trailing strips will always work, unless 
you try to remove the entire plot.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Sheet - Remove 
leading / trailing strip - <value> - Apply
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Scan width method

Description The ‘Scan width method’ option allows you to select the 
width that will be scanned:
Standard:  The width scanned is according to the automati-
cally sensed original width.
Non-standard: The scan width is extended to the first 
non-activated original width sensor, or to the maximum orig-
inal size.
Custom: Custom selected width. Useful if the original is a 
non-standard format. This setting will overrule the automati-
cally detected original size.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Sheet - Scan width 
method - <value> - Apply

Custom scan width

Description The ‘Custom scan width’ option allows you to select the 
width that will be scanned:
Useful if the original has an arbitrary width. This setting will 
overrule the automatically detected original format.
The setting is used in combination with the ‘Scan width 
method’.

Min/max values 1 – 36 inches

Menu path Jobs - Copy & File - Defaults - Original - Sheet - Custom 
scan width - <value> - Apply

Scan length method

Description Use ‘Scan length method’, to select the length that will be 
scanned.
Standard: The scan length is determined by the automati-
cally sensed original length.
Non-standard: The scan length extends to the first original 
length sensor that is not activated or to the maximum original 
size.
Custom-selected length: Useful if the original is of a 
non-standard format. This setting will overrule the automat-
ically detected original size.
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Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Sheet - Scan length 
method - <value> - Apply
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Custom scan length

Description The ‘Custom scan length’ option allows you to select the 
length that will be scanned.
This is useful if the original has an arbitrary length. This set-
ting will overrule the automatically detected original format.
The setting is used in combination with ‘Scan length meth-
od’.

Min/max values 40 –590.55 inches

Menu path Jobs - Copy & File - Defaults - Original - Sheet - Custom 
scan length - <value> - Apply

Original type

Description Select the type of original that you want to scan from the fol-
lowing range:
- Lines / text
- Grays & lines
- Dark original
- Blueprint
- Printed matter
- Photo

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Image - Original 
type - <value> - Apply

Background compensation

Description Use this function to automatically compensate the original 
background.
The compensation depends on the original type. For ‘photo’ 
or ‘Grays & lines’ originals, the background compensation 
will be fixed. For other original types, the compensation will 
be adaptive.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Image - Back-
ground compensation - <value> - Apply
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Exposure

Description The exposure can be set for every original.
A negative value indicates a lower brightness, resulting in a 
darker scan; a positive value indicates a higher brightness, 
thus resulting in a lighter scan.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Original - Image - Exposure 
- <value> - Apply
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Copy (group)
The Copy group contains the following options (see figure 76 on page 149):
■ Align
■ Horizontal shift
■ Vertical shift
■ Automatic media
■ Default paper source
■ Default paper source number
■ Manual feed
■ Cut length method
■ Custom cut length
■ Add leading strip
■ Add trailing strip

[76] ’Copy’ Folder for Copy & File
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Align

Description The align function enables you to automatically align the im-
age to one corner, to one side, or to the center of the page. 
The default is ‘Upper left’.  The following buttons are avail-
able:
Left up
Up
Right up
Left
Center
Right
Left down
Down 
Right down.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Copy - Layout - Align - <val-
ue> - Apply

Horizontal shift

Description The print margin may be too small to accommodate, for in-
stance, filing strips without loss of information. To avoid 
this, shift the image in a horizontal and/or vertical direction. 
Image shift can be used in combination with the align func-
tion.

Min/max values -35 – 35 inches

Menu path Jobs - Copy & File - Defaults - Copy - Layout - Horizontal 
shift - <value> - Apply

Vertical shift

Description The print margin may be too small to accommodate, for in-
stance, filing strips without loss of information. To avoid 
this, shift the image in horizontal and/or vertical direction. 
Image shift can be used in combination with the align func-
tion.

Min/max values -48 - 48 inches

Menu path Jobs - Copy & File - Defaults - Copy - Layout - Vertical shift 
- <value> - Apply
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Automatic media

Description The ‘Auto format’ option allows you to specify that the se-
lected media size should be based on the size of your origi-
nal.

Note:
Only sizes present in the specified paper series will be con-
sidered for use with the auto format function, unless nothing 
appropriate can be selected. In the latter case, the best fitting 
format in the specified paper series will be proposed.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Copy - Sheet - Automatic me-
dia- <value> - Apply

Default paper source

Description Use ‘Default paper source’, to define the default paper 
source. The default is Roll 1. Whether a roll or a cassette tray 
is selected as default media source, is determined by the 
specified feed preference. The default selected paper source 
can be:
Roll
Cassette tray
Manual feed
Auto.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Copy - Sheet - Default paper 
source - <value> - Apply

Default paper source number

Description Use ‘Default paper source number’, to define the default pa-
per source.

Min/max values 1 - 2

Menu path Jobs - Copy & File - Defaults - Copy - Sheet - Default paper 
source number - <value> - Apply
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Manual feed

Description Use ‘Manual feed’, to allow manual feed only upon request 
by the printer. Only portrait orientation is allowed.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Copy - Sheet - Manual feed 
- <value> - Apply

Cut length method

Description The Océ 9600 determines the length and width of each digi-
tal image. Use ‘Print cut method’, to select one of the follow-
ing default cut methods:
Standard: The print length corresponds to a standard format, 
depending on the media width.
Synchro:  The print length is related to the length of the im-
age. This is the default value. The minimum print length is 
279 mm or 11 inches.
Custom:  The print length is defined by the user. The mini-
mum length is 279 mm or 11 inches. The default value is 
specified with the Cut length option.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - Copy - Sheet - Cut length 
method - <value> - Apply

Custom cut length

Description You can define a specific cut length.
The specified cut length is used when the Custom cut meth-
od is selected. If custom cut is enabled, the copy media 
length will only depend on this setting, any other influence 
is excluded.

Min/max values 11 – 590.55 inches

Menu path Jobs - Copy & File - Defaults - Copy - Sheet - Custom cut 
length - <value> - Apply
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Add leading / trailing strip

Description Use the add leading / trailing strip settings to add, by default, 
a blank strip at the top or bottom of the image. The print 
length will increase accordingly.
‘Add leading strip’ will add a blank strip at the top of the im-
age.
‘Add trailing strip’ will add a blank strip at the bottom of the 
image.
By default, no leading or trailing strip is defined.
Note:  Adding a trailing strip will only work if the cut meth-
od is set to synchro cut.

Min/max values 0 - 16 inches

Menu path Jobs - Copy & File - Defaults - Copy - Sheet - Strips - Add 
leading / trailing strip - <value> - Apply
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File (group)
The File group contains the following options (see figure 77 on page 154):
■ File format
■ File extension TIFF
■ File extension CALS
■ TIFF compression
■ TIFF organization
■ File resolution
■ Optimization

[77] ’File’ Folder for ‘Copy & File’
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File format

Description To define the internal organization of the scanned files. 
Choose between TIFF and CALS.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - File - Destination - File for-
mat - <value> - Apply

File extension TIFF

Description You can enter an extension of your own choice for TIFF 
files.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - File - Destination - File ex-
tension TIFF - <value> - Apply

File extension CALS

Description You can enter an extension of your own choice for CALS 
files.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - File - Destination - File ex-
tension CALS - <value> - Apply

TIFF compression

Description Before scanning, you can set the compression method for 
TIFF files. Choose between Group 4, Group 3, or None.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - File - Destination - TIFF 
compression - <value> - Apply

TIFF organization

Description Before scanning, you can set the compression method for 
TIFF files. Choose between RAW, stripped or tiled.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - File - Destination - TIFF or-
ganization - <value> - Apply
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File resolution

Description The Océ 9600 scan-to-file option allows you to scan at the 
following three resolutions:
200 dots per inch (dpi)
300 dpi
400 dpi
The higher the resolution, the better the image quality. High-
er resolution also leads to bigger file size.

Min/max values 200 - 400 dpi

Menu path Jobs - Copy & File - Defaults - File - Image - File resolution 
- <value> - Apply

Optimization

Description There are two ways to optimize a scan-to-file.
Scan quality: optimizes for the best image quality resulting 
in a better image quality. The scan resembles the original as 
much as possible.
File size: optimizes for better compression. Generally result-
ing in a smaller file size.

Min/max values N/A

Menu path Jobs - Copy & File - Defaults - File - Image - File optimiza-
tion - <value> - Apply
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Zoom calibration
■ On the Océ 9600 there are two options available for zoom calibration: 

‘Horizontal zoom calibration’ and ‘Vertical zoom calibration’ (see 
figure 78).

[78] ’Zoom calibration’ Folder for ‘Copy & File’

Horizontal / vertical zoom calibration

Description In order to optimize the 1 to 1 copy and print quality, the key 
operator can adjust the zoom calibration factor to an accura-
cy of 0.1%.

The zoom factor can be adjusted by means of two correction 
factors, one for the vertical zoom direction and the second for 
the horizontal zoom direction.

Min/max values 97 - 103%

Menu path Jobs - Copy & File - Zoom calibration - Horizontal / Vertical 
zoom calibration - <value> - Apply



158 Océ 9600 Copier/Printer User Manual

Job-related settings for printing 

The ‘Print’ tab of the job-related settings contains a folder with default 
settings, which can be overruled by settings that are sent along with the print 
job, plus a setting for printing error pages (see figure 79).

The ‘Print’ tab contains 4 single options and 4 groups of options:
■ Print error page (single option)
■ Number of prints/sets (single option)
■ Collate (single option)
■ Default print mode (single option)
■ Finishing (group)
■ Sheet (group)
■ Image (group)
■ Layout (group)

[79] Tab for ‘Print’ with single options and grouped options
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Print error page (single option)

Description Use this setting to have error pages printed in case a printing 
error occurs.
Error pages are printed in the following environments: PDL, 
RCF ticket or OJT ticket.

Min/max values N/A

Menu path Jobs - Print - Print error pages - <value> - Apply

Number of prints/sets (single option)

Description The ‘Number of prints/sets’ option allows you to define the 
default number of prints for each job in the printer memory. 

Min/max values 1 - 999

Menu path Jobs - Print - Defaults - Number of prints/sets - <value> - Ap-
ply

Collate (single option)

Description Specifies whether or not a number of originals should be pro-
cessed together as a set. If set processing is off, sorting is al-
ways done by page and every original will be presented as a 
job. If set processing is on, sorting is done by page and all 
originals will belong to the same job until the set is closed, or 
sorting is done by set.

Min/max values N/A

Menu path Jobs - Print - Defaults - Collate - <value> - Apply

Default print mode (single option)

Description With the print mode the printer Image Logic can be set in a 
mode that matches the contents of the image. Setting the de-
fault print mode according to the main stream contents of the 
print jobs will improve the quality of printed images. The de-
fault print mode setting is used when the Image Logic is not 
able to automatically detect the appropriate print mode.

Select ‘Poster’ for images with dominating of gray areas.
Select ‘Lines/Text’ for scanned images.
Select ‘Standard’ otherwise.
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Sheet (group)

The Sheet group contains the following options (see figure 80):
■ Auto format
■ Fit method
■ Feed preference
■ Default paper source
■ Default paper source number
■ Print cut method
■ Custom print length
■ Add leading strip
■ Remove leading strip
■ Remove trailing strip
■ Add trailing strip
■ Default roll format

[80] ‘Sheet‘ folder for ‘Print’

Min/max values N/A

Menu path Jobs - Print - Defaults - Default print mode - <value> - Apply
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Auto format

Description The ‘Auto format’ option allows you to specify that the se-
lected media size should be based on the size of your origi-
nal.
Note:
Only sizes present in the specified paper series will be con-
sidered for use with the auto format function, unless nothing 
appropriate can be selected. In the latter case, the best fitting 
format in the specified paper series will be proposed.

Min/max values N/A

Menu path Jobs - Print - Defaults - Sheet - Auto format - <value> - Ap-
ply

Fit method

Description The ‘Fit method’ option allows you to define on which media 
size an original will be printed if the specified media size is 
not available.
The following buttons are available:
- Exact fit: The original will only be printed if the specified 
media size is available.
- Next smaller: If the specified media size is not available, 
the original will be printed on the next smaller size.
- Exact fit: The 9600 will choose the best possible fit meth-
od.

Min/max values N/A

Menu path Jobs - Print - Defaults - Sheet - Fit method - <value> - Apply

Feed preference

Description The ‘Feed preference’ option allows you to define which me-
dia type is to take preference when the Automatic media se-
lection option is active: 
- Sheet then roll
- Roll then sheet

Min/max values N/A

Menu path Jobs - Print - Defaults - Sheet - Feed preference - <value> - 
Apply
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Default paper source

Description The ‘Default paper source’ option allows you to define the 
default paper source. Whether a roll or a cassette tray is se-
lected as default media source, is determined by the specified 
feed preference.
Available default paper sources: 
- Roll
- Cassette tray
- Manual feed
- Auto

Min/max values N/A

Menu path Jobs - Print - Defaults - Sheet - Default paper source - <val-
ue> - Apply

Default paper source number

Description Use ‘Default paper source number’, to define the default pa-
per source.

Min/max values 1 - 2

Menu path Jobs - Print - Defaults - Sheet - Default paper source number 
- <value> - Apply

Print cut method

Description The Océ 9600 determines the length and width of each digi-
tal image. The ‘Print cut method’ option allows you to select 
one of the following default cut methods:
Standard: The print length corresponds to a standard for-
mat, depending on the media width.
Synchro: The print length is related to the length of the im-
age. This is the factory default value. The minimum print 
length is 279 mm.
Custom: The print length is defined by the user. The mini-
mum length is 279 mm. The default value is specified with 
the ‘Cut length’ option.

Min/max values N/A

Menu path Jobs - Print - Defaults - Sheet - Print cut method - <value> - 
Apply
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Custom print length

Description The ‘Default paper source number’ option allows you to de-
termine the value on the Océ 9600 you can define a specific 
cut length.

The specified cut length is used when the ‘Custom’ cut meth-
od is selected. If custom cut is enabled, the copy media 
length will only depend on this setting, thus any other influ-
ence is excluded.
The minimum cut length is 279 mm.

Min/max values 11 – 590.55 in 

Menu path Jobs - Print - Defaults - Sheet - Custom print length - <val-
ue> - Apply

Default roll format

Description Use ‘Default roll format’, to define the default media size for 
your print jobs.
The default is A0.
The following sizes are available:
A0 to A4 (DIN range)
36 inch (E+)
ISO B1
ISO B2
Note: ‘Default roll format’ works only, when ‘Auto format’ 
Off is selected in the Media section.

Min/max values 11 – 590.55 in 

Menu path Jobs - Print - Defaults - Sheet - Default roll format - <value> 
- Apply

Default material

Description Default material to use for incoming print jobs.

Min/max values N/A

Menu path Jobs - Print - Defaults - Sheet - Default paper material - <val-
ue> - Apply
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Add leading / trailing strip

Description Use the add leading or trailing strip settings to add a blank 
strip at the top or bottom of the image and make this the de-
fault setting. The print length will increase accordingly.
‘Add leading strip’ will add a blank strip at the top of the im-
age.
‘Add trailing strip’ will remove a blank strip at the bottom of 
the image.
You can remove up to 400 mm or 16 inches in increments of 
1 mm.
Note: Add leading or trailing strips will always work, unless 
you try to remove the entire plot.

Min/max values 0 - 16 inches

Menu path Jobs - Print - Defaults - Sheet - Strip - Add leading / trailing 
strip - <value> - Apply

Remove leading / trailing strip

Description Use the ‘remove leading or trailing strip’ settings to set the 
removal of a blank strip at the top or bottom of the image as 
default. The print length will decrease accordingly.
‘Remove leading strip’ will remove a blank strip at the top of 
the image.
‘Remove trailing strip’ will remove a blank strip at the bot-
tom of the image.
You can remove up to 400 mm or 16 inches in increments of 
1 mm.
Note:  Remove leading or trailing strips will always work, 
unless you try to remove the entire plot.

Min/max values 0 - 16 inches

Menu path Jobs - Print - Defaults - Sheet - Strip - Add leading / trailing 
strip - <value> - Apply
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Finishing (group)
The finishing group contains the following options (see figure 81):
■ Folding
■ Drawing method
■ Image orientation
■ Folding length
■ Folding width
■ Binding strip

[81] Printer-related finishing options 
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Folding

Description To determine if the job will be folded by default.

Min/max values N/A

Menu path Jobs - Print - Defaults - Finishing - Folding - <value> - Apply

Drawing method

Description To define the standard folding method.

Min/max values N/A

Menu path Jobs - Print - Defaults - Finishing - Drawing - <value> - Ap-
ply

Image orientation

Description To specify the image orientation for folding. Choose be-
tween Portrait, Landscape or Auto detect.

Min/max values N/A

Menu path Jobs - Print - Defaults - Finishing - Image orientation - <val-
ue> - Apply

Folding length

Description Determines the folding length

Min/max values 276 - 310

Menu path Jobs - Print - Defaults - Finishing - Folding length - <value> 
- Apply

Folding width

Description Determines the folding width

Min/max values 7 -  9 inches

Menu path Jobs - Print - Defaults - Finishing - Folding width - <value> 
- Apply

Binding strips

Description Determines the width of the binding strip
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Min/max values .5 – 1 inch

Menu path Jobs - Print - Defaults - Finishing - Binding strips - <value> 
- Apply
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Image (group)
The Sheet group contains the following options (see figure 82):
■ Zoom method
■ Custom zoom
■ Mirror
■ Invert
■ Rotate value
■ Legend correction

[82] ‘Image’ folder for ‘Print’
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Zoom method

Description If you select the ‘Auto zoom’ option, a zoom ratio will auto-
matically be calculated, based on the original size and the re-
ceiving copy media size. 

Min/max values N/A

Menu path Jobs - Print - Defaults - Image - Zoom method - <value> - 
Apply

Custom zoom

Description Specifies the zoom value when zoom method is set to cus-
tom.

Min/max values 25 - 400 %

Menu path Jobs - Print - Defaults - Image - Custom zoom - <value> - 
Apply

Mirror

Description You can use the ‘Mirror’ option to print a horizontally mir-
rored image of an original. 
Mirroring is performed in the vertical axis.

Min/max values N/A

Menu path Jobs - Print - Defaults - Image - Mirror - <value> - Apply

Invert

Description Use ‘Invert’, to print digital originals in reverse image.
This means that black text on a white background will be 
printed as white text on a black background.

Min/max values N/A

Menu path Jobs - Print - Defaults - Image - Invert - <value> - Apply
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Rotate

Description The ‘Rotate value’ option allows you to set the default rota-
tion applied to the print.
The following values are available:
0 - 90 - 180 - 270 degrees
Auto rotate
Note:  Use ‘Auto rotate’, to make the Océ 9600 choose a ro-
tation automatically. When this setting is activated, the image 
will rotate to the best fitting media format.
The following values are available:
Auto rotate productive if possible: the orientation is changed 
to landscape to allow for faster printing (paper movement 
through the machine will be reduced.
Auto rotate folding if possible: the orientation is changed to 
portrait to facilitate folding.
Auto rotate portrait:  The orientation is changed to portrait.
Auto rotate landscape:  The orientation is changed to land-
scape.
Note:
Rotation is possible for both vector and raster files (1-bit).

Min/max values N/A

Menu path Jobs - Print - Defaults - Image - Rotate - Rotate value - <val-
ue> - Apply
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Legend correction

Description The ‘Rotate value’ option allows you to set the default rota-
tion applied to the print.
The following values are available:
0 - 90 - 180 - 270 degrees
Auto rotate
Note:  Use ‘Auto rotate’, to make the Océ 9600 choose a ro-
tation automatically. When this setting is activated, the image 
will rotate to the best fitting media format.
The following values are available:
Auto rotate productive if possible: the orientation is changed 
to landscape to allow for faster printing (paper movement 
through the machine will be reduced.
Auto rotate folding if possible: the orientation is changed to 
portrait to facilitate folding.
Auto rotate portrait:  The orientation is changed to portrait.
Auto rotate landscape:  The orientation is changed to land-
scape.
Note:
Rotation is possible for both vector and raster files (1-bit).

Min/max values N/A

Menu path Jobs - Print - Defaults - Image - Rotate - Legend correction - 
<value> - Apply
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Layout (group)
The Layout group contains the following options (see figure 83):
■ Auto shift
■ Horizontal shift
■ Vertical shift

[83] ‘Layout’ folder for ‘Print’
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Auto shift

Description The Auto shift function enables you to automatically align 
the image to one corner, to one side, or to the center of the 
page. The following buttons are available:
- Left up 
- Up 
- Right up 
- Left 
- Center 
- Right 
- Left down 
- Down 
- Right down

Min/max values N/A

Menu path Jobs - Print - Defaults - Layout - Auto shift - <value> - Apply

Horizontal / Vertical shift

Description The print margin may be too small to accommodate, for in-
stance, filing strips without loss of information. To avoid this, 
shift the image in horizontal and/or vertical direction. Image 
shift can be used in combination with the align function.

Min/max values N/A

Menu path Jobs - Print - Defaults - Layout - Horizontal / Vertical shift - 
<value> - Apply
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Printer-related settings

There are two printer-related settings for a key operator (see figure 84):
■ Automatic roll switch
■ Block number with correct light intensity

[84] Printer related settings

Automatic roll switch

Description When you enable ‘Automatic roll switch’, the Océ 9600 
switches to another roll or cassette tray (depending on the 
specified feed preference) with the same material type and 
size, as soon as a roll or cassette tray is empty.
If ‘Set next larger fit’ is active, a larger size of material will 
be used for printing. Only when all corresponding rolls or 
cassette trays are empty, will you have to refill media.
Note:    
The Océ 9600 will not switch to a roll or cassette tray which 
is specially configured.

Min/max values N/A

Menu path Printer - Automatic roll switch - <value> - Apply
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Block number with correct light intensity

Description As the printer drum gets older, the print quality might slightly 
deteriorate (printouts get lighter).

To avoid this and to guarantee the best possible print quality, 
you may use the ‘Block number with correct light intensity’ 
option to adjust the light intensity of the print head.

Min/max values 1 - 20

Menu path Printer - Adjust - Block number with correct light intensity - 
<value> - Apply
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System related settings

There are two single system-related settings and five groups of settings for a 
key operator (see figure 85):
■ Scan-to-file password (single)
■ Telephone number (single)
■ Localization (group)
■ Job priorities (group)
■ Media (group)
■ Timers (group)
■ Disk cleanup (group)

[85] System-related settings for a key operator
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Single options
 

Localization (group)

Under localization, you can change the display languages and the 
measurement unit (see figure 86).

[86] Localization settings for key operators

Scan-to-file password (single)

Description Scan-to-file is an optional module.
To activate this option, a password is required. Call your lo-
cal dealer for this password.
After you have entered the password, you can use 
Scan-to-file.

Min/max values N/A

Menu path System - Scan-to-file - <value> - Apply

Telephone number

Description Use ‘Telephone number’, to display a telephone number, 
when a permanent error occurs.
This can be the number of the key operator but also that of 
the local service organization.

Min/max values N/A

Menu path System - Telephone number - <value> - Apply
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First language

Description Use the ‘First language’ option, to specify the first (default) 
language to be used at the operating panels (printer and scan-
ner) on your Océ 9600, for providing information to the us-
ers. All settings (also on the system) will be presented in the 
specified language.

Min/max values N/A

Menu path System - Localization - Display languages - First language - 
<value> - Apply

Second language

Description Use the ‘Second language’ option to specify the second (al-
ternative) language to be used at the operating panels (printer 
and scanner) of your Océ 9600, for providing information to 
the users. Users can choose between the first and second lan-
guages by changing the language at the printer operating 
panel. For this option, the same languages are available as for 
the first language.

Min/max values N/A

Menu path System - Localization - Display languages - Second lan-
guage - <value> - Apply

Unit of measurement

Description Use the ‘Measurement unit’ option, to specify the preferred 
unit of measurement for your Océ 9600: metric or inches.
The selected unit of measurement will be used throughout 
the system.
Note: After the unit of measurement has been changed, all 
the settings will be recalculated.

Min/max values N/A

Menu path System - Localization – Unit of measurement - <value> - 
Apply
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Job priorities (group)
In this group there is one setting: Copy priorities (see figure 87).

[87] Job priorities settings for key operators.

Copy priorities

Description When you activate ‘Copy priorities’, the copy job will be 
placed right behind the active job.
When you deactivate the option, the job will be placed at the 
end of the print queue.

Min/max values N/A

Menu path System - Job priorities - Copy priorities - <value> - Apply
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Media (group)
The Media group contains one setting: Paper series (see figure 88).

[88] Media settings for key operators

Paper series

Description Use ‘Paper series’, to specify which paper range is to be used 
as the default on your Océ 9600.
When the user sets a new media size on the printer operating 
panel, only the sizes in the selected paper series are available.
If ‘Auto format’ is enabled, the ‘Paper Series’ setting deter-
mines which sizes will be used (only those present in the pa-
per series).
Choose from the following paper series:
DIN
DIN carto
Only 8.5 inch range
Mixed 8.5 inch and 9 inch range

Min/max values N/A

Menu path System - Media - Paper series - <value> - Apply
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Timers (group)
The Timers group allows you to adjust the following settings (see figure 89):
■ Sleep mode timer
■ Manual feed time out
■ Controller panel time out

[89] Timers settings for key operators.
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Sleep mode timer

Description Use ‘Sleep mode timer’, to specify how many minutes of in-
activity are required before the Océ 9600 switches to Sleep 
mode. In Sleep mode, most of the power supply is cut off.  
Note:  The sleep mode time out also applies to the scanner 
and the folder, but NOT to the controller.

Min/max values N/A

Menu path System - Timers - Sleep mode timer - <value> - Apply

Manual feed time out

Description Use ‘Manual feed time-out’, to define the manual feed 
time-out in. This is done in terms of seconds.  This time-out 
is the amount of delay time that must pass before jobs will 
get the ‘not ready to print’ status (e.g. when the sheet is not 
being fed).

Min/max values N/A

Menu path System - Timers - Manual feed time out - <value> - Apply

Controller panel time out

Description Use ‘Panel time-out’, to set the panel time-out for the scan-
ner panel. When no settings are being selected and no origi-
nal is being scanned, the panel will switch to the default 
settings after this time out has elapsed. By default, this set-
ting is ‘ON’. The default panel time-out is 90 sec. 

Min/max values N/A

Menu path System - Timers - Controller panel time out - <value> - Ap-
ply
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Disk clean up (group)
Use disk clean up to clean the disk in regular intervals. Clean up can be done 
automatically or manually. Three directories can be cleaned (see figure 90):
■ Temporary store folder
■ Unsent folder
■ Scan spool folder

[90] Disk clear up settings for key operators
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Frequency

Description Frequency: the folder will be cleaned at the preset time.

Min/max values 0 - 850 h

Menu path System - Disk cleanup - Local storages / Unsent folder / Scan 
spool cleanup - Frequency - <value> - Apply

File age

Description File age: files older than the specified time and date will be 
deleted.

Min/max values 0 - 850 h

Menu path System - Disk cleanup - Local storages / Unsent folder / Scan 
spool cleanup - File age - <value> - Apply

Next time

Description Next time: the next cleanup action will be at the preset time. 
After completion of the clean up action, this setting is updat-
ed according to the frequency setting.

Min/max values N/A

Menu path System - Disk cleanup - Local storages / Unsent folder / Scan 
spool cleanup - Next time - <value> - Apply
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Scanner related settings

There are four single scanner-related settings and two groups of settings for a 
key operator (see figure 91):
■ Printer family (single)
■ Rewind originals (single)
■ Automatic feed (single)
■ Fit method (single)
■ Zoom steps (group)
■ Timers (group)

[91] Scanner-related settings for a key operator
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Single options

Printer family

Description During scan-to-file, the image can be optimized for a speci-
fied range of printers. When reprinting a scanned file, the 
output quality will be best on a printer from the specified 
family. A ‘Universal’ printer does not optimize for one range 
of printers, but gives an image that will print about equally 
well on all types of printers.

Min/max values N/A

Menu path Scanner - Settings - Printer family - <value> - Apply

Rewind originals

Description Use ‘Rewind originals’, to have the Océ 9600 rewind the 
originals after they have been scanned.
You can then take the scanned original from the front of the 
scanner.

Min/max values N/A

Menu path Scanner - Settings - Rewind originals - <value> - Apply

Automatic feed

Description If you enable the ‘Automatic feed time out’ option, you only 
have to use the start key once at the beginning of the scan job.
If this option is disabled, you will have to press the start key 
for every original in order to start scanning or copying.
Note:  If the start button has to be used to start the scanning, 
a message will appear.

Min/max values N/A

Menu path Scanner - Settings - Automatic feed - <value> - Apply
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Zoom steps (group)

The Key-Operator can change the 8 zoom steps in the range from 25.0 % - 
400.0% in increments of 0.1%. There are 4 zoom steps to reduce and 4 zoom 
steps to enlarge (see figure 92). The 100.0 % zoom step cannot be changed.

[92] Zoom steps for key operators

Fit method

Description Use ‘Fit method’, to indicate on which media size an original 
will be printed if the specified media size is not available.
The following options are available:
Exact fit: he document will only be printed if the specified 
media size is available. 
Next larger: if the specified media size is not available, the 
document will be printed on the next larger size. 
Next smaller: if the specified media size is not available, the 
document will be printed on the next smaller size. 
Best fit: the Océ 9600 will choose the best possible fit meth-
od. If the specified media size is not available, larger sizes 
will have preference above smaller sizes.

Min/max values N/A

Menu path Scanner - Settings - Fit method - <value> - Apply
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The defaults for the 8 zoom steps are:
■ Reduction step 1: 70.7 %
■ Reduction step 2: 50 %
■ Reduction step 3: 35.5 %
■ Reduction step 4: 25 %
■ Enlargement step 1: 141.4 %
■ Enlargement step 2: 200 %
■ Enlargement step 3: 282.8 %
■ Enlargement step 4: 400 %

Timers (group)
There are three scanner-related timer settings a key operator can change (see 
figure 93):
■ Panel time out
■ Set time out
■ Automatic feed time out

[93] Scanner related Timer settings for key operators
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Panel time out

Description The ‘Panel time out’ option allows you to set the panel time 
out of the scanner panel. When no settings are being made 
and no original is being scanned the panel will switch to de-
fault settings after this time out has elapsed.

Min/max values 30 - 600 seconds

Menu path Scanner - Settings - Timers - Panel time-out - <value> - Ap-
ply

Set time out

Description The ‘Set time-out’ option allows you specify how much time 
must elapse before the set on the scanner is automatically 
closed if no new original is fed and the set is not closed with 
the start key.

Min/max values 10 - 600 seconds

Menu path Scanner - Settings - Timers - Panel time-out - <value> - Ap-
ply

Automatic feed time out

Description If you enable the ‘Automatic feed time out’ option, you only 
have to use the start key once at the beginning of the scan 
job.
If this option is disabled, you will have to press the start key 
for every original in order to start scanning or copying.

Min/max values 15 - 600 seconds

Menu path Scanner - Settings - Timers - Automatic feed time out - <val-
ue> - Apply
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Chapter 11
System administrator settings

This chapter describes how to make System Administrator 
settings on the Océ 9600 Settings Editor.
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Introduction

The Océ 9600 system administrator is responsible for: 

■ Dithering matrix and Poker settings
■ Printer language controller settings
■ Pen settings
■ Automatic Language Selection (ALS) settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings. 

To modify the system administrator settings, you have to access the SA settings 
in the Settings Editor. 

This chapter will inform you about accessing the Settings Editor and how to 
define system administrator settings.
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System Administrator settings

In order to perform special system administrator functions, you must log on to 
the Settings Editor as a system administrator (see ‘User modes’ on page 121).

Note: When you are finished, make certain you log out of the System 
administrator mode of the Settings Editor to prevent unauthorized use of the 
Océ 9600.

▼▼▼▼ Choose system administrator settings in the Settings Editor

1 Maximize the Settings Editor on the screen.
2 Log in as system administrator. 

See ‘User modes’ on page 121 for more information about logging into the 
Settings Editor.

3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings, such as the default pen settings, are made directly 
from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting

7 Log out of the System administrator mode when you are finished updating 
settings. 

See ‘Settings Editor’ on page 132 for more information about the Settings 
Editor.
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There are two types of system administrator settings (see figure 94):
■ Printer
■ System

.

[94] System administrator settings in the Settings editor
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Printer related settings

The PDLs tab contains 5 single options and 9 groups of settings:
■ Dithering matrix (single option)
■ Poker PDL heap size (single option)
■ Poker min number of vertices in polygons (single option)
■ Poker max number of vertices in polygons (single option)
■ Scale down algorithm (single option)
■ HPGL (group)
■ HPGL-2 (group)
■ Calcomp (group)
■ Postcript (group)
■ NIRS (group)
■ C4 (group)
■ TIFF (group)
■ CALS (group)
■ ASCII (group)
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Note: The minimum and maximum number should be the same.

Dithering matrix

Description The ‘Dithering matrix’ option allows you to select the dith-
ering matrix for improving the print quality. You can choose 
between:
- Clustered
In general, this option can be used for vector files with sharp 
lines
- Stochastic
Use this option in case of raster files.

Min/max values N/A

Menu path Printer - PDLs - Dithering matrix - <value> - Apply

Poker PDL heap size

Description This setting allows you to increase the PDL heap size if the 
system is unable to perform transformations (due to large 
polygons). However, a higher heap size may result in perfor-
mance degradation.

Min/max values 16 - 256 Mb

Menu path Printer - PDLs - Poker PDL heap size - <value> - Apply

Poker min number of vertices in polygons

Description This setting specifies the minimum number of vertical poly-
gons that can be correctly handled by the printer.

Min/max values 1024 - 35000

Menu path Printer - PDLs - Poker min number of vertices in polygons - 
<value> - Apply
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Note: The minimum and maximum number should be the same

.

Printer Descriptive Language settings (groups)

The Printer menu in the SA settings of the Settings Editor allows you to define 
specific settings for the available printer languages and to change pen settings 
for the supported vector languages.

The Océ 9600 accepts print files in various data formats (languages). These 
include HP-GL, HP-GL/2, Calcomp, Postscript level 2, NIRS, C4, TIFF, 
CALS and ASCII. You can change the settings for HP-GL, HP-GL/2, Calcomp 
and ASCII. The other available languages can only be enabled or disabled.

On the Océ 9600, a number of settings are available which allow the system 
administrator to specify, by connection type, which printer languages are 
accepted for automatic data format recognition and which language is forced. 
These settings are called ALS (Automatic Language Sensing) settings.

Poker max number of vertices in polygons

Description This setting specifies the maximum number of vertical poly-
gons that can be correctly handled by the printer. If you se-
lect a very high value, a great deal of memory will be used 
and performance degradation may occur.

Min/max values 1024 - 35000

Menu path Printer - PDLs - Poker max number of vertices in polygons 
- <value> - Apply

Scale down algorithm

Description Use 'Scale down algorithm', to scale down a bitmap. If you 
use 'Sampling', all information will be sized down. This 
means that you may lose thin lines. If you use 'Black pixel 
conservation' to scale down the bitmap, all information will 
be kept.

Min/max values N/A

Menu path Printer - PDLs - Scale down algorithm - <value> - Apply
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If ALS is enabled, the Océ 9600 automatically recognizes the host data 
language and adapts the printer to support all the parameters required for 
printing data from the host.

Automatic data format recognition enables the Océ 9600 to switch between 
files with different formats when working in a multi-format environment, 
where different printer drivers are being used.

The following language formats are supported on the Océ 9600:
■ HPGL
■ HPGL2
■ CALCOMP
■ Postscript
■ NIRS
■ C4
■ TIFF
■ CALS
■ ASCII

The ASCII language is not automatically recognizable, but must be forced 
when plots are to be printed in ASCII format (e.g. for printing listings). VDF 
and BGL are not available on the Océ 9600.

C4, or CALS type 4, was previously called EDMICS. NIRS is also called 
CALS type 3. CALS type 2 is recognized, but not interpreted (only CALS1 is 
supported). 

Note: When using automatic data format recognition, it is important that every 
print file begins with start of plot instructions and ends with end of plot 
instructions. 

Automatic language sensing  When you are using automatic data format 
recognition, it is advisable to:
■ Implement the same defaults for all connection types 
■ Select the ‘Automatic’ option as your ‘PDL selection’ setting for the 

appropriate connection type
■ Set all languages supported on the Océ 9600 to ‘Enabled’. 

Any other approach is only appropriate for system administrators who need to 
tune or organize the use of their system to specific organizational 
requirements.
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Note: If your plot is not recognized correctly, define the data format in a remote 
control file or an Océ Job Ticket and then send the plot again. In that case, the 
selected option only applies to this job. 
You can also select the appropriate data format manually on the Settings 
Editor panel and then resend the plot. However, this setting will remain active 
for all incoming prints on that connection. This means that you will need to 
reset machine default settings to Automatic in order to return to your “normal” 
working mode.

For further information on remote control, refer to the Remote Control File 
Reference Manual or the Océ Job Ticket Reference Manual.

▼▼▼▼ Enable Automatic Language Sensing (ALS)

1 Click on the ‘System’ button. 
The System settings are displayed

2 Click on the ‘Connectivity’ folder. 
A list of available connection types is displayed.

3 Click on the folder for the appropriate connection type.
4 Select the ‘PDL selection’ option.
5 Select ‘Automatic’ (the default value) to activate Automatic Language Sensing
6 Click on the ‘Apply’ button to save the changes you made.

Note: The following default settings can be overruled by settings that are sent 
along with the print or copy job:
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.

HPGL

Setting Description
Enable 
HPGL

The 'Enable' option allows you to enable or disable HPGL. 
Should problems arise with HPGL, the HPGL PDL can be dis-
abled by selecting the 'Disabled' option.

Origin Use the 'Origin' option to define the HPGL origin settings of the 
plot.

Select pen 
0

If you enable the 'Select pen 0' option, the selection of pen 0 will 
be interpreted as end of file (EOF).  If the option is disabled, pen 
0 will behave like a default HPGL pen.

Color 
merge con-
trol

Use the 'Color merge control' option to determine what should 
happen when two or more colors intersect at the same point on a 
plot, especially at the intersection of vectors or 'filled' polygons.  
If the color merge control is set to off, the color of the last vector 
or area fill overwrites the colors specified at the same crossing ar-
ea. White areas are considered opaque.  If set to ‘on’, all colors 
are blended together (merged) at the intersection of vectors and 
polygons.

Pen width 
scaling

To enable or disable the pen width scaling.
If enabled: scaling an image will scale the pen width correspond-
ingly.

HPGL-2

Setting Description
Enable 
HPGL-2

The 'Enable' option allows you to enable or disable HPGL-2. In 
case of problems with HPGL-2, the HPGL-2 PDL can be dis-
abled by selecting the 'Disabled' option

Origin Use the 'Origin' option to define the HPGL-2 origin settings of 
the plot.

Select pen 
0

If you enable the 'Select pen 0' option, the selection of pen 0 will 
be interpreted as end of file (EOF).  If the option is disabled, pen 
0 will behave like a default HPGL-2 pen.

Color 
merge con-
trol

Use the 'Color merge control' option to determine what should 
happen when two or more colors intersect at the same point on a 
plot, especially at the intersection of vectors or 'filled' polygons.  
If the Color merge control is set to off, the Color of the last vector 
or area fill overwrites the colors specified at the same crossing ar-
ea. White areas are considered opaque.  If set to ‘on’, all colors 
are blended together (merged) at the intersection of vectors and 
polygons.
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Pen priori-
ty

Pen parameters can be defined in two ways: 
- In the plot data file 
- In the Remote Configuration File (RCF) or Océ Job Ticket 
(OJT) 

If pen priority is set to 'Language', the pen parameters defined in 
the plot data file will be used. If pen priority is set to 'Setup', the 
pen parameters defined in the configuration file or the job ticket 
received with the plot will be used. 

PS no clip If 'PS no clip' is set to 'On' and the plot defines a Page Size (PS) 
value of WxH (Width and Height), the PS is not taken into ac-
count. In that case, the plot may be bigger or smaller than the PS.

Emulation 
type

You can use the 'Emulation type' option to determine the type of 
printer you want to emulate: HP650C or HP750C. The default 
emulation type is HP650C, which is compatible with older ma-
chines. Differences occur in the default pen palette and the de-
fault number of pens. If HP750C is selected, the default palette 
is a gray level palette and compatible with HP750C. 

Line at-
tributes

If the 'HP default' value is set, the Line Attributes instruction is 
fully emulated. All types of lines ends/joins allowed by the Line 
attributes specifications will be therefore printed according to 
these specifications. For backward compatibility reasons, the in-
terpretation of this instruction can be disabled ('Océ Round val-
ue). In that case, the lines of the plot will be processed as rounded 
and without join.

Pen width 
scaling

To enable or disable the pen width scaling.
If enabled: scaling an image will scale the pen width correspond-
ingly.

HPGL-2
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Calcomp

Setting Description
Enable 
Calcomp

The 'Enable' option allows you to enable or disable Calcomp. In 
case of problems with Calcomp, the Calcomp PDL can be dis-
abled by selecting the 'Disabled' option.

Step size The 'Step size' option allows you to define the number of steps 
per inch.  Note: This setting should correspond with the resolu-
tion of the plot.

Origin With the 'Origin' option you can define the Calcomp origin set-
tings of the plot.

Synchro 
code

You can use the 'Synchro code' option to define the character 
code for the synchronization byte. This setting indicates the be-
ginning of the plot data.

Double 
synchro

You can use the 'Double synchro' option to enable / disable the 
double sync mechanism.

Checksum You can use the 'Checksum' option to enable / disable the check-
sum. 

End of 
message

You can use the 'End of message' option to define the character 
code for the end-of-message byte. This will indicate the end of a 
data sequence. 

Pen priori-
ty

Pen parameters can be defined in two ways: 
- In the plot data file 
- In the Remote Configuration File (RCF) or Océ Job Ticket 
(OJT) 

If pen priority is set to 'Language', the pen parameters defined in 
the plot data file will be used. If pen priority is set to 'Setup', the 
pen parameters defined in the configuration file or the job ticket 
received with the plot will be used. 

Color 
merge con-
trol

Use the 'Color merge control' option to determine what should 
happen when two or more colors intersect at the same point on a 
plot, especially at the intersection of vectors or 'filled' polygons. 

If the color merge control is set to 'Off', the color of the last vector 
or area fill overwrites the colors specified at the same crossing ar-
ea. White areas are considered opaque.  If set to 'On', all colors 
are blended together (merged) at the intersection of vectors and 
polygons.

Pen width 
scaling

To enable or disable the pen width scaling.
If enabled: scaling an image will scale the pen width correspon-
dents.
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PostScript

Setting Description
PS level 2 
password

To activate PostScript level 2, you need a password. This pass-
word is coupled to the system serial number. Call your local 
dealer for this password.
After you have entered the password, you can use the PostScript 
level 2.

NIRS

Setting Description
Enable 
NIRS

The 'Enable' option allows you to enable or disable NIRS. 
Should problems with NIRS arise, the NIRS PDL can be dis-
abled by selecting the 'Disabled' option.

C4

Setting Description
Enable C4 The 'Enable' option allows you to enable or disable C4. Should 

problems with C4 arise, the C4 PDL can be disabled by select-
ing the 'Disabled' option.

TIFF

Setting Description
Enable 
TIFF

The 'Enable' option allows you to enable or disable TIFF.

Photome-
try

The 'Photometry' option allows you to define the photometry val-
ue for TIFF.

You can choose from:
- File control 
The photometry info in the TIFF header will be used. 

- White is zero 
The photometry info in the TIFF header will be overruled. 

For example: 
When the plot is inverted in terms of background and you wish 
to correct that, this option can fix the problem and re-invert the 
plot (although it depends on the content of the plot) 
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CALS

Setting Description
Enable 
CALS

The 'Enable' option allows you to enable or disable CALS. 
Should problems with CALS arise, the CALS PDL can be dis-
abled by selecting the 'Disabled' option.

ASCII

Setting Description
Enable 
ASCII

The 'Enable' option allows you to enable or disable ASCII. 
Should problems with ASCII arise, the ASCII PDL can be dis-
abled by selecting the 'Disabled' option.

End of line The 'End of line' option allows you to define the type of line 
break used in the ASCII file:
- carriage return (CR) only 
- line feed (LF) only 
- carriage return and line feed (CR-LF). 

Line over-
flow

The 'Line overflow' option allows you to define whether a line 
that extends beyond the right margin is wrapped onto the next 
line, or is truncated.

Font size The 'Font size' option allows you to define the font size to use, in 
points (1 point=1/72 inch) 

Tab size The 'Tab size' option allows you to define the tab size to use.
Top margin The 'Top margin' option allows you to define the top margin to 

keep above the text. 
Bottom 
margin

The 'Bottom margin' option allows you to define the top margin 
to keep underneath the text. Top is related to input, not orienta-
tion of paper.

Left mar-
gin

The 'Left margin' option allows you to define the margin to keep 
to the left of the text.

Right mar-
gin

The 'Right margin' option allows you to define the margin to keep 
to the right of the text.

Pen width The 'Pen width' option allows you to define the default line width 
of the text.

Page type The 'Page type' option allows you to define the default page type 
for the logical image that contains the ASCII text. 
Possible values are:
- Standard 
- Custom

Custom 
page width

The 'Custom page width' option allows you to define the selected 
page width when 'Custom' has been selected as default page type.
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▼▼▼▼ Specifying printer language settings

1 Click on the ‘Printer’ button. 
The Printer settings are displayed.

2 Click on the ‘PDLs’ tab. 
A list of available printer languages is displayed.

3 Click on the folder for the appropriate language and make the desired settings.
4 Click on the ‘Apply’ button to activate the changes.

Custom 
page 
height

The 'Custom page height' option allows you to define the selected 
page height when 'Custom' has been selected as default page 
type.

Standard 
page for-
mat

The 'Standard page format' option allows you to define the de-
fault size of the formatted text when 'Standard' as file type is se-
lected.

Standard 
page orien-
tation

The 'Standard page orientation' option allows you to define the 
direction of the ASCII text when 'Standard' is selected as file 
type.
The following settings are available:
- Portrait 
- Landscape

Pen width 
scaling

To enable or disable the pen width scaling.
If enabled: scaling an image will scale the pen width correspon-
dents.

ASCII
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Pen settings

When printing files, the pen settings can be changed on the ‘Pens’ tab of the 
‘Printer’ menu. You can change the default width and pattern for each pen 
number. These settings apply to all vector languages: HP-GL, HP-GL/2 and 
CalComp.

[95] Making pen settings

Pen width  Pen width can be defined from 0.12 up to 16.25 mm. By default, all 
pen widths are set to 0.12 mm. Adjustment can be made in increments of 0.01 
mm.

Pen pattern  A pen can be selected by the plot file to draw a line or to fill a 
polygon. All lines or polygons on the plot can be drawn with a predefined 
pattern or shade of grey. Default is pen pattern 16 (black). 
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The following pen patterns are available:

[96] Available pen patterns

▼▼▼▼ Define pen settings

1 Click on the ‘Printer’ button. 
The Printer settings are displayed

2 Click on the ‘Pens’ tab.
The Pen settings are displayed (see figure 95).

3 Type a pen number in the ‘Pen number’ box or select a number with the 
selection arrows to the right of the box. 
The ‘Pen width’ and ‘Pattern’ boxes now become active.

4 Specify a pen width by typing a value or selecting one with the selection 
arrows.

5 Specify a pen pattern by typing a number, selecting one with the selection 
arrows or clicking on one of the available patterns in the ‘Pattern overview’ 
box.

6 Click on the ‘Apply’ button to save the changes you made.

white

black
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System related settings

The system related settings contains one single option and three groups of 
options (see figure 97):
■ Scan memory reservation (single option)
■ Controller identification (group)
■ Set memory reservation (group)
■ Connectivity (group)

[97] System related settings in the Settings Editor
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Controller identification settings (group)

Controller identification contains the following options:
■ Host name
■ Description
■ Location
■ Administrator

Scan memory reservation

Description To specify the maximum amount of the file system disk us-
age allowed for all folders to store scanned files, temporary 
store folder, unsent folder and the scan spool folder

Min/max values 1024 -3072 Mb

Menu path System - Scan memory reservation - <value> - Apply
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[98] Making system settings

Host name

Description To specify the name with which the Océ 9600 will present 
itself on the TCP/IP network. To identify the controller, you 
have to enter the host name. Keep the following: 
- use no more than 15 characters. 
- choose characters from the following series: a-z; A-Z; 0-9. 
- if you use a hyphen, put it somewhere in the middle of the 
name, not at the beginning nor at the end.

Min/max values N/A

Menu path System - Controller identification - Hostname - <value> - 
Apply

Description

Description To enter additional information about the system. It is not 
mandatory to fill in this field.

Min/max values N/A

Menu path System - Controller identification - Description - <value> - 
Apply

Location

Description To enter additional information about the system. It is not 
mandatory to fill in this field.

Min/max values N/A

Menu path System - Controller identification - Location - <value> - Ap-
ply

Administrator

Description To enter the name of the system administrator.

Min/max values N/A

Menu path System - Controller identification - Administrator - <value> 
- Apply
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Set memory reservation settings
The System Control Panel contains a set memory bar, which indicates how 
much set memory is still available. In the Settings Editor, you can define the 
threshold values for the orange and red zones (see figure 97 on page 208).

Connectivity settings

The Océ 9600 supports a large number of different connection types, 
including:
■ Centronics
■ FTP
■ LPD
■ SMB
■ Novell
■ TCP/IP
■ IPX/SPX
■ NetBeui

Orange zone limit

Description To specify the orange limit in Megabytes. The orange zone 
is entered when the free space in the set memory becomes 
less than this limit.

Min/max values 100 -2048 Mb

Menu path System - Set memory reservation - Orange zone limit - <val-
ue> - Apply

Orange zone limit

Description To specify the red limit in Megabytes. The red zone is en-
tered when the free space in the set memory becomes less 
than this limit. If the red zone is reached,  write access to set 
memory is refused, until the starting point of the orange zone 
is reached.

Min/max values 50 -1024 Mb

Menu path System - Set memory reservation - Red zone limit - <value> 
- Apply
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The system administrator can configure the Océ 9600 for these different 
connection types with the help of the Settings Editor.

▼▼▼▼ Making connectivity settings

1 Click on the ‘System’ button.
2 Open the ‘Connectivity’ folder.
3 Open the folder with the appropriate connection type.
4 Select any of the available options for the selected connection type.
5 Change the setting in the update area, as appropriate.
6 Click on the ‘Apply’ button to save any changes you have made.

See the Océ 9600 Connectivity Manual R 2.1 on the ‘User Documentation and 
Remote Applications CD-ROM’, which is delivered with the system, for 
detailed information about making the Océ 9600 available in your particular 
network configuration.
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Centronics

Setting Description

Enable Centron-
ics

To define if Centronics communication is enabled or dis-
abled.

Plot time-out To define the plot time-out on a Centronics connection.
1 - 1000 s

Communication 
mode

To define the communication mode for a Centronics connec-
tion. With ‘Print while spool’, the data will be spooled in 
chunks. With ‘spool then print’, the complete job will be 
spooled before printing starts.

PDL selection To define the PDL enabled for a Centronics connection. The 
Automatic option enables Automatic Language Sensing.

FTP

Setting Description

Enable FTP To specify whether or not FTP communication is enabled or 
disabled.

Time-out To define the plot time out on a FTP connection.
60 -900 s

Communication 
mode

To define the communication mode for an FTP connection. 
With ‘Print while spool’, the data will be spooled in chunks. 
With ‘spool then print’, the complete job will be spooled be-
fore printing starts.

PDL selection To define the PDL activation for a FTP connection. The Au-
tomatic option enables Automatic Language Sensing.

LPD

Setting Description

Enable LPD To specify whether or not LPD communication is enabled or 
disabled.

Communication 
mode

To define the communication mode for an LPD connection. 
With ‘Print while spool’, the data will be spooled in chunks. 
With ‘spool then print’, the complete job will be spooled be-
fore printing starts.

PDL selection To define the PDL activation for a LPD connection. The Au-
tomatic option enables Automatic Language Sensing.
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SMB

Setting Description

Enable SMB To specify whether or not SMB communication is enabled 
or disabled.

Workgroup name To specify the SMB workgroup name. A workgroup is a 
group of users sharing computer files and services for com-
munication.

Communication 
mode

To define the communication mode for a SMB connection. 
With ‘Print while spool’, the data will be spooled in chunks. 
With ‘spool then print’, the complete job will be spooled be-
fore printing starts.

PDL selection To activate the PDL for an SMB connection. The Automatic 
option enables Automatic Language Sensing.

Novell

Setting Description

Enable Novell To specify whether or not Novell communication is enabled 
or disabled.

Pserver name To specify the Novell PSERVER name. The specified string 
should not be preceded by a period.

Pserver pass-
word

To specify the Novell PSERVER password.

Access mode To define the Novell access mode.

File server 
names

To specify the names of the available Novell file servers. You 
can define multiple names, divided by a semi-colon.

NDS context To specify the Novell Directory Services context of the Ps-
erver that has been defined for the system.

Queue poll inter-
val

To specify the Novell queue poll interval in terms of sec-
onds. The system will check Pserver regularly for new jobs 
to be printed.

Connection retry 
interval

To define the interval for trying to re-establish a Novell con-
nection.

Communication 
mode

To define the communication mode for a Novell connection. 
With ‘Print while spool’, the data will be spooled in chunks. 
With ‘spool then print’, the complete job will be spooled be-
fore printing starts.

PDL selection To define the PDL enabled for a Novell connection. The Au-
tomatic option enables Automatic Language Sensing.



System administrator settings 215

TCP/IP

Setting Description

Domain To specify the network domain name. The network domain 
name is the TCP/IP address of the domain server where the 
Océ 9600 controller is connected to.

DNS To specify the DNS server. Use semicolons ( ; ) to separate 
entries.

Enable To specify whether or not the TCP/IP adapter is enabled or 
disabled, in order to allow TCP/IP communication.

Enable DHCP To enable or disable the DHCP protocol, this allows network 
administrators to manage and automate the assignment of 
Internet Protocol. In order to make DHCP recognize your 
system, a fixed IP address has to be configured.

IP address To specify the IP address for the server. A single adapter card 
can have more than one adapter on it, so it is possible to 
specify several IP addresses.

IP mask To specify the IP subnet mask for the server. The subnet 
mask is a number that, when compared by the computer with 
a network address number, will block out all but the neces-
sary information.

Default gateway To specify the default gateway IP address. A gateway con-
nects networks using different protocols so that information 
can be passed from one to the other. A gateway both trans-
fers information and converts it to a form compatible with 
the protocols used by the receiving network.

Primary WINS 
server

Type the IP address for the primary WINS server. This uses 
Windows Internet Name Service (WINS) protocol in combi-
nation with name query broadcasts to resolve computer 
names to IP addresses.

Secondary WINS 
server

Type the IP address for the secondary WINS server. This 
uses Windows Internet Name Service (WINS) protocol in 
combination with name query broadcasts to resolve comput-
er names to IP addresses.

IPX/SPX

Setting Description

Enable To specify whether or not the SPX adapter is enabled or dis-
abled.
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NetBeui

Setting Description

Enable To specify whether or not the NetBeui adapter is enabled or 
disabled.
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Chapter 12
Loading supplies

This chapter describes regular maintenance tasks, such as 
refilling paper and toner, and refilling the folder 
reinforcement unit.
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Introduction

This chapter covers the important maintenance activities, such as:

■ Loading rolls of print material
■ Loading cut sheet material
■ Adding toner
■ Cleaning the glass platen and the scanner reference roller
■ Refilling the folder reinforcement unit
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Media

The Océ 9600 is available in many configurations, ranging from two rolls in a 
single drawer, four rolls in two drawers plus three cassette trays and a 
maximum of six rolls with one cassette tray. 

Note: Contact your Océ representative if you want to know more about the 
available configurations.

Each of the rolls and cassette trays on the Océ 9600 may be loaded with print 
material of a different size or type. The size and type of the available media are 
indicated on the operating panel.

Note: In case you have three cassette trays, no A4 size material and no A3 
landscape material can be used in the bottom cassette trays. The minimum size 
of media in the third cassette tray is A2.

Attention: After loading new print material, you need to inform the system 
about the size of the material and of the type of print material that was 
loaded (paper, transparent, or polyester).

The definition of the size and type of the new print material is required in order 
to:

■ Enable the automatic media switch function to work correctly (see 
‘Automatic roll switch’ on page 174)

■ Prevent folding errors (when a folder is installed)
■ Support autozoom and auto format functions.

Caution: It is highly advisable to place heavy rolls (A0, A1, and 175 meter 
rolls of plain paper) in position 1 of the top drawer, position 3 of the middle 
drawer or position 5 of the bottom drawer, to minimize user strain. The 
diameter of rolls should not exceed 185 mm (6.5 inches).
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Rolls
When a roll is empty during a print job, a ‘Roll empty’ message is displayed 
at the printer operating panel and on the System Control Panel application. You 
then have to load a new roll of print material.

Note: The following media are currently supported on the Océ 9600:

■ Plain paper (Red label plus) 20 lb. bond
■ Plain paper (Red label) 6 lb. bond
■ Transparent paper 4.5-5 lb. bond
■ Polyester film (CPRF) 3.5mil
■ Polyester film 4.5mil
■ vellum (9020/9022) 20lbs.

Caution: See Appendix B for more information about safely handling/ 
placing rolls of print material in the printer.

▼▼▼▼ Loading rolls

1 Open the appropriate roll compartment (see figure 99).

[99] Opening the appropriate roll compartment

2 If necessary, remove any scrap material from the paper roll compartment.
3 Remove the roll holder from the paper roll compartment.
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4 Press the green knob inside the roll holder (on the right side) to release the 
locking mechanism (see figure 100) and remove the core from the holder.

[100] Pressing the green knob

Note: You can place the new roll in the groove on top of the printer.
5 Slide the roll holder in the new roll of material while pressing the green knob.
6 Align the roll with the appropriate size indicator on the roll holder and release 

the locking mechanism. This line has to be completely visible.
7 Use both hands to place the holder in the roll compartment (see figure 101).

[101] Positioning the roll

34"
A0 36"

left view
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8 Use both hands to slide the material under the metal paper guide until it makes 
contact, as shown in figure 102.

[102] Using both hands to load the material

Note: If the print material is especially curled, it may be somewhat difficult to 
slide the material under the paper guide. If this is the case, you can slightly fold 
back the top few centimeters (no more than 10) of the print material to 
facilitate the load process.

9 Press the appropriate green button inside the paper roll compartment (see 
figure 103). The material will automatically be fed into the machine.
You may also refer to the sticker inside the drawer.

[103] Button for feeding and cutting the paper

10 Press the green button a second time to cut off the material protruding from the 
paper path.

11 Remove the scrap material.
12 Close the roll compartment.
13 Press the on line button to put the system off line.

Feed/cut
buttons
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14 Specify the size and type of material on the operating panel.
15 Press the on line button again.

Note: You only have to adjust the settings on the operating panel when you 
alter the size and/or media type.

Roll loader  In order to help customers comply with the international safety 
regulations as far as maximum roll weights are concerned, Océ has developed 
a roll loader for use with the Océ 9600. See ‘Recommended weight limits’ on 
page 292 for more information about the maximum recommended roll weights 
with and without a roll loader.

▼▼▼▼ Use the optional roll loader to load a roll

1 Fully open the roll compartment.
Inside the drawer, the roll loaders are installed. The roll loaders consist of a 
metal frame with a lever and a green knob in the middle of the lever.

2 Put the appropriate horizontal lever in an upright position by pulling it to the 
right.

3 Pull the lever completely forward. The roll holder is lifted up (see figure 104).
d

[104] Lifting up the holder with the roll loader

4 Remove the roll holder from the paper roll compartment using both hands.
5 Press the green knob inside the roll holder to release the locking mechanism 

and remove the core from the holder.
Note: You can place the new roll in the groove on top of the printer.

6 Slide the roll holder in the new roll of material while pressing the green knob.
7 Align the roll with the appropriate size indicator on the roll holder and release 

the locking mechanism. This line has to be completely visible.
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8 Use both hands to place the holder in the roll loader (see figure 105).
d

[105] Placing the new roll in the roll loader

9 Place the holder back in the roll compartment by returning the roll loader lever 
to its upright position. The roll will now be loaded.

Caution: Be careful when lifting the lever to avoid any possible damage to 
the roll compartment.

10 Use both hands to slide the material under the metal paper guide until it makes 
contact, as described in the procedure for loading rolls of print material.

11 Press the appropriate green button inside the roll compartment. The material 
will automatically be fed into the machine.
Note: You may also refer to the sticker inside the drawer.

12 Press the green button a second time to cut off the material protruding from the 
paper path.

13 Remove the scrap material.
14 Return the roll loader lever to its starting position by pushing it to the left.
15 Close the paper roll compartment.
16 Press the on line button to put the system off line.
17 Specify the size and type of material on the operating panel.
18 Press the on line button again.

Note: When you alter the size and/or media type, you have to adjust the settings 
on the operating panel.
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Cut sheet material
When a cassette tray is empty during a print job, a ‘Cassette tray x empty’ 
message is displayed at the printer operating panel and in the System Control 
Panel (SCP) application. You then have to load new cut sheet print material.

Note: Polyester cut sheets must be ventilated before use in order to prevent 
sticking together. Also, avoid the use of sheets that have already been printed 
on one side.

▼▼▼▼ Loading cut sheet material

1 Open the appropriate drawer (see figure 106).

[106] Opening the appropriate drawer
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2 Release the right-hand guide by squeezing the light-green release handle on the 
guide (see figure 107) and move the guide to the required media size indicator. 
Note: Make certain that the handle is properly aligned with the appropriate 
indicator.

[107] Adjusting the position of the right-hand guide

3 Remove the print material from its packaging. In the case of wrapped paper, 
also remove the top and bottom sheets.
Note: If you use polyester as print material, you have to ventilate the sheets 
before you load them to avoid having them stick together.

4 Position the print material in the drawer against the front plate. The side to be 
printed should be face-down.
Note: You can check if the material is properly loaded by looking through 
the view holes in the drawer (see figure 107).

5 Adjust the right-hand guide.
Note: Carefully place the print material in the drawer to avoid damage to 
the media.

6 Slide the two other guides into position.
You may also refer to the sticker inside the drawer.

7 Close the drawer.

Note: When you alter the size and/or media type, you have to adjust the settings 
on the operating panel.

Attention: If you decide to reload print material when the drawer is not 
entirely empty, it is recommended to remove all remaining print material 
from the drawer before you insert the new print material. This way you can 
avoid the risk of inadvertently shifting any remaining print material out of 
place and blocking the path. This could result in a jam.

guide
release
handles

view holes
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Toner

When a ‘Toner low’ message appears on the printer panel, you should refill 
toner. From this moment on, you can print a maximum of 260 m2.

Refilling toner can be done at any time, even while a job is printing. You will 
be able to finish your current job.

If you do not refill toner in time, the system will stop and an ‘Out of toner’ 
message will appear. In that case, printing will only be resumed after you have 
refilled toner and pressed the on line button.

Note: Before you refill toner, always make certain that you first replace the 
waste toner bag.

▼▼▼▼ Adding toner

1 Open the left cover of the printer (see figure 108).

[108] Opening the left printer cover

2 Pull the waste toner bag from the holder and place the supplied cap on the bag.
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3 Slide a new waste toner bag as far as possible over the holder (see figure 109).

[109] Replacing the waste toner bag

Attention: Use only Océ B5 toner.

4 Shake the toner bottle thoroughly and open the bottle.
5 Screw in the bottle clockwise in a slanted position (see figure 110).

[110] Screwing in the bottle
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6 Move the toner bottle to a vertical position (see figure 111).

[111] Adding toner

7 Tap the bottle to remove the toner from the bottle.
8 Return the bottle to its original position when the toner bottle is empty.
9 Unscrew the toner bottle counter-clockwise and close it.

10 Close the cover.
Printing will be resumed after you press the ‘on line’ button.
Note: When you have refilled toner after a ‘toner low’ message, it may take a 
while (up to thirty seconds), depending on the number of prints that you make, 
before the ‘Out of toner’ message disappears. When you have refilled toner 
after the system had stopped due to low toner supply, you have to confirm the 
refill operation by pressing the On line button. The ‘Out of toner’ message will 
then disappear.
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Maintenance of the glass platen and the 
reference roller

If the glass platen is dirty or static, it should be cleaned to ensure top quality 
copies are produced. At the same time, you can clean the white reference roller.

▼▼▼▼ Clean the glass platen and reference roller

1 Turning off the scanner.
2 Open the top scanner cover  (see figure 112). 

[112] Opening the top scanner cover

3 Clean the glass platen with a soft cloth, moistened with water (see figure 113). 

[113] Glass platen and reference roller
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4 Clean the white reference roller with soft cloth moistened with a small quantity 
of Cleaner A (see figure 113).

5 Lift the top cover of the scanner to release the hinge lock, then close the cover 
(see figure 114).

[114] Closing the top scanner cover

6 Turning on the scanner.



232 Océ 9600 Copier/Printer User Manual

Reinforcement unit maintenance

This section covers maintenance activities for the optional folder 
reinforcement unit, such as:
■ Inserting a new tape roll
■ Emptying the waste box
■ Cleaning the reinforcement knives

Attention: Only use the original reinforcement strips from Océ, to avoid 
damage to the reinforcement unit.

A new tape roll

When the tape roll is empty while the engine is on stand-by, one of these 
messages will appear on the display:

■ ‘Load reinforcement tape’
■ ‘Reinforcement unit empty’ (if the engine was running when the roll ran out 

of tape).

When a tape roll is empty while the engine is running, this message will be 
accompanied by a picture of the engine with the side door of the reinforcement 
unit blinking (see figure 115).

[115] No tape in reinforcement unit
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▼▼▼▼ Inserting a new tape roll

1 Open the side door of the reinforcement unit (see figure 116).

[116] Opening the side door of the reinforcement unit

2 Turn the two guide plates away from the pin roller and lock them into their 
open position (see figure 117).

[117] Opening the guide plates
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3 Remove the trailing edge of the old tape (see figure 118).

[118] Removing the trailing edge of the old tape

4 Open the front side plate of the roll holder by unscrewing the green nut and 
removing the old kernel.
Note: It is recommended that you clean the reinforcement knives before you 
insert a new roll. See ‘Maintenance of the reinforcement knives’ on 
page 241 for more information.

5 Insert the new roll and close the side plate. Make sure that the roll is placed 
with the holes to the back and the protection sheet to the front (see figure 119).

[119] Placing the new roll
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6 Detach the end of the roll and lead the tape over the large guide roller (see 
figure 120).

[120] Guiding the tape around the guide roller

7 Lead the tape between the upper and lower knife and over the pin roller (see 
figure 121).

[121] Leading the tape between the upper and lower knife
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8 Make sure that at least 200 mm (7.87 inches, or 2 strip lengths) of tape protrude 
from the knife section (see figure 122).

[122] Protruding tape

9 The holes in the tape must be aligned with the hole pattern on the sticker found 
on the frame plate of the reinforcement unit (see figure 123). If this is not the 
case, lift the tape from the pin roller and push the tape further between the two 
knives until the holes are aligned.

[123] Adjusting the holes on the tape
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10 Close the pin roller guide plates (see figure 124).

[124] Closing the guide plates

11 Peel the protection sheet off of the tape (see figure 125).

[125] Peeling off the protection sheet
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12 Lead the protection sheet back between the upper and lower knife.

[126] Leading the protection sheet between upper and lower knife

13 Lift the guide and lead the protection sheet between the protection sheet 
rollers, pulling the protection sheet tight (see figure 127).

[127] Leading the protection sheet between the rollers
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14 Insert the leading edge of the tape into the closed section of the slide (see 
figure 128).

[128] Inserting the tape into the closed section of the slide

15 Hold the upper guide plate down and cut the tape at the knife section by quickly 
pulling the edge up so that the tape is cut by the upper knife (see figure 129).

[129] Cutting the tape at the knife section

16 Close the side door of the reinforcement unit.
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The waste box
If a reinforcement unit is installed, the protective sheet from the reinforcement 
tape is stored in a waste box. For each roll of tape, the box should be emptied 
twice.

Note: You can empty the waste box while the engine is running.

▼▼▼▼ Emptying the waste box

1 Open the waste box by first pulling it to the left-hand side and then pulling it 
towards you.

[130] Opening the waste box

2 Empty the box.
3 Close the waste box by pushing it forward and then pushing it to the right-hand 

side.

[131] Closing the waste box
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Maintenance of the reinforcement knives
Because the reinforcement unit knives get sticky from the glue on the 
reinforcement tape, they have to be cleaned regularly. You are recommended 
to clean the knives each time you have inserted a new tape roll (see ‘A new tape 
roll’ on page 232) or when an error in the reinforcement unit has occurred.

When cleaning the reinforcement knives, place them in such a position that all 
the parts that need to be cleaned are accessible.

Attention: Use only the original Cleaner K and Fixing Unit Cleaning Oil 
(silicon oil) from Océ, to avoid damage to the reinforcement unit.

▼▼▼▼ Cleaning the reinforcement knives

1 Press the on line button on the printer operating panel to put the printer off line. 
The ‘Off line’ message is displayed in the status window.

2 Press the left selection button to access the ‘Folding’ menu.
A shadow effect is used to indicate that this menu has been entered.

3 Select the ‘Clean knives’ option from the ‘Folding’ menu.
Then the reinforcement knives are placed in the correct position.
Note: When a job is running, the ‘Job interrupted’ message appears. The 
machine stops running after it has correctly finished the prints that were 
already in the engine and the focus can be set to the Folding menu.
A picture of the engine appears on the display with the side door of the 
reinforcement unit blinking. 

4 Opening the reinforcement unit side door.
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5 Clean the upper and lower knife using Cleaner K (see figure 132).

[132] Cleaning the upper and lower knife

6 Oil the felt using Fixing Unit Cleaning Oil (silicon oil).

[133] Oiling the felt

Close the side door of the reinforcement unit. The knives are automatically 
placed back in their home positions. The picture on the display disappears, and 
the ‘Press start to resume job’ or ‘Ready to print’ message appears, depending 
on whether or not a job was interrupted to clean the knives.



243

Océ 9600 Copier/Printer

User Manual

Chapter 13
Problem solving

This chapter describes the problems that may occur while 
using the Océ 9600.
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Introduction

Problems that may occur with the Océ 9600 consist of: 

■ Originals jammed in the scanner (see page 245).
■ Jams, (see page 247).
■ Other problems, (see page 266).

When an error occurs, the display informs you about:
■ the type of problem
■ where it has occurred
■ how to solve it

Printing material is normally transported through the system without any 
problem. However, printing material may get stuck. If this happens, a flashing 
cover or door will be displayed on the graphic display, indicating in which part 
of the system the material has been jammed.

Stickers on some parts of the system indicate which green handles, green 
knobs, green bars and covers, etc. are to be lifted, pressed or opened to remove 
any jammed printing material.

The display guides you through a sequence of steps to solve the problem. If a 
jam occurs in more than one location, the display will continue to instruct you 
until all jammed printing material has been removed.

Once the error has been cleared, the display will give you instructions on how 
to continue the job in such a way that all prints are produced correctly.
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Original jams in scanner

If during scanning, an original becomes jammed, you can stop the original 
transport with the red Stop button.

▼▼▼▼ Removing a jammed original

1 Open the top scanner cover  (see figure 134).

[134] Opening the top scanner cover

2 Remove the original.
3 Lift the top cover of the scanner to release the hinge lock, then close the cover 

(see figure 135).

[135] Closing the top scanner cover

4 If applicable, smooth out the original and feed it in again.
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If originals are mis-fed frequently:
■ Make sure a suitable type of original is being used. See ‘List of available 

material types and sizes’ on page 288.
■ Make sure the original is inserted along the guide
■ Use the carrier sheets available from Océ to protect your valuable originals.

Note: When working with poor-quality or valuable originals, it is advised to 
disable the rewind function to avoid the risk of jams during rewind.
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Jams in printer

If printing material misfeeds, printing stops and instructions to the operator for 
solving the media jam appear in the display and the error location is shown by 
flashing covers or doors.

If print material misfeeds:
■ Follow the instructions on the display
■ Thoroughly remove scraps of print material from the machine.
■ Roll up the media and feed it in again.

If originals are mis-fed frequently, make sure that
■ the printing material is properly loaded (see ‘Rolls’ on page 220 or ‘Cut 

sheet material’ on page 225)
■ the correct printing material is used (‘List of available material types and 

sizes’ on page 288)
■ jammed printing material, scraps of printing material or foreign matter are 

left in the paper path.

How to handle jams is described in detail in the following sub-sections.

[136] Sections for jams

D: Fusing section

E: Folding section

C: Manual feeder

B: Roll feed sectionA: Cut sheet feed section
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Cut sheet feed section
The cut sheet feed section is indicated as section A in figure 136 on page 247.

▼▼▼▼ Clearing a jam in the cassette tray

1 Open the appropriate cassette tray.
Note: Only one cassette tray can be open at a time.

2 Remove any jammed printing material from the paper path (see figure 137).

[137] Removing jammed material from the paper path

3 Close the cassette tray again.
Note: If the cut sheet feed covers are still flashing on the display, re-check the 
cassette tray section.

Roll feed section

The roll feed section is indicated as section B in figure 136 on page 247.

▼▼▼▼ Clearing a jam in the roll compartments 

1 Open the appropriate roll compartment.
Note: Only one compartment can be open at a time.

2 Remove any jammed printing material from the paper path (see figure 137) 
and, if necessary, pull back the paper and rewind it.
Note: Occasionally, a jam may occur before the printing material has been 
cut. In that case, you can cut the material manually by pressing the 
appropriate green load button in the roll compartment.

3 Reload the roll if the system asks you to do so (see ‘Rolls’ on page 220).
4 Close the roll compartment again.
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Note: If the roll feed covers are still flashing on the display, re-check the roll 
feed section.

Manual feeder

When printing material misfeeds in section C, as in figure 136 on page 247 a 
jam has occurred in the manual feeder.

▼▼▼▼ Clearing a jam in the manual feeder

1 Open the manual feeder by tilting it toward you (see figure 138).

[138] Opening the manual feeder

2 Remove any jammed printing material.
Note: If the material cannot be removed easily, you must open the cover of 
the fusing section to get access to the jammed material. Otherwise, the 
OPC drum may become damaged.

3 Close the manual feeder again.
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Fuser section
The fuser section is indicated as section D (see figure 136 on page 247).

Caution: During normal use the fuser must be closed. Open it only to 
remove paper after a media jam. Because of hot surfaces, the operator 
always has to be cautious and wear heat-protective gloves when removing 
printing material from the fuser section.

▼▼▼▼ Clearing a jam in the fuser section

1 Turn off the printer.
2 Wait a few moments to let the fuser cool down.
3 Open the manual feeder to release the printing material.

Attention: If you fail to do so, the OPC drum might get damaged when you 
remove jammed material.

4 Open the cover on the left side (see figure 139).
Note: During normal use, the left cover has to be closed. This is necessary to 
ensure proper operation.

[139] Opening the left side cover
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5 Open the fuser section cover by lifting the cover by the green handle (see 
figure 140).

[140] Opening the fuser section cover

6 Remove any jammed printing material from the fuser section.
Note: If the printing material is visible in the manual feed section, remove 
it from the front side of the Océ 9600 Printer.

7 Pull the green knob to release the fuser section cover and close the cover with 
the help of the green handle.

8 Close the cover.
9 Turn the printer on again.

▼▼▼▼ Clear a jam at the integrated receiving tray

1 Open the manual feeder to release the printing material.

Attention: If you fail to do so, the OPC drum might get damaged when you 
remove jammed material.

2 Open the cover on the left side (see figure 139 on page 250).
3 Open the fuser section cover by lifting the cover by the green handle (see 

figure 140).
4 Remove any jammed printing material from the Integrated Receiving Tray.
5 Pull the green knob to release the fuser section cover and close the cover with 

the help of the green handle.
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Folder
When printing material misfeeds in section E, as shown in figure 136 on 
page 247, a jam has occurred in the folding section. 

Jams in the folder can occur in either the first fold section, the second fold 
section, the folder transport section or the belt unit.

▼▼▼▼ Clearing a jam in the first fold section

1 Opening the top cover of the folder (see figure 141). 
The green light on the right of the folder is blinking quickly.

[141] Top cover of the folder

2 Remove any jammed printing material.
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3 Open the cover of the first fold section (see figure 142).

[142] Opening first fold section

4 Open the guide plate (see figure 143).

[143] Opening the guide plate

5 Remove any jammed printing material.
6 Close the guide plate.
7 Close the cover of the first fold section.
8 Close the top cover of the folder.
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▼▼▼▼ Clearing a jam in the folder transport section

1 Open the cover of the first fold section (see figure 144).
.

[144] Open the cover of the folder transport section

2 Remove any jammed printing material.
3 Close the folder transport section cover from the left side by lifting it up and 

pushing the hinge away from you.

▼▼▼▼ Clearing a jam in the second fold section

1 Open the front door of the second fold section (see figure 145).

[145] Opening the front door of the second fold section

2 Remove any jammed printing material at the bottom of the second fold section.
3 Close the front door of the second fold section.
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4 If you have a belt unit, put the belt in an upright position (see figure 146).

[146] Putting the belt in an upright position

5 Open the delivery unit (see figure 147).

[147] Opening the delivery unit
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6 Open the guide plate with the green lever (see figure 148).

[148] Opening the guide plate with the green lever

7 Remove any jammed printing material.
8 Open the vertical transport with the green lever (see figure 149).

[149] Opening the vertical transport

9 Remove any jammed printing material.
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10 Close the vertical transport (see figure 150).

[150] Closing the vertical transport

11 Close the guide plate.
12 Close the delivery unit (see figure 151).

[151] Closing the delivery unit
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▼▼▼▼ Clear a jam in the belt unit

1 Open the belt unit door(see figure 152).

[152] Opening the belt unit door

2 Squeeze the two green knobs in the upper section of the belt unit and open the 
plate (see figure 153).

[153] Opening the plate

3 Remove any jammed printing material.
4 Squeeze the two knobs again and put the plate in its original position.
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5 Release the green lever in the lower section of the belt unit (by slightly lifting 
it and pulling it forward) to open the lower plate (see figure 154).

[154] Opening the lower plate 

6 Remove any jammed printing material.
7 Pull up the green lever again (until it locks into position) to close the plate.
8 Close the belt unit door.
9 Put the belt in its operating position by pushing it down gently.
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Reinforcement unit
If a reinforcement unit is installed, the following errors can occur:
■ Paper jams
■ Tape jams
■ No reinforcement strips on the output

This section explains how these errors can be solved.

Paper jams with the reinforcement unit  When a paper error occurs, the 
following message is displayed: ‘Paper jam’. A picture of the engine appears 
on the display with one or two doors blinking, depending on where the jam 
occurs (see figure 155).

[155] Paper jam
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▼▼▼▼ Clear a paper jam

1 Open the cover of the transport to the First Fold delivery and remove all paper 
inside (see figure 156).

[156] Open the cover of the folder transport section

2 Close the cover of the folder transport section.
3 Open the front door of the reinforcement unit (see figure 157).

[157] Opening the front door of the reinforcement unit
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4 Open the top cover of the reinforcement unit and remove all paper inside (see 
figure 158).

[158] Opening the top cover of the reinforcement unit

5 Close top cover and side door of the reinforcement unit.

Clear tape jams in the reinforcement unit  When a tape jam occurs, the 
following message appears on the display: 
‘Reload tape in reinforcement unit’.

When a tape jam occurs while the engine is running, the message will be 
accompanied by a picture of the engine with the side door of the reinforcement 
unit blinking (see figure 159). 

[159] Tape jammed in reinforcement unit
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▼▼▼▼ Clearing a tape jam

1 Open the front door of the reinforcement unit (see figure 160).

[160] Opening the reinforcement unit front door

2 Turn the two guide plates away from the pin roller and lock them into their 
open position (see figure 161).

[161] Opening the guide plates
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3 Remove all tape between the rollers and knives (see figure 162).

[162] Removing the tape

4 Lead a new trailing edge of tape between the rollers and knives.

No reinforcement strips on the output without an error message  This error 
occurs when there are no reinforcement strips on the output, although 
reinforcement is selected.

▼▼▼▼ Solve this error

1 Put the printer off line by pressing the on line button on the operating panel.
2 Opening the reinforcement unit side door.
3 See if there are loose reinforcement strips in the unit with the protection sheet 

still on (see situation B in figure 163).

[163] Situation A: No mechanical errorSituation B: Mechanical error

4 If there are, remove the tape strips in the reinforcement unit.
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Note: If the protection sheet is not on the reinforcement strip (see situation 
A in figure 163), there is no mechanical error and you should insert a new 
tape roll as described in ‘A new tape roll’ on page 232. If this error 
frequently occurs, you should call the Océ service organization (see ‘Other 
problems’ on page 266).

5 Remove all tape between the rollers and knives (see figure 164).

[164] Removing the tape

6 Lead a new trailing edge of tape between the rollers and knives. For more 
information, see ‘A new tape roll’ on page 232.
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Other problems

You can solve most other printer problems by simply pressing the on line 
button, as indicated on the operating panel.

Should there be a problem that cannot be solved in that way, the system 
displays a ‘Call service’ message. If this happens, you must call the Océ 
service organization, turn off the system with the main switch and leave the 
system as it is.
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Chapter 14
Folder

This chapter contains a description of the optional folder 
delivered with the Océ 9600.
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Océ 9600 folder

If you have a folder installed on your Océ 9600 system, the following two 
optional features are available:
■ Reinforcement unit
■ Belt unit.

Folder

On your Océ 9600 system, a folder can be installed which allows you to have 
your copies folded (see figure 165). The copies are folded according to the 
selected folding width and length in combination with a drawing method. It is 
only possible to fold paper. Polyester or transparent media cannot be folded. If 
you try to do so, a media jam may occur.

[165] Océ 9600 folder

Folder

Stacker

Belt

First Fold Delivery 
tray

Reinforcement
Unit
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Standard folding settings  By default, the standard folding settings defined for 
the Océ 9600 system by the key operator are used. The following settings are 
available:

■ Folded copy delivery (Stacker or Belt)
■ Folding legend (Leading or Trailing).
Note: In the drivers, this setting is called the ‘Folding orientation’, with the 
‘Portrait’, ‘Landscape’ and ‘Automatic’ options.
■ Drawing method (Standard (DIN), Ericsson or Afnor-like)
■ Folded package width (range 186 - 230 mm (7.3 – 9 inches) in steps of 1 mm; 

default 210 mm (8.27 inches))
■ Folded package length (range 276 -310 mm (10.87 – 12.2 inches) in 

increments of 1 mm; default: 297 mm (11.3 inches))
■ Binding edge (enabled or disabled; range 15 - 30 mm (0.59 – 1.18 inches) in 

increments of 1 mm; default 20 mm (.79 inches))
■ Reinforcement (enabled or disabled)
■ Reinforce A4 (enabled or disabled)
■ Maximum number of copies on belt.

You can overrule the standard folding program with settings from the printer 
driver or the scanner operating panel. 

More information about Océ 9600 Plot Director and other printer drivers can 
be found in the corresponding online help. The use of the Océ 9600 Copier 
panel for making folding settings is described below.

See ‘Finishing (group)’ on page 165 for more information about defining 
default folding settings.
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▼▼▼▼ Choosing folding settings from the Océ 9600 Scanner operating panel

1 Open the ‘Feeding’ card in the ‘Original’ section and press the ‘Legend 
location’ function button to select the required legend location (‘Leading’ or 
‘Trailing’).
Note: Make sure that the legend is always located on the right-hand side to 
ensure correct positioning of the legend during folding.

2 Press the ‘Drawing method’ function button to select ‘Standard’, ‘Ericsson’ or 
‘Afnor’ fold.

3 Open the ‘Finishing’ card in the ‘Copy’ section.
4 Press the ‘Folding’ function button to select ‘Full’ or ‘First fold only’ (see 

figure 166).
5 Press the ‘Folded package’ function button and change the length and/or width 

of the folded package, as required, by using the arrow buttons or the numeric 
buttons.

6 If required, press the ‘Binding’ function button.
Set the required binding edge using the arrow buttons or the numeric buttons.

7 Specify other settings as required.
8 Feed in the original.

[166] Folding options

Note: Do not select the folder when you are using A4 or letter paper on rolls 
with a width of 210 mm (8.3 inches) and a length of more than 305 mm (12 
inches) on your Océ 9600. Instead, you are advised to select the Integrated 
Receiving Tray (IRT).

Note: You can also select a drawing method and, if required, a folding length, 
folding width and binding edge. When changing the folding length and/or 
folding width and the folder is equipped with a belt, you must also adjust the 
side guides of this unit.
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Folding settings 75 grams

Output length Delivery
‘Stacker’ or ‘Belt’
selected

 < 2.73 yd Delivered on stacker or belt

2.5 m - 6 m First fold only, delivered in
first fold delivery

> 6.56 yd
length known at start

Unfolded, delivered in IRT

> 6.56 yd
length not known at start

Possible paper jam

‘First fold only’ selected < 6.56 yd Delivered in first fold delivery
> 6.56 yd
length known at start

Unfolded, delivered in IRT

> 6.56 yd
length not known at start

Possible paper jam

[167] Folding settings 75 grams

Folding settings 110 grams

Output length Delivery
‘Stacker’ or ‘Belt’
selected

 < 1.33 yd
(3 folds)

Delivered in first fold delivery

 < 1.33 yd
(2 folds)

Delivered on stacker or belt

 > 1.33 yd
< 2.73 yd

Delivered in first fold delivery

> 2.73 yd Unfolded, delivered in IRT

‘First fold only’ selected < 2.73 yd Delivered in first fold delivery
> 2.73 yd Unfolded, delivered in IRT

[168] Folding settings 110 grams
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Off line folding
An important productivity feature provided by the Océ 9600 folder, is the 
possibility to make off line folds. For off line folding the same settings can be 
made as for normal folding. By default, the predefined settings in the Settings 
Editor for off line folding are used. Polyester or transparent media cannot be 
folded. This may result in a media jam.

Note: Use off line folding only for sheets which do not exceed a maximum 
length of 6 m. If you try to fold a sheet longer than 6 m anyway, an error occurs.

▼▼▼▼ Make off line folds

1 Switch the printer off line on the printer operating panel and wait for the printer 
to finish the jobs that are already in the printer.
Note: Watch the light on the top cover of the folder. 
■ If this is off, the printer is on line and off line folding is not possible.
■ If this is blinking slowly, the printer is off line, but the folder is still 

processing the last prints.
■ If this is blinking rapidly, an error has occurred.
■ If this is on, the printer is off line and you can feed in a sheet.
Note: Also, refer to the sticker on the top cover of the folder.

2 Choose any settings for (off-line) folding on the printer operating panel.
Note: If required, the key operator can change the default settings for 
folding programs from the Settings Editor. See chapter 10, ‘Key operator 
settings’ on page 129 for more information.

Off-line folding settings

Output length Delivery
‘Stacker’ or ‘Belt’
selected

 =< 2.19 yd Delivered on stacker or belt

 2 m - 2.5 m (2 folds) Delivered on stacker or belt
2 m - 2.5 m (3 folds) Stopped in second fold (possible 

paper jam)
> 2.73 yd Unfolded, delivered in IRT

‘First fold only’ selected < 6.56 yd First fold only, delivered in first 
fold delivery

[169] Off-line folding settings
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3 Feed in the sheet of paper face-down and with the legend on your right-hand 
side. Also, make sure that you feed in the paper with the legend on the 
right-hand side (see ‘Océ 9600 folder’ on page 268 for more information).
Note: Wait until the light on the folder no longer blinks before you feed in 
a new sheet. Otherwise, a media jam may occur.

4 Collect your output.

Reinforcement unit
If you install a reinforcement unit, copies can be delivered with a pre-punched, 
self-adhesive strip (see figure 170). 

[170] Example A of a reinforcement strip

Protection sheet
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With this strip, the copy can be stored in a binder without running the risk of 
having the punching holes tear out. You can unfold a folded map in a binder 
without opening the binder mechanism (see figure 171). 

[171] Example of a folded map with a reinforcement strip

The optional reinforcement unit supports all media sizes larger than A4. 
However, A4 size media can also be reinforced if you enable A4 reinforcement 
in the Settings Editor. 

Note: Reinforcement is only possible with the Standard folding method.

See ‘Reinforcement unit’ on page 273 for more information about inserting a 
new tape roll and other maintenance issues.

▼▼▼▼ Enable reinforcement

1 Click on the ‘Jobs’ button in the Settings editor.
2 Select the ‘Copy’ tab if you want to enable folding reinforcement for copy jobs 

or select the ‘Print’ tab if you want to enable folding reinforcement for print 
jobs.

3 Open the ‘Defaults’ folder.
4 Open the ‘Finishing’ folder.
5 Select the ‘Folding reinforcement’ option.
6 Enable folding reinforcement in the right-hand part of the window. 
7 Click on the ‘Apply’ button to save any changes you have made.
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Belt unit
A belt unit offers a large capacity and more flexibility. On the belt unit, up to 
100 A0 prints can be delivered offset and stacked. You can adjust the side 
guides of the belt, depending on the width of the folded package.

See chapter 10, ‘Key operator settings’ on page 129 for more information 
about selecting the belt for default print/copy/off line delivery.

Note: The belt unit can also be selected from the drivers (including Plot 
Director) or the copier operating panel. The remote command overrules the 
key operator setting.

▼▼▼▼ Selecting belt as folded copy delivery on copier operating panel

1 Open the ‘Finishing’ card in the ‘Copy’ section of the copier operating panel.
2 Press the ‘Folding’ function button to select full folding.
3 Press the ‘Folded copy delivery’ function button to select the belt.

▼▼▼▼ Adjusting the side guides of the belt

1 Loosen the nuts (see figure 172).

[172] Adjusting the side guides of the belt

2 Adjust the plate in accordance with the width of the fold package.
3 Tighten the nuts.
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Overview of the Océ 9600 system

[173] The Océ 9600 system

1 Off line folding input
2 Integrated receiving tray
3 Printer operating panel
4 Manual feed
5 Printer
6 Rolls or cassette trays
7 Scanner
8 Scanner operating panel
9 Scanner feed table

10 Folder

10

1 2

3

6

78

9

5
4
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Printer operating panel

Stop button

On line 
button

Up/Down
buttons

Selection
buttons
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Scanner operating panel

Stop
button

Interrupt
button

Correction buttonStart button

Section buttons Arrow buttons

Function
buttons

Numeric buttons
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Product specifications Océ 9600

The Océ 9600 is a wide format, mid to high volume printing and copying 
system.
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Printer

Technology Electrophotography (LED head) with organic photo-
conductor (OPC) drum and closed toner system

Resolution 400 dpi
Speed 5 linear meters p/min. or approx. 4 A0s p/min.
Media sources Several possible configurations from 2 to 6 rolls, up to 

3 cassette trays, and manual sheet feed
Output sizes From A4 to A0, up to 15 meters long
Media types Plain, transparent, recycled, fluorescent and colored 

papers; films and vellums
Output reception Standard Integrated Receiving Tray (IRT) for 100 

prints
Warm up time None, instant behavior
Noise level < 68 dB(A) operating; 0 dB(A) stand-by
Power consumption < 1500 W operating; < 15 W in low power mode
Electrical require-
ments

120/230 V, 50/60 Hz

Dimensions 55.1 (W) x 57.9 (H) x 29.6 (D) inches, including inte-
grated receiving tray

Weight From 250 kg (550 lb.) (model with 2 rolls) to 360 kg 
(792 lb.) (model with 6 rolls and 1 sheet feeder)

Safety approvals TüV GS, CETECOM, CE, UL, (c)UL, CB, FCC Class 
B

Functionality Multiple prints: up to 999
Automatic Language Sensing (ALS)
Auto roll/cassette tray selection and switching
Plot manipulation: auto-positioning, rotation, au-
to-scaling
File spooling on the controller
Set memory: send once, process once, print many; ca-
pacity to store up to 250 A0s and create identical sets 
sorted by page or by set
Concurrent receiving/processing/ printing/finishing 
of digital jobs
Sophisticated local and remote user communication 
system with:
Queue Manager application: view status for each job 
and cancel, hold/restart the entire job
System Control Panel application: view status and set-
tings of system components
Setting Editor application: customize system settings
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Océ 9600 Controller

Platform Océ Controller with embedded Windows NT
Memory 128 MByte RAM standard, 256 MByte RAM for scan 

to file
Disk space High-speed hard disk dedicated to file spooling, and a 

high-speed hard disk dedicated to set memory offer-
ing 250 A0 storage capacity

File formats HPGL, HPGL2, HPRTL, TIFF 6.0, CALS type 1, 
NIRS, EDMICS (C4), CalComp 906/907/951, 
PostScript Level 2 (optional) 

Interfaces Standard: Ethernet 10/100 Mbits/s with RJ45
Optional: Ethernet 10 Mbits/s with BNC and SubD; 
TokenRing 4/16 Mbits/s; Centronics

Network protocols TCP/IP, NetBEUI (smb), Novell (IPX, SPX) 
Power consumption <75 W controller; 200 W monitor
Electrical require-
ments

120/230 V, 50/60 Hz

Scanner

Model Free-standing console
Optional: Original delivery tray

Technology CCD, Océ Image Logic real-time image processing 
hardware

Speed 5 linear meters per minute or approximately 4A0s per 
minute

Original feed Face down, right aligned
Automatic feed off/on 
Rewind original to front off/on

Originals Automatic original size detection
8 - 36 inches
Original width: 8 –40.16 in
Original length: 6 - 590 inches

Maximum thickness 0,04 in
Exposure control Automatic, manual fine adjustment

Special modes: Lines & Text (default), Photo, Grays & 
lines, Dark Original, Blueprint, Printed matter

Media selection Manual or automatic, based on original size (autodetect) 
and zoom factor

Reproduction scale Zoom: 25 % - 400 % (adjustable in 1 % and 0.1 % steps)
Programmed fixed steps
Auto zoom to paper size
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Input mode Single sheet
Set (sets processing/set collation)
Multiple sheets

Other operating Concurrent scanning and printing
Functions Multi-copy mode: 1-999 copies (scan once print many)

Pre-programming of next job
Programmable default settings
Programmable custom card
Automatic roll selection
Automatic reduction/enlargement
Standard cut, synchro cut and custom cut modes
Leading and trailing edge adjustment (up to +/- 400 mm 
(15.75 inches))
Two languages available

Image editing Image align: Horizontal left, middle, right
Image align: Vertical top, middle, bottom
Image shift: horizontal/vertical up to +400 mm (15.75 
inches)
Image mirroring

Noise level 65 dB (A) operating, <45 dB (A) in stand-by 
Power consumption < 110 W operating, < 10 W in stand-by
Electrical require-
ments

120/230 V, 50/60 Hz

Dimensions 51.7 (W) x 22.9 (H) x 53.3 (D) inches
Weight 90 Kg
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Scan to file

Applications Océ Scan Manager, integrated scanning solution
Scan destinations 10 programmable destinations

Scan to controller
Scan to network directory
File Transfer Protocol (FTP)

Resolution 200, 300, 400 dpi
Data formats Tiff (G3, G4, uncompressed)

CALS type 1
Scan modes Single scan, stream feed productive batch scanning
File naming Automatically generate unique file names for each scan
Check plot Single/multiple checkplots
Viewing View scans at point of scanning
Océ Image Logic Optimum scan quality with six special original modes
Ease of use STF from scanner panel, scan directly to destination
Options Océ View Station: Edit and enhancement software

Océ Batch Processor: Automated editing software

Drivers and application software

Océ ADI driver For AutoCAD 12, 13, 14, 
Windows 3.x, 95/98 and NT 3.51/4.0

Océ HDI driver For AutoCAD 2000
Windows 95/98 and NT 4.0

Océ Windows driver Windows 95/98 and NT 4.0
PostScript Level 2 driv-
ers

For Windows 95/98 and NT 4.0

Océ Plot Director Job submission software for Windows 95/98 and NT 4.0
Others Certified drivers for e.g. Microstation, Intergraph and 

Pro Engineer, provided by the CAD/EDM software sup-
plier

Finishing: integrated Folder

Folding modes On-line fanfold and crossfold
Folding method Standard (=DIN-like), Ericsson, Afnor-like;

Length: 10.87 – 12.2 inches
Width: 7.3 -  9 inches
Filing strip: 0.59 – 1.18 inch

Paper size (20 lb. bond),
Width: 11 - 36 inches
Length: 8.3 – 236.2 inches fanfold only;
8.3 – 98.4 inches for fanfold and crossfold
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First fold exit Extra bin for fanfold
Noise level < 67 dB(A) operating; 0 dB(A) stand-by
Power consumption < 100 W operating
Electrical supply 120/230 V, 50/60 Hz
Dimensions 86,61 (W) x 39,25 (H) x 49,61 (D) inches
Weight 485.02 lb
Optional features Reinforcement unit

Belt delivery tray for 100 A0

Finishing: integrated Folder

Folding modes On-line fanfold and crossfold
Folding method Standard (=DIN-like), Ericsson, Afnor-like;

Length: 10.9 – 12.2 inches
Width: 7.3 -  9 inches
Filing strip: .59 – 1.18 inch

Paper size (20 lb. bond),
Width: 11-36 inches
Length: 8.3 – 236.2  inches fanfold only;
8.3 – 98.4 inches for fanfold and crossfold

First fold exit Extra bin for fanfold
Noise level < 67 dB(A) operating; 0 dB(A) stand-by
Power consumption < 100 W operating
Electrical supply 120/230 V, 50/60 Hz
Dimensions 86,61 (W) x 39,25 (H) x 49,61 (D) inches
Weight 485.02 lb
Optional features Reinforcement unit

Belt delivery tray for 100 A0
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Finishing: copy delivery tray

Model Wheeled delivery tray with blower unit
Capacity Up to 150 sheets (media type dependent) from A4 to A0
Types of media Plain paper, transparent paper, film, vellum and polyes-

ter
Power consumption < 40 W
Electrical require-
ments

120/230 V, 50/60 Hz

Dimensions 89.4 (W) x 42.9 (H) x 56.7 (D) inches with tray fully ex-
tended

Weight 78.26 lb

Original Delivery Tray for scanner

Model Wheeled delivery tray with blower unit
Capacity Up to 150 sheets (media type dependent) from A4 to A0
Types of media Plain paper, transparent paper, vellum and polyester
Power consumption < 40 W operating
Electrical require-
ments

120/230 V, 50/60 Hz

Dimensions 46,06 (W) x 42,91 (H) x 56,69 (D) inches
Tray fully extended

Weight 78.1 lb.
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List of available material types and sizes

Océ machines and materials are matched for optimal quality and performance. 
It is therefore recommended that you use only approved Océ materials in the 
Océ 9600.
A full list of Océ materials suited for use in the Océ 9600, including plain 
paper, transparent paper, colored papers and various polyester films is 
available from your Océ representative.

Material types  The following material types are available for the Océ 9600:

Material sizes  The following material sizes are available for the Océ 9600:

Plain paper 20 to 27 lb. bond
Transparent paper 20 to 27 lb.
Vellum 16 - 20 lbs
Polyester film 3.5 or 4.5 mil
Special Colored paper, etc.

Minimum Maximum
Width 8.27 inches 36 inhes
Length 11 inches 49 feet

[174] Overview of print material that can be used

Format Width Length Format Width Length
ISO range ANSI range
A4 portrait 8.27” 11.69” A portrait 8.5” 11”
A3 11.69” 16.53” B 11” 17”
A2 16.53” 23.3” C 17” 22”
A1 23.3” 33.1” D 22” 34”
A0 33.1” 46.81” E 34” 44”

Format Width Length Format Width Length
ANSI PLUS 
range

Others

A+ portrait 9” 12” 30” 30” 42”
B+ 12” 18” B1 27.5” 39.3”
C+ 18” 24” B1+ 27.83” 1000 

mm
D+ 24” 36” B2 19.69 in 27.5”
E+ 36” 48” B2+ 19.96 in 27.5”

[175] Overview of material sizes that can be used
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Attention: Avoid storing paper in rooms where temperature and humidity 
are high. Also, avoid dust and direct sunlight. Wrap unused paper in plastic 
to prevent it absorbing moisture.

Reinforcement strips

Information about the different reinforcement strips is available from your Océ 
representative.

Attention: Only use the original reinforcement strips from Océ, to avoid 
damage to the reinforcement unit.
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Recommended weight limits

The Océ 9600 can be equipped with 6 rolls. The following recommended 
weight limits (RWLs) for the roll positions can be calculated based on the 
NIOSH method (National Institute for Occupational Safety and Health):

Note: Every roll placed in the machine includes a 1.3 kg (2.9 lbs) roll holder.

A roll loader has been designed to allow placement of all available materials in 
all roll positions without exceeding the RWLs. The roll loader allows you to 
safely use the following weights per roll:

Weight limits (in kg 
and lbs.)

Roll 1 13.5 kg (29.7 lbs.)
Roll 2 8.9 kg (19.6 lbs.)
Roll 3 13.2 kg (29 lbs.)
Roll 4 8.3 kg (18.3 lbs.)
Roll 5 13.3 kg (29.3 lbs.)
Roll 6 8.0 kg (17.6 lbs.)

[176] Recommended weight limits in kg and lbs. without roll loader

Weight limits (in kg 
and lbs.)
with roll loader

Roll 1 21.7 kg (47.7 lbs.)
Roll 2 20.5 kg (45.1 lbs.)
Roll 3 22.9 kg (50.4 lbs.)
Roll 4 22.4 kg (49.3 lbs.)
Roll 5 20.1 kg (44.2 lbs.)
Roll 6 21.5 kg (47.3 lbs.)

[177] Recommended weight limits in kg (and lbs.) with roll loader
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The following overview shows the weights of some commonly used materials:

Note: Weights do not include the 1.3 kg (2.9 lb) roll holder. 

The weight of a stack of sheets never exceeds the RWL.

Caution: If the Océ 9600 printer is not equipped with the optional roll 
loader, the NIOSH limit for load handling will be exceeded when rolls of 
imaging materials having a net weight of more than 7 kg (15.5 lbs) (i.e. a 
width of more than approximately 50 cm or 20 inches) are placed in the roll 
positions 2, 4, and 6 by a single person.

Roll weights per material

Plain paper, 24 lb bond, E size, 500 feet 9.7 kg (21.3 lbs.)
Transparent paper 23 lb, E size, 500 feet 8.2 kg (18 lbs.)
Océ polyester film (3.5mil, E size, 150 feet) 11.8 kg (26 lbs.)
Vellum 7500 (20 lb, 36", 500’) 11.4 kg (25.1 

lbs.)
Engineering bond 45-111 (20 lb, 36", 500’) 11.4 kg (25.1 

lbs.)

[178] Weights per material
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Instructions for safe use

Océ machines and materials have been developed and tested  in accordance 
with the strictest international safety standards. To ensure safety in working 
with these products, it is important that you observe the following safety rules: 

■ Do not remove any screws from fixed panels.
■ The machine is not user-serviceable except for the components and 

maintenance materials mentioned in this manual.
■ Do not place any liquids in or on the machine.
■ Use maintenance materials or other materials for their original purpose only. 

Keep maintenance materials away from children.
■ Do not mix cleaning fluids or other materials.
■ To avoid risks, all modifications to Océ equipment must be performed only 

by Océ service personnel. We recommend the use of Océ-specified 
attachment cables.

■ Do not bridge any mechanical or electrical circuit breakers.
■ Do not use an extension cord to connect the machine.
■ Locate the machine close to an easily accessible dedicated 16 A wall socket.
■ The switch in the fixed connection (if any) should be easily accessible.
■ This machine has not been designed for connection to an IT power system. 

(An IT power system is a voltage network in which the neutral wire is not 
grounded).

■ Do not block the ventilation openings of the machine.
■ Ensure that the machine is placed on a level, horizontal surface of sufficient 

strength. See the Océ 9600 safety data sheet in this appendix for information 
about the weight of the machine.

■ Make sure there is sufficient space around the machine. This facilitates 
reloading materials as well as maintenance.

■ Do not place the machine in rooms which are subject to excessive vibration.
■ Do not place the machine in rooms which are too small and insufficiently 

ventilated. See the Océ 9600 safety data sheet in this appendix for 
information about space and ventilation requirements.

■ Always use materials recommended by Océ and developed for this Océ 
machine. Materials not approved by Océ may result in machine errors or 
malfunctions.

■ Do not use the machine if it is making unusual sounds. Remove the plug from 
the power socket and contact your key operator.

■ Do not open more than one drawer at a time.
■ Do not remove the printer supports underneath the Océ 9600.
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Safety data sheets

Disclaimer  The following disclaimer is valid for all safety data sheets in this 
manual.

These safety data sheets have been compiled to the best of our knowledge as a 
condensed guide to safe handling of this product. We reserve the right to revise 
safety data sheets as new information becomes available. It is the user’s 
responsibility to determine the suitability of this information for the adoption 
of such safety precautions as may be necessary, and to contact the company to 
make sure that the data sheet is the most recent one issued. To the extent that 
limitation of liability is permitted under applicable law, we do not accept 
liability for any inaccuracy that may occur in this information.

Safety data sheet Océ 9600 printer and folder

NOT YET AVAILABLE

Safety data sheet Océ 9600 scanner

NOT YET AVAILABLE



296 Océ 9600 Copier/Printer User Manual

Safety data sheet Océ 9600 printer

Note: The contents of this safety data sheet are subject to the disclaimer on 
page 295 of this manual.

PRODUCT SAFETY DATA SHEET

Number E-691-a-US
Date May 1999

Copyright © 1999 Océ -Technologies B.V., Venlo, NL

Model Océ  9600 Printer-engine

Description Electrostatic printer, instant printing, console model, plain paper, organic photoconductive
drum, powder toner.

Max. process speed 5m/min.

Dimensions Width 1400 mm
Depth 753 mm
Height 1470 mm

Weight 250 kg 50 kg (extra rolldrawer) 25 kg (extra sheet feeder)

Voltage 230 V
Frequency 50-60 Hz
Current-rated 7,5 A
Current-max 10 A
Power consumption, operation 1470 W
Power consumption, standby 50 W
EPA ENERGY STAR ¨
* Power consumption, low power 180 W Recovery time < 3 seconds
Mains connection Cable with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Sound pressure level
(at operator/bystander
position)

Standby: In operation:
30 dB(A) mainbody 50 dB(A);

incl. optionals 57 dB(A);
mpulse ∆ Li = 3 dB(A)

Sound power level 51 dB(A) mainbody 63 dB(A);
incl. optionals 75 dB(A)

Radio interference Complies with FCC rules and regulations, part 15 class A
Radiation Below the Threshold Limit Value for UV radiation (TLV list of ACGIH)
Heat emission Standby 50 W; in operation 1470 W
Ozone emission 0,004 mg/min at continuous operation

Room volume Recommendation: min. 50 m3

Room ventilation Recommendation: min. 25 m3/h (natural ventilation)
(For heat evacuation extra ventilation may be necessary)

Use simulation at random
operation

With a room volume and ventilation as recommended and a daily volume of 210 m (much
more than average) the use simulation at random operation gives the following ozone
concentrations:
- Time weighted average 0,001 mg/m3 (0,00o5 ppm)
- Peak 0,002 mg/m3 (0,0005 ppm)

Threshold Limit Value/Occupational Exposure Limit
(Time Weighted Average) for ozone 0,2 mg/m3 (0,1 ppm)
Odour Perception Limit for ozone 0,04 mg/m3 (0,02 ppm)

Consumables Océ  OPC Drum,(Océ  Material Safety Data Sheet E-218)
Océ  B5 Toner (Océ  Material Safety Data Sheet E-199)
Océ  D5 Developer (Océ  Material Safety Data Sheet E-200)
Océ  Copying Materials. This apparatus is suitable for processing recycling paper which
complies with the requirements of ENV 12281.

Additional safety information The ozone Þlter does not have to be replaced for keeping the ozone concentration in the
workplace below 0,04 mg/m3 (the life of the Þlter equals that of the apparatus)

Listed according to standard UL 1950 and CAN/CSA-C22.2 No.950

LISTED 927F

INFORMATION
TECHNOLOGY
EQUIPMENT

E 69871
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EPA ENERGY STAR®

Océ-Technologies B.V. has joined the ENERGY STAR® program of the United 
States Environmental Protection Agency (EPA). The purpose of the ENERGY 
STAR® program is to promote the manufacturing and marketing of 
energy-efficient equipment, thereby potentially reducing combustion-related 
pollution.

Using the energy management features outlined below prevents unnecessary 
power consumption, which helps to reduce air pollution from 
electricity-generating plants and saves money on your utility bills.

The Océ 9600 is supplied as a printer and as a copier/printer and includes the 
following separate units:

1 Océ 9600 printer
2 Océ 9600 controller
3 Océ 9600 monitor
4 Océ 9600 scanner (copier/printer only)
5 Océ 9600 folder (optional)

As an ENERGY STAR® partner, Océ-Technologies B.V. has determined that 
both the printer and the copier/printer meet the ENERGY STAR® guidelines for 
energy efficiency.

The EPA ENERGY STAR® criteria involve the following features:

Low power mode  The Océ 9600 Printer is shipped with the low power mode 
default time set at 30 minutes, which means that the device automatically 
enters the low power mode 30 minutes after the last print is made.(*) The low 
power mode default time can be adjusted by the key operator to between 5 and 
60 minutes. The low power mode recovery time is less than 1 second, after 
which printing can be resumed ("instant printing", i.e. time to first print less 
than 40 seconds).

The Océ 9600 has a standby mode which complies with the ENERGY STAR® 
low power mode criteria for Multifunction Devices.(*) The default time is zero 
and the recovery time is less than 1 second.
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Sleep mode  The Océ 9600 is shipped with the sleep mode default time set at 
30 minutes, which means that the device automatically enters the sleep mode 
30 minutes after the last copy or print is made.(*) The sleep mode default time 
can be adjusted by the key-operator to between 20 and 60 minutes. The sleep 
mode recovery time is less than 1 second. Only if a sleep mode default time of 
60 minutes still causes you significant inconvenience, due to your particular 
usage pattern, the key-operator may disable the sleep mode feature.

Recycled paper  The use of recycled paper also benefits the environment. The 
Océ 9600 is designed to use recycled paper. Product literature on 
recommended types of recycled copier/printer paper can be obtained from 
your local Océ company or Océ Headquarters (Océ-Technologies B.V.) in 
Venlo, the Netherlands.

(*) For power consumption data: see the Product Safety Data Sheet in this 
appendix. 

ENERGY STAR® is a U.S. registered mark.
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How to read this manual

The consistent style that is used in this manual enables you to quickly become 
familiar with the use of this manual and ultimately the Océ 9600.

Description  Each section or subsection contains a description of the feature or 
operation identified in the title. It might also include possible applications, as 
well as any guidelines that you should bear in mind.

Procedures  A description is followed by a procedure. A procedure always 
begins with a phrase which briefly describes the procedure, followed by a 
series of numbered steps that take you, step by step, through all phases of 
performing the operation. 

Figures and tables  Figures and tables are titled and numbered sequentially 
throughout this manual. Figures include pictures of product components, 
screen dumps, examples, and diagrams of concepts discussed in the 
description.

Attention getters  There are several types of information to which we draw 
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters which ensure the proper 
functioning of the machine or application, but useful advice concerning its 
operation may also be given.

Attention: The information that follows ‘Attention’ is given to avoid 
damage to your copy or original, the copier or printer, data files, etc.

Caution: The information that follows ‘Caution’ is given to prevent you 
suffering personal injury. .
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User survey

Did you find this manual to be accurate?
❏ Yes
❏ No

Were you able to operate the product after reading this manual?
❏ Yes
❏ No

Does this manual provide adequate background information?
❏ Yes
❏ No

Is the format of this manual convenient in size, easy to read and layed out well?
❏ Yes
❏ No

Did you find the information you were looking for?
❏ Always
❏ Most of the times
❏ Sometimes
❏ Not at all

How did you find the information you were looking for?
❏ Table of contents
❏ Index
❏ Neither

Are you satisfied with this manual?
❏ Yes
❏ No

Thank you for evaluating this manual. 
If you have any other comments or concerns, please explain them on the 
following page.
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Comments:

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------
Date:

This reader’s comment sheet is completed by: 

Name (optional):

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
Attn: ITC-User Documentation
P.O. Box 101
5900 MA Venlo
The Netherlands

Send you comments by E-mail to : itc-userdoc@oce.nl

For the addresses of local Océ organizations see : www.oce.com
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Addresses of local Océ organizations

Océ-Australia Ltd.
P.O.Box 363
Ferntree Gully MDC VIC 3165
Australia

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels 
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
525, Logan Avenue,
Toronto, Ontario M4K 3B3
Canada

Océ Office Equipment (Beijing) Co Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China

Océ-Česká republika s.r.o.
Hanusova 18
14021 Praha 4
Pankrác,
Czech Republic

Océ-Danmark A.S.
Kornmarksvej 6
DK 2605 Brøndby
Denmark

Océ-France S.A.
32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454
4330 Mülheim an der Ruhr (13)
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens
33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1241 Budapest
Hungary

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Malaysia
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Océ-Nederland B.V.
P.O.Box 800
5201 AV ‘s-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4
Norway

Océ-Poland Ltd.
ul. Łopuszańska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495 Algés
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab
190 MacPherson Road
Singapore 348548

Océ España SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Svenska AB
P.O.box 1231
S-164 28 Kista
Sweden

Océ-Schweiz AG
Sägereistrasse 29
CH8152 Glattbrugg
Switzerland

Océ (Taiwan) Ltd.
No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan
Taiwan, RO

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Langston Road
Loughton, Essex IG10 3SL
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 60656
U.S.A.
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Index

"Ready to copy" 47

A
aborting job currently being printed 79
Access 137
add a controller 127
adding toner 227

replacing waste toner bag 227
applications 120
Apply 136
Automatic language sensing 198
Automatic login 123
automatic login 123
automatically view a scanned file 98
available material types and sizes 11, 288

B
belt unit 268, 275
buttons 29

higher/lower buttons 31
on line 18
selection buttons 29, 41
stop 29, 41

C
clearing jams 247

cut sheet feed section 248
folder 252
fuser section 250
manual feeder 249
roll feed section 248

command line parameters 125
compression 87
connect to a controller 127
Connecting 127
connecting workstations 100

copying 48
long/short originals 58

counter 28
Custom card 138

D
default settings 41
define settings 53
Defining

original settings 148
pen settings 206
set time-out 189
zoom calibration 157

delete a scanned file 97
deleting print jobs 80
destination 86

delete 95
lock 94
unlock 95

destination properties 96
destination type 94
Display language 124
Dithering matrix 195

E
editing image 67
enlargement 48
EPA Energy Star 297
exposure

modifying 48

F
file extension 95
file mode 86
file type 86

cals 87
tiff 86

folded copies 268
folder

belt unit 273
standard folding program 269



306 Océ 9600 Copier/Printer User Manual

Folder options
belt unit 268
reinforcement unit 268

folding settings 271, 272
FTP 99
function buttons 42
functions

Océ 9600 12

G
General control buttons 135
get files 99
glass platen 230
graphical display (LCD) 27

H
help 124
Horizontal zoom calibration 157

I
install remote logic 115
instructions for safe use 294

K
Key operator settings 132
KOS system

introduction 130

L
language 124
loading media 219

cut sheet material 225
rolls 220
using roll loader 223

login 122
logout 122
long/short originals 58

M
manual feed see sheet feed
manual feeder 18
media jam

belt unit 258
cassette tray 248
first fold section 252
folder 252
folder transport section 254
fuser section 250
manual feeder 249
roll feed section 248
second fold section 254

Menu bar 134
mirror 89
Multiple sheet 144

N
non-standard sized originals 58
number of copies, defining - 48

O
Océ 9600

functions 12
manual feeder 18

Océ 9600 applications
Key Operator Settings/System Administrator 
Settings 20
Queue Manager 20
System Control Panel 20

Océ 9600 folder 267
Océ 9600 Key Operator Settings (KOS) 10, 129
Océ 9600 printer 12
Océ 9600 System Administrator Settings (SAS) 
191

off line folding 271, 272
on line button 18
operating panel 40
operating panel printer 26
optimization 88

file size 88
scan quality 88
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organization 87
original delivery

selecting front or rear output 53
Original delivery tray 22
original jam 245
originals

copying thick - 52, 58

P
Panel time out 189
password 122
pen pattern 206
Pen settings 206
pen settings

pen pattern 206
pen width 206

pen width 206
PostScript 203
print a scanned file 96
print job

managing 10, 73
print settings 206
printer buttons 29
printer settings 10

selecting language 35
setting a special media indication 32, 34
setting media type and size 32
starting up and shutting down the printer 31
stopping print job 34

product specifications 281
properties of a scanned file 97

Q
Queue Manager

aborting active print job 79
aborting the job currently being printed 79
active print job window 74
deleting print jobs 80
functions 20, 74
introduction 20, 74, 79
menu bar 74
modes 75
pausing print jobs 80

print queue window 74
restarting paused print job 80
restarting paused print jobs 80
structure 74
viewing the print queue 79
window 75

Queue Manager window 107

R
recommended weight limits 292
reduction 48
reduction/enlargement 48
reference roller 230
reinforcement unit 268
remote logic 113
removing the folder’s Nickel Cadmium battery 
298

resolution 88
restarting a paused print job 80
retrieve scanned files 99
roll holder 220, 223
Row of buttons 134

S
safety data sheet

Océ 9600 OPC drum 296
Océ 9600 printer 296
Océ 9600 toner 296

safety data sheets 295
safety information 291, 294
SAS system

pen settings 206
scan manager 90

create destination 93
scan-to-file 81

destination 83
file mode 83
how to 83
password 82
settings 85

selecting language 35
selection buttons 29, 41
Set time out 189
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Set time-out 189
Setting dependencies 132
setting media type and size 32
setting special media indication 34
Settings area 134
Shutting down 131
Single sheet 144
solving problems 266
Sort 144
Standard folding program 269
start button 49
Starting up 131
starting up and shutting down the printer 31
Status bar 136
stop button 29, 41, 55
Stopping a copy job 55
stopping a print job

Stop button 34
stopping print job 34
supported media 220
System administrator settings 132
System Control Panel (SCP)

icons 110
introduction 106
structure 106

T
table view 91

file properties 91
temporary store 98
tiff subformat 87
Tree structure 135
tree view 91

destinations 91
Turning off

printer 31
turning on

printer 31

U
Undo 136
up/down buttons 31
Update area 135

User modes 137
user modes 121

V
Vertical zoom calibration 157
view a scanned file 96
View error 104
view station 82, 101

view a scanned file 84
viewing printer status 105
viewing the print queue 79

W
waste box 240
waste toner bag 227
work on a remote system 127

Z
zoom 48, 88
zoom calibration 157
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